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1. 1.  OSNOVE EXCEL-a

Spreadsheet programi,ili kako obično prevodimo programi za unakrsna izračunavanja, su briljantna ideja, koja je doprinela da personalni računari steknu svoje mesto na tržištu i postignu populamost koju danas uživaju. Prvi takav program , VisiCalc za Apple II,"naterao" je hiljade poslovnih ljudi da kupe računar. Kasniji prelaz na jači hardver usledio je uspeh njegovih naslednika, pre svega programa Lotus 1-2-3 za PC računare. Microsoft se relativno kasno pojavio na sceni spreadsheet programa, ali danas vlada velikim delom tog tržišta. Njihov Excel je, zahvaljujući grafičkom radnom okruženju Windows-a bio znatno jednostavniji za upotrebu i moćniji od konkurenata. Excel je iz verzije u verziju rastao, da bi vrhunac postigao kada je, zajedno sa tekst procesorom Word, bazom podataka Access i nekim drugim programima, integrisan u Microsoft Office.

Trenutno je Excel najprodavaniji program svoje vrste na svetu. Jednostavnost upotrebe je stavljena na prvo mesto: opcije su koncipirane tako da se do njih lako dolazi, a zatim se jednakom lakočom primenjuju, uz stalno nadgledanje i asistenciju samog Excela; program će čak "pogoditi" šta želite da uradite i savetovati lakši put za obavljanje tog posla.

Excel je prilagodljiv paket,  možete ga prekonfigurisati da odgovara vašim potrebama. Po potrebi možete da promenite tastere pridružene nekim akcijama, premeštate stavke u menijima ili dodajete komande na tasterski meni. Ako vam smetaju padajući meniji, lenjiri, tasterski meniji... sve se može uključivati ili isključivati, a može im se menjati i pozicija. Vrhunac povećanja prostora na uvek malom ekranu je opcija za prikazivanje najpotrebnijih stvari radne površine i osnovnog menija. Ova osobina je naročito dragocena za korisnike prenosnih kompjutera, notebook- ova, na kojima se dijagonala ekrana od desetak inča smatra velikom.

Integracija i saradnja sa drugim programima se podrazumevaju: možete da uvozite tekstove, slike i datoteke kreirane u drugim programima, pomoću filtera koji podržavaju sve poznate formate. Tu je i OLE 2.0 koji omogućava da na licu mesta, u svojoj tabeli, kreirate i obradite tekst, sliku, grafikon, formulu ili nešto drugo pomoću spoljnje aplikacije- najčešći slučaj je program za pravljenje grafikona MSGraph,. Sve to programiranje naravno nije neophodno: Excel je namenjen najširem krugu korisnika, pa je posebna pažnja posvečena jednostavnom radu sa podacima, formulama, grafikonima pa i bazama podataka

Programi iz godine u godinu postaju sve moćniji, ali i zahtevniji: današnji Excel zahteva preko deset megabajta prostora na disku i moderan računar: bar 80486 na 66MHz i 16Mb operativne memorije ( RAM ).

1.1 Osnovni pojmovi prilikom rada sa tabelama

Ne postoji kancelarija kojoj nisu potrebni određeni proračuni. Uz to ponekad je potrebno formirati tabelame i grafičke prikaze koji slikovito predstavljaju takve proračune. Računar nam daje mogućnosti za brzi i sigurniji način ostvarivanja takvih želja. Mogućnost pojave greške se smanjuje samo na period unošenja podataka, dok greške nastale korišćenjem matematičkih formula pri formiranju tabela, ne postoje. Svaka tabela kreirana takvim programom mora biti prethodno isplanirana i planski skicirana. Znači, potrebno je imati viziju kako će tabela izgledati i koje sve matematičke relacije i međuzavisnosti elemenata tabele treba koristiti. Ukoliko nam je ovo poznato možemo pristupiti kreiranju tabele u programu za unakrsne proračune. U programu se uvodi novi vid teminologije. Umesto elemenata tabele, koristimo se nazivima ćelija tabele (Table Cell). Na ekranu nam se prikazuje samo deo celokupne tabele. Najčešćeje u pitanju 8 kolona x 17 redova.

Sada ćemo razmotriti osnove formiranja tabela. Pri tom, treba reci da postoje određeni standardi uglavnom anglosaksonskog porekla. 

Programi za formiranje tabela su jednostavni za učenje, jednostavni za koriščenje i pokazuju vrlo brzo rezultate rada. Upravo zbog ovako brzog ovladavanja programom korisnici preskaču proces planiranja prilikom unošenja tabela. Umesto toga oni tabele unose direktno u program. Problemi nastaju prilikom kreiranja i obrade većih tabela. Gube se osnovni elementi stila kreiranja tabela. To znači smanjuje se preglednost, nedostaje metod uočavanja relevantnih podataka, Što dalje uslovljava da dolazi do smanjene "čitljivosti".

Pri kreiranju tabele potreban nam je plan za kreiranje tabele koja sadržava relevantne, važeće, pouzdane i od grešaka očiščene podatke. 

Na tabeli bi trebalo odrediti grupe podataka. U pojedine grupe ubrajamo:

•   Zajedničke podatke. Oni predstavljaju podatke koji se koriste za izračunavanje formula u više čelija.

•   Naslov tabele. Naslov omogučava indikaciju šta predstavljaju podaci koji se nalaze u tabeli. Naslov mora biti kratak i precizan, a mora isto tako upućivati na sadržinu tabele

•  Datum. U tabelu se unosi tačno vreme formiranja tabele, kao i vreme kada je izvršena poslednja revizija tabele.

•  Ime korisnika tabele. Tabela je najčešće namenjena određenom korisniku i zbog toga bi bilo zgodno imenovati tog korisnika. 

•  Autor tabele. Autor tabele bi trebao uneti svoje ime. Ovo ime je neophodno jer ukoliko se pojave nejasnoće u vezi sa sadržinom tabele, po datom imenu se može zaključiti kome se možemo obratiti za pomoć kako bi razjasnili problem.

•   Pretpostavke. Da bi se pretpostavke u vezi sa specifičnim podacima u tabeli bolje razumele potrebno je imeonovati date pretpostavke naslovom - labelom. 

•  Odnosi. Potrebno je u redovima i kolonama tabele pomoću naslova pokazati o čemu je reč i kakve su međuzavisnosti između datih redova.

•  Formule.   One   formiraju   međuzavisnosti predstavljenih u određenim ćelijama tabele.

•  Ukupne (totalne) sume. Iz prakse knjigovodstva je poznato da se bilo koje sume, pa bile to među ili konačne sume prethodno podvlače linijom. Na ovaj način se prikazuje da te vrednosti predstavljaju sumu svih vrednosti iznad linije.

•  Jedinica obračuna. Jedinica mere se izabire korišćenjem određenog formata. Taj format u SAD je oznaka $ koja prethodi vrednosti novca. Kod nas se koristi oznaka DIN ili NDIN i nalazi se iza vrednosti novca.

· Karakteristike koje treba da poseduje tabela su preciznost, čitljivost i konzistentnost. Naime, zadovoljavanje ovih karakteristika su osnova dobrog planiranja i metoda kreiranja tabela.

· Karakteristika preciznosti znači da tabela treba da sadržava podatke oslobođene grešaka nastalih prilikom unošenja podataka. 

· Čitljivost tabele označava da je tabela organizovana na takav način da omogućava "lako snalaženje" u podacima koje nudi. Najčešće se čitljivost povećava dobrim dokumentiranjem u tabeli - znači unošenjem teksta koji objašnjava podatke i radnje u tabeli. Isto tako se može povećati čitljivost promenom veličine i boje slova u tekstu. Npr. dug kojem je istekao rok za plaćanje, moguće je vidnije predstaviti crvenim slovima.

· Konzistentnost omogućava lakši pregled tabele.. To znači da tabelu treba kreirati tako da se zna gde se nalazi glavni naslov, labele, ulazni i izlazni podaci, proračuni, međurezultati i dr.

1.1.1 Koraci planiranja kreiranja tabele 

postoje dva koraka:

•   Pretpostavke o tome ko će i na kakav način koristiti datu tabelu:

•   Ugrubo skiciranje oblika tabele koju ćemo formirati.

Ipak planiranje zavisi i od vrste tabele koju kreiramo. Tabele se dele u 4 modela:

•   Model unošenje podataka koji se obrađuju osnovnim aritmetičkim operacijama. Na neki način možemo reči da ovaj slučaj predstavlja kreiranje najobičnijih i najjednostavnijih vrsta tabela.

•   Šta-ako model. Ova vrsta tabela predstavlja situaciju u kojoj je potrebno predvidjeti šta će se desiti ukoliko se jedna ili više varijabli u tabeli promene. Mi zapravo u ovoj vrsti tabele istražujemo scenario šta će se desiti ako se određeni uslovi promene.

•   Model osetljivosti. U ovom slučaju istražujemo uticaj promene samo jedne varijable na određene veličine. Pri maloj osetljivosti je slučaj da ,i veoma velike promene date varijable uzrokuju male promene istraživane veličine ("izlazna veličina"). Za razliku od toga, u interesantnijem slučaju pri velikoj osetljivosti, male promene posmatrane varijable imaju 1 za posledicu značajne promene u vrednosti "izlazne veličine".           |

•  Model pronalaženja zadatka. Ovaj model je, model po logici delovanja, potpuno suprotan od prethodnih modela. U ovom slučaju mi  imamo ciljni zadatak, dok tražimo uslove koji če omogućiti da se taj  zadatak dostigne, odnosno da postane stvarnost.                      ;

Planiranje samog izgleda tabele ima značajan uticaj na preglednost podataka  prikazanih u njoj. Postoji više pravila za kreiranje layouta tabele. 

Postoje 2 osnovne grupe layout organizacije tabele. To su:

•  Tabela sa jednim blokom

•  Tabela sa više blokova

1.-  Tabela sa jednim blokomNajjednostavniju formu predstavlja tabela sa jednim blokom koja prikladna za jednostavne aplikacije. U ovakvoj konfiguraciji podaci i proraču se nalaze zajedno u istom području ispod naslova tabele.

2.-  Tabela sa više blokova se sastoji od 4 grupe blokova. To su:

•  Dokumentacioni blok koji daje informacije o samoj tabeli i ne sad nikakve podatke od važnosti za proračune tabele.

•   Ulazni hlok koji sadržava vrednosti veličina koje se koriste; formulama.

•   Blok proračuna koji predstavlja tzv. radni deo tabele. On sadrži formule i podatke. Radi veće preglednosti ovaj blok se može razbit u više podcelina.

•   Izlazni blok podataka koji sadržava rezultate operacija i proračuna.

1.2 Pokretanje Excela

Microsoft Excel je pretstavnik programa za tabelarne proračune (eng. speadsheet). pomoću programa se mogu kreirati tabele koje se po promeni nekog podatka u njima sami ažuriraju. 

Excel ste kupili kao samostalan program ili kao deo paketa Microsoft Office. U oba slučaja pretpostavljamo da ste prošli kroz proces instaliranja programom Setup i da ste uspešno instalirali Excel na svoj računar. Excelov program Setup instalira na disk sve neophodne datoteke.

Ovako instaliran program pokreće se kao i bilo koji drugi Windows program: 

• Pritisnite dugme Start na paleti poslova (engl. taskbar), izaberite stavku Programs a zatim Microsoft Excel.

• Iz Windows Explorera: mišem pokažite bilo koju Excelovu datoteku i pritisnite dvaput levi taster. Excel će se pokrenuti i otvoriće se datoteka.

• Dvaput pritisnite Excelovu prečicu na radnoj površini Windowsa 95 (ako ta prečica postoji).

Kao što vidite, pokretanje Excela se ne razlikuje od pokretanja većine Windowso-vih aplikacija. 

napomena: Pošto korisnik lako može sebi da prilagodi Excel, ekran koji vidite kada prvii put pokrenete program verovatno neće izgledati kao ekran na računaru vašeg saradnika. 

Po pokretanju programa pojavljuje se sledeći prozor:

· Prozor je u mnogome sličan već poznatim prozorima. Kao u svim Windows programima, i tu se nalazi: Naslovna linija, linija sa menijima, paletke sa alatkama, statusna linija i radna površina. 

· Radna površina, pošto se radi o programu za tabelarna izračunavanja, sadrži jednu tabelu, čije kolone su označene sa slovima a redovi sa brojevima. 

· ćelija, osnovni element tabele, nalazi se u preseku kolone i reda,  naziv se dobija spajanjem naziva kolone i reda u kom se nalazi (npr. druga kolona, treći red  – polje C3). Ćelije mogu da sadrže brojeve i slova. Ćelije koje sadrže slova ne mogu bit argumenti matematičkih funkcija. Pored brojeva i slova ćelije mogu sadržati i funkcije. U tom slučaju u ćeliji je vidljiv rezultat funkcije, a funkcija se vidi u Edit polju.

Tabele u Excel-u se smeštaju na radne listove (worksheet). Nekoliko radnih listova čine radnu knjigu (workbook). Na tvrdi disk se zapisuje radna knjiga i to u jedan fajl. Radni listovi radne knjige su na radnoj površini smešteni „jedan iza drugog”. Pojedini radni list možete otvoriti izborom njegovog jezička na dnu radne površine (Sheet 1, Sheet 2, Sheet 3).

Jedana od ćelija radnog lista je uokvirena.Ovaj okvir pretstavlja fokus, što znači da je ćelija u fokusu izabrana i svaka akcija korisnika se odnosi na nju. Okvir igra ulogu kurzora iz Worda i pomera se na sličan način.

1.2.1 Zaustavljanje Excela

Postoji nekoliko načina da se izađe iz Excela 

• Pritisnite dugmence X u gornjem desnom uglu Excelove radne površine.

• Izaberite File / Exit.

• Pritisnite Excelovu ikonu u gornjem levom uglu Excelovog prozora da biste otvorili kontrolni meni pa iz njega izaberite Close. (Ili, pritisnite dvaput Excelovu ikonu).

• Pritisnite Alt+F4.

Kada izađete iz Excela pojaviće se dijalog koji vas upozorava da snimite ono što ste radili pre nego što se Excel zaustavi.

1.2.2 Windowsov interfejs

Excel 8 radi pod Microsoftovim Windowsom 98 i sledi Standarde za Windowsov interfeis. Ako ste koristili druge Wndowsove programe prepoznaćete mnoge elemente, kao što su kontrole za aplikacije, kontrole za prozore, linija menija i trake za pregled sadržaja ekrana (engl. scroll bars). 

Najveća prednost Windowsovog interfejsa je što zahvaljujući njemu svi programi izgledaju slično. Ako ste radili sa bilo kojim Windows programom neće vam biti teško da se snađete sa Excelom.

1.2.3 Linija za naslov

Inicijalno na vrhu Excel prozora se nalazi ime fajla sa kojim se radi, sa standardnim kontrolnim menijem sa leve i tasterima za povećanje (maximize), smanjivanje (minimize) i izlazak iz programa (exit) sa desne strane. 

Linija za naslov sadržava ime samog programa - Microsoft Excel uz ime trenutno otvorene i aktivne tabele. Ako dvostrukim klikom izaberemo bilo koji deo ove linije, naša celokupna radna oblast u kojoj se nalazi aplikacija MS-Excela postaje prozor koji zaprema jedan deo ekrana. Ako ponovo dvostruko kliknemo datu površinu, veličina prozora opet obuhvata celu oblast ekrana.

1.2.3.1 Korisćenje sistema komandi

Biranje komandi u Excelu je skoro isto kao i u ostalim programima paketa Microsoft Office. Postoji sistem menija, priručnih menija, niz paleta alatki i bezbroj prečica sa tastature za one koji ne preteruju sa korišćenjem miša. Uvek postoji po nekoliko načina da se izvrši većina Excelovih komandi.

:
1.2.4 Meni linija

Ispod linije za naslov je traka sa glavnim padajučim menijima i kontrolama za prozor u kome se trenutno radi

Meni linija prikazuje imena dostupnih meni opcija. Po izabiranju određenog menija, na ekranu se otvara padajući meni. U tom meniju su date opcije koje možemo aktivirati. Da bi direktno pristupili određenom meniju preko tastature potrebno je pritisnuti taster Alt i podvučeno slovo u datom meniju.

Značajno poboljšanje Excelovog interfejsa su podmeniji koji se ponekad zovu i kaskadni meniji. Podmeni prikazuje više opcija koje se kao kaskada nižu sa desne strane izabrane komande. Tada komandu birate iz podmenija. Komande koje prikazuju podmenije označene su simbolom trougla:

na primer, kada izaberete komandu Format  / Row, prikazuje se podmeni sa nekoliko opcija

1.2.5 Toolbar linija

Toolbar linija sadržava niz tastera sa ikonama čije aktiviranje (izabiranje) uzrokuje pokretanje određenih akcija.

Ukoliko na bilo koju od navedenih ikona tastera postavimo kurzor miša pokazaće se kratak naziv tog tastera. Ovaj naziv će nam olakšati da prepoznamo funkciju koju vrši navedeni taster.

Postoji više vrsta Toolbar linija. Celokupni Toolbar deo se sastoji iz više grupa tastera. 

U prvoj grupi nalaze se tri tastera. To su tasteri New, Open i Save.Oni zapravo zamenjuju funkcije odnosno opcije menija File/New, File/Open i File/Save.

Sledeću grupu čine tri tastera koji imaju nazive Print, Preview i Spelling. Ova tri tastera se aktiviraju prilikom procesa štampanja tabela. Znači po zvršetku uređivanja naše tabele želimo proveriti da li smo sve reči odnosno labele napisali na pravilan način (odnosi se samo na tekstove napisane na engleskom jeziku). Zbog toga pritisnemo taster Spelling. Istu akciju možemo pokrenuti izborom opcije menija' Tools/Spelling. Posle pregledavanja grešaka nastalih prlikom pisanja, potrebno je da vidimo kakav izgled če imati tabela kada se ištampa na papiru. Ovaj proces treba pokrenuti pre nego što započnemo proces štampanja tabele. Zato izaberemo taster Preview koji pokreće identičnu akciju kao i opcija File/Preview. Proces štampanja zapoočinjemo izborom tastera Print. Po izboru datog tastera na ekranu se pojavljuje prozor za dijalog sa korisnikom koji traži od nas informacije o stranicama celokupne radne tabelarne sveske koje treba ištampati. Te podatkeje potrebno uneti u prozor za unošenje podataka sadržan u prozoru za dijalog sa korisnikom. Isti ovaj proces se može postiči izborom opcije File/Print. 

U grupi tastera za aktivnosti editovanja imamo 4 tastera sa nazivima: Cut, Copy, Paste i Format Painter. Taster Cut vrši istu funkciju kao i opcija Edit/Cut. Ovaj taster odseca (briše) izabrani podatak u tabeli iz jedne ili više c'elija i prebacuje ga u Clipboard. Posle toga se pomoću funkcije Paste i pozicioniranja na neku novu lokaciju (c'eliju/e) prebacuje sadržaj. Opcija Edit/Paste se može aktivirati i izborom tastera Paste. Taster Copy prebacuje izabrani sadržaj teksta u Clipboard, ali ga pri tom ostavlja na njegovoj izvornoj lokaciji.(ne briše ga kao funkcija Cut). Na isti način se dati podatak kopira u novu ćeliju sa Paste funkcijom. Funkciju Copy pokrećemo izborom tastera Copy ili pomoću opcije Edit/Copy. Poslednji taster iz ove grupe je Format Painter. On omogućava preslikavanje oblika odnosno formata podatka iz jedne čelije na drugu c'eliju. Znači prvo izaberemo jednu ćeliju koja ima oblik koji želimo preslikati na drugu ćeliju. Posle toga izaberemo pomenuti taster. Kurzor miša se pretvara u oblik ikone dat na tasteru. Sada dati kurzor pomerimo na lokaciju čelije kojem želimo dati oblik prethodno izabrane ćelije i kliknemo je mišem (levim tasterom). Ćelija je sada promenila oblik prema onom obliku koji ima prvo izabrana čelija.

Sledeču grupu tastera čine dva tastera Undo i Redo. Prvi taster odnosno taster Undo omogućava povratak na stanje pre izvršavanja poslednje akcije. Drugi taster odnosno taster Redo omogućava povratak na stanje za jednu akciju posle Undo akcije. Undo taster, izborom strelice koja se nalazi uz njega, može dobiti spisak poslednjih 100 akcija čiji se učinak može povratiti u prethodno stanje.

Sledeću grupu čine dva tastera AutoSum i Function Wizard. Ova dva tastera omoućavaju sprovođenje matematičkih operacija nad ćelijama. Tatster AutoSum omogućava automatsko sabiranje grupe ćelija. Najjednostavnija primena navedene funkcije je ako izaberemo određeni broj ćelija (sa podacima) u koloni

plus jednu dodatnu praznu ćeliju. Zatim pritisnemo dugme AutoSum. Ukupna suma svih izabranih ćelijaje izračunata u "dodatnoj" praznoj ćeliji.

Drugi taster Function Wizard ima kompleksniju funkciju. On omoguc'ava korak po korak kreiranje i izvršavanje određene matematičke funkcije nad specificiranim argumentima.

Sledeća dva tastera omoguc'avaju sortiranje izabranih ćelija. Prvi to vrši redom od A do Z (Ascending), a drugi od Z do A (Descending).

Novu grupu čine tri tastera sa nazivima: Chart Wizard, Text Box i Drawing. Prvi taster Chart Wizard predstavlja savetnika za kreiranje grafikona. Pri tom je prvo neophodno izabrati ćelije koje sadržavaju podatke koji će biti prikazani u grafikonu. Dalje nas vodi sam Wizard (savetnik-čarobnjak) kroz niz prozora za dijalog sa korisnikom. U datim prozorima unosimo neophodne podatke kako bi se kreirao željeni grafikon.

Text Box taster omogućava u tabeli kreiranje prozora u kojem će se moći uneti određeni tekst. On se najčešće koristi prilikom kreiranja grafikona.

Taster Drawing se koristi za crtanje grafičkih elemenata. To znači da koristeći navedeni taster pokrećemo deo unutar MS-Excela koji omogućava crtanje grafičkih elemenata. Po izabiranju datog tastera na ekranu dobivamo novi Toolbar - Toolbar za crtanje grafičkih elemenata (Drawing Toolbar). Izgled ovog Toolbaraje dat na sledećoj slici.

1.2.5.1 Padajuće palete

Pored nekih alata nalazi se taster sa strelicom. Na primer, alat za okvire (Border) sa palete sa alatkama za formatiranje (Formatting). Mišem izaberite strelicu kada želite da dobijete padajuću paletu sa opcijama. Pretpostavimo da često koristite ovu padajuću paletu. Postoji mogućnost da je skinete sa palete sa alatkama:

1. Pritisnite strelicu nadole da otvorite paletu.

2. Pažljivo pritisnite na traku duž gornje ivice palete i držeći pritisnut taster miša odvucite je od palete sa alatkama.

3. Otpustite taster miša da je spustite.

Da sakrijete plutajuću paletu, pritisnite dugmence X u njenom gornjem desnom uglu.

1.2.5.2 Funkcije alata sa palete Standard

Palete sa alatkama i alatke mogu da se prilagođavaju prema želji 

napomena: Većina alatki na standardnoj paleti nalazi se tu sa razlogom: to su komande koje se najčešće koriste. 

· Otvara novu radnu svesku 

· Otvara postojeću radnu svesku 

· Snima aktivnu radnu svesku na disk 

· Štampa aktivnu radnu svesku
· File / Print Preview
Pokazuje kako će izgledati štampane strane
· Tools / Spelling
Proverava pravopis teksta na engleskom jeziku
· Edit / Cut - Isecanjem premešta izabrane ćelije

· Edit / Copy - Kopira izabrane ćelije

· Edit / Paste - Prenosi isečene ili kopirane ćelije

· Format Painter- kopira formatiranje između ćelija ili objekata 

· Undo- Ponistava redom poslednje operacije 

· Redo- Ponavlja poništene operacije

· Insert / Hyperlink - Umeće hipervezu prema drugom dokumentu ili udaljenoj lokaciji 

· View / Toolbars / Web    Prikazuje ili sakriva pa!etu Web 

· Insert / Function / Sum   

· AutoSum - Unosi funkciju SUM u izabrane ćelije 

· Insert / Function -Prikazuje dijalog Paste Function

· Data  / Sort - Sortira izabrane ćelije po rastućem redosledu

· Data  / Sort - Sortira izabrane ćelije po opadajućem redosledu

· Insert / Chart - Pokreće program ChartWizard 

· Insert / Map - Stavlja mapu na radni list

· View /  Toolbars / Drawing - Prikazuje paletu sa alatkama za crtanje (Dravving)

· View / Zoom - Smanjuje/povećava radni list

1.2.5.3 Toolbar Drawing
Zatim sledi grupa sa jednim tasterom. Zapravo, on ne predstavlja taster nego padajući prozor za izlistavanje. Njegov naziv je Zoom Control. Oblik ovog tasteraje dat na sledećoj slici.

U okviru ovog prozora imamo mogučnosti procentualno specificirati veličinu prikazanog sadržaja informacija u našem radnom prozoru. Moguće je izabrati jednu od ponuđenih procentualnih ili opisnih opcija ili specificirati svoj procenat koji je različit od onih datih u listi. Ova kontrola nam može značajno olakšati rad prilikom obrade određenih detalja u MS-Excelu. Naime, često veličina tabele prevazlazi veličinu radnog prozora na ekranu. Pomoću ove kontrole možemo na zadovoljavajući način povečavati ili smanjuvati "vidljivost" detalja i informacija prisutnih u radnom prozoru.

Sledeću grupu tastera čine dva tastera: Tip Wizard i Help taster. Ovi tasteri su prikazani na sledećoj slici;

Prvi taster tip Wizard nam daje određene savete koji se najčešće u anglosaksonskoj literaturi nazivaju Tips & Tricks. Ovi saveti nam u nekim situacijama mogu značajno koristiti.

Drugi taster je Help taster. On omogućava pokretanje Helpa na dva načina. Ukoliko za neki element korisničkog interfejsa ne znamo funkciju, nau'ednostavnije je izabrati dati taster. Sada se kurzor miša pretvara u oblik ikone prisutan u Help tasteru. Da bi prikazali Help za određenu temu neophodno je dati taster pozicionirati iznad nekog elementa na korisničkom interfejsu i ponovo kliknuti Help taster. Sada se otvara određena grana Helpa koja daje objašnjenje vezano za tu specifičnu temu.

Drugi način pozivanja Helpa je pozivanje celokupnog Helpa i to na vrhu njegove hijerarhije. To se ostvaruje sa dvostrukim uzastopnih klikom na taster Help. Iste funkcije možemo odraditi izborom opcija iz menija Help.

1.2.5.4 Linija za formatiranje

Ispod Toolbar linije se nalazi linija za formatiranje. Ona se sastoji od više elemenata. Njen oblik je dat na sledećoj slici.

Ako sa levog kraja posmatramo navedenu liniju prvo uočavamo dva padajuća prozora za izlistavanje. 

Font. On pokazuje font trenutno aktivnog teksta. Izborom drugog fonta možemo menjati izgled fonta pripadajućeg teksta.
Font Size. U ovom prozoru nalazi se veličina fonta izabranog teksta. Izborom druge veličine fonta u mogučnosti smo promeniti veličinu fonta trenutno aktivnog teksta.

Sledeću grupu tastera na liniji za formatiranje čine tri tastera. Ovi tasteri služe za postavljanje tipova i efekata fontova. 

· Prvi ima naziv Bold i omogućava naglašavanje - podebljavanje fonta izabranog teksta. 

· Drugi ima naziv Italic. On se koristi za formiranje efekta iskošenosti fonta izabranog teksta. 

· Treći sa nazivom Underline upotrebljava se za podvlačenje izabranog teksta.
Sledeću grupu čine 4 tastera za postavljanje poravnanja teksta. 
Ova četiri tastera imaju nazive: Align Left, Center, Align Right i Center Across Columns. Oni uspostavljaju poravnavanje teksta odnosno podataka u ćeliji na levo, u sredinu (centar), na desno u odnosu na horizontalni raspored teksta. Poslednji taster postavlja centralno poravnanje između više izabranih ćelija. Sve navedene opcije primenjuju se na izabrane podatke u ćelijama.. Pošto se navedene funkcije formatiranja odnose na izabranu/e čeliju/e onda ih možemo ostvariti i izborom opcija Format/Cells list Alignment.
Sledeću grupu tastera čini 5 tastera. To su tasteri: Currency, Percent, Comma, Increase Decimal i Decrease Decimal. Njihov izgledje dat na sledečoj slici.
Funkciju datih tastera najlakše ču objasniti na konkretnom primeru. Pretpostavimo da sam u čeliju uneo vrednost 10500 i izabraoj'e. Sada cu redom pritiskati da tastere.

Posle aktiviranja tastera Currency podatak u čelija ima sledeći oblik:

Posle aktiviranja tastera Percent podatak u ćelija ima sledeći oblik:

1050000%8l
Posle aktiviranja tastera Comma podatak u čelija ima sledeći oblik:

Posle aktiviranja tastera Increase Decimal podatak u čelijaje:

Posle aktiviranja tastera Increase Decimal podatak u ćelijaje:

Treba još napomenuti da se može pojaviti situacija da ćelija dobije sledeći izgled.

U tom slučaju se u datoj veličini ćelije nije mogao prikazati celokupni podatak pa je zamenjen sa nizom povisilica. Međutim, postoje dva načina da rešimo taj problem. Prvi način je da uzastopno dvaput kliknemo levim tasterom miša datu ćeliju. Posle te akcije prikazuje se sadržina ćelij'e. Ovaj procesje samo trenutan jer se posle opet u čeliji pojavljuju povisilice. Drugi način nam omogućava da za stalno vidimo podatak u čeliji. To postižemo povecavanjem dužine ćelije.

Sledeći tasterje Borders. On je dat na sledecoj slici.

Aktiviranje ovog tastera otvara jedan prozor koji sadržava niz tastera koji omogućavaju različit tip uokviravanja izabranih ćelija. Data grupa tasteraje:

Navedena grupa od 12 tasteraje svojom slikom dovoljno ilustrativna. Sledeći tasterje taster Color. Njegov oblik je dat na sledećoj slici.Ovaj taster služi za "bojenje" same podloge ćelije. Primena ovog tastera može biti za označavanje čelija koje predstavljaju među rezultate, ukupne sume i sl.

Po aktiviranju datog tastera otvara se mali prozor koji sadržava 64 boje kojima možemo "obojiti" izabranu ćeliju.

Pb aktiviranju ovog tastera na ekranu dobivamo prozor sa 64 boje kojima možemo "obojiti" font izabrane ćelije.

Primenu za ovu funkciju možemo nači prilikom označavanja određenih podataka u ćelijama. Recimo zgodno je postaviti da se svi rezultati koji predstavljaju minus, gubitak, opasnost pri ulaganju oboje crvenim. Isto tako, svi podaci koji su "sigumi" se označavaju recimo zelenom bojom.

1.2.6 Radni prozor

Sledeći element na korisničkom interfejsu u MS-Excelu predstavlja radni prozor. On se sastoji od radne površine, vertikalnog i horizontalnog skrolbara, oznaka za kolone (oznake slovima), oznake za redove (oznake brojevima) i oznake fascikli (16 fascikli).

Treba reći da se u radnoj oblasti nalaze čelije u koje unosimo podatke. ćelije se referenciraju po njihovoj koloni i redu kojem pripadaju. To znači daje ćelija u tabeli jednoznačno određena sa svojim redom i kolonom (presek reda i kolone).

Zbog toga čelije imaju oznake koje sačinjavaju slovo (kolona) i   broj (red). Tako ćelijaje npr. A5. Ona se nalazi na preseku kolone A i reda 5.

Linija za prikazivanje kolona (oznake slova) je dat na sledećoj slici. Ona se nalazi na najvišoj liniji radnog prozora.

1.2.6.1 Linija za označavanje kolona tabele

Postavljanjem i pritiskanjem miša na određeno slovo u ovoj liniji izabiremo određenu kolonu. Ako sada kliknemo sa desnirrrtasterom miša na ekranu dobivamo prozor koji nam daje mogućnost da menjamo karakateristike objekta odnosno kolone. Ovaj prozorje dat na sledećoj slici.

U navedenom prozoru imamo niz opcija koje nam daju mogućnost da promenimo karakteristike ćelija izabrane kolone.

Na dnu radnog prozora nalazi se linija za fascikle. U svakoj fascikli imamo 16 tabela. Njihovi nazivi se startno postavljaju na Sheetl, .... Sheetl6.,Naravno, ova imenaje mouće promeniti.

Ako na poziciji određene tabele u fascikli kliknemo sa desnim tasterom miša, na ekranu dobivamo prozor u kojem možemo promeniti karakteristike datog objekta odnosno lista fascikle. Akcije koje možemo izvršiti su ubacivanje novog lista u fasciklu (Insert), brisanje trenutno izabranog lista (Delete), preimenovanje izabranog lista (Rename), prebacivanje ili kopiranje lista (Move or Copy) i izabiranje svih fascikli odjedanput (Select All Sheets).

Delete Rename... Move or Copy... SelectAII Sheets

5/.88 Prozor zo promenu karakteristika objekfa - lista fascikle
Linija za unošenje podataka
Ova služi za unošenje podataka u ćelije tabele. U njoj je prikazan trenutni sadržaj izabrane ćelije. Isto tako kada unosimo podatak u ćeliju sadržina datog unošenja se direktno vidi u datoj liniji. Njen izgledje dat na sledećoj slici.

1.2.6.2 Izgled linije za unošenje podataka

Statusna linija
Statusna linija prikazuje informacije o trenutnom načinu rada, trenutnim aktivnostima i o drugim pomočnim elementima. Ona se nalazi u zadnjem redu ekrana.

1.2.6.3 Palete alatki - brzi pristup komandama

Palete alatki (engl. toolbar) su prečice za većinu Excelovih komandi. Postoji više takvih paleta svaka sa različitim skupom komandi. Ukoliko nije drugačije zadato, prikazuje se paleta Standard a mnoge se pojavljuju automatski kada se ukaže potreba. 

Kada se govori o menijima treba raščistiti terminologiju. Pre Excela 8 postojale su linije menija i palete alatki i to su bili sasvim razliciti objekti. U Excelu 8 i dalje postoje i jedne i druge ali su sada spojene u jedan isti objekat koji se zove komandna paleta (engl. command bar).
Komandna paleta sadrži tekstualne komande (kao i meniji) i/ili ikone/kontrole (kao i palete). Podrazumevana linija menija radnog ista sadrži samo tekstualne komande. Podra-zumevana paleta alatki je komandna paleta koja sadrži samo ikone/kontrole. 1 jedno i drugo su komandne palete.

Ugrađene komandne palete možete promeniti a možete napraviti i nove komandom 

Tools >• Customize. 

Koriste se sva tri termina: meni, paleta alatki i paleta komandi odnosno komandna paleta.Da biste prikazali ili sakrili palete alatki izaberite 

View / Toolbars / Pojaviće se dijalog / Izaberite palete koje hoćete da prikažete i one koje hoćete da sakrijete. Ovaj dijalog vam omogućava da napravite izbor po meri svojih potreba. 

savet: Brz naćin da prikažete ili sakrijete palete alatki je da pritisnete desni taster miša pokazujući na liniju menija ili neku od paleta. Pojaviće se priručni meni iz kojeg birate palete koje hoćete da prikažete ili sakrijete.

1.2.6.4 Prikazivanje naziva alatki

Ponekad je teško odrediti funkcijn neke alatke samo na osnovu njenog izgleda. Postoji jednostavan način da se sazna funkcija svakog dugmeta na paleti. Postavite pokazivač miša na dugme alatke koja vas interesuje ali ne pritiskajte taster miša - dovuljno je da pokazivac bude iznad dugmeta par sekundi. Pojaviće se kratak opis, odnosno naziv alatke u vidu teksta na pravougaonoj podlozi žute boje.

savet: Standardno, ikone alata su relativno male. U zavisnosti od vrste monitora, lik sa ikone alata raspoznaje se lakše ili teže. Evo kako ih možete učiniti krupnijim: 

Izaberite opciju Tools / Customize / Options / a zatim opciju Large icons.

Ako se naziv alatke ne pojavi, pokušajte sledeće: 

izaberite Tools / Customize /  karticu Options. Proverite da li je potvrdena opcija Show ScreenTips on toolbars.

1.2.6.5 Premeštanje paleta sa alatkama

Standardno, palete sa alatkama su usidrene (engl. dockeci) ispod linije menija. Da bi se paleta sa alatkama premestila, postavite pokazivač na nju (bilo gde, ali ne pokazujući ni na jednu određenu alatku) i povucite je do drugog mesta u Excelovom prozoru. Ako se paleta povuče do vrha, dna, leve ili desne ivice prostora za rad, ona je usidrena. 

Ako se paleta povuče bilo gde drugde u prostoru za rad , kaže se da  je plutajuća (engl. floating). Plutajučoj paleti može se promeniti veličina povlačenjem njenih ivica.

Sada se palete alatki mogu potpuno odvući iz Excelovog radnog prostora. Ovo je naročito korisno ako radne sveske pravite po meri drugih korisnika (a imate i veliki monitor!). 

1.2.6.6 Rad sa priručnim menijima

Jedan od najpogodnijih načina za izbor komandi jeste preko menija koji odgovaraju kontekstu koji se zovu i priručni meniji. Priručni meni je meni koji se prikazuje pritiskom na desni taster misa. Obično sadrži uobičajene komande u vezi sa objektom koji ste izabrali.

· Pritisnete desni taster miša pokazujući na neku ćeliju. Na njemu se nalaze komande kao sto su Cut, Copy, Paste i Format. Iz priručnog menija se izlazi pritiskom nataster Esc ili ako mišem izaberete bilo koji deo radnog lista.

· Drugi koristan priručni meni dobija se pritiskom na paletu alatki. Pomoću tog menija lako prikazujete ili sakrivate patete alatki.

· Pritiskom na desni taster miša izaberite dugme za pomeranje jezičaka listova u donjem levom uglu ekrana. Priručni meni prikazuje spisak svih radnih listova - pritisnite onaj koji hoćete da aktivirate.

1.2.6.7 Ubrzavanje rada pomoću prečica na tastaturi

Za mnoge komande iz menija postoje prečice na tastaturi koje su prikazane sa desne strane komande. Na primer, Ctrl+C je prećica za komandu Edit / Copy 

Ctrl+G je prećica za komandu Edit / Go To, što možete da vidite u meniju Edit. 

Prečice ćete najlakše naučiti pamteći ih dok koristite komande iz menija.

1.2.6.8 Komande sa potvrdom

Ispred nekih komandi iz menija, kao View / Status Bar, nalazi se znak za potvrdu. Ove komande su kao prekidači - znak za potvrdu pokazuje da li je komanda aktivirana ili nije. Biranjem komande prekidač se prebacuje u suprotno stanje.Nedostupne komande u menijuomanda koju iz nekog razloga trenutno ne možete da upotrebite ispisana je bledim slovima (engl. dimmed). Na primer, komanda Window / Unhide u sledećem meniju dostupna je samo kada je prozor sakriven; inače je nedostupna.

1.2.6.9 Komande koje čekaju unos

Koniande iz menija koje prikazuju okvire za dijalog, na kraju imena imaju tri tačke (,...). 

Na primer, komanda Vievv / Toolbars... iz menija View prikazuje okvir za dijalog, dok komanda View / Formula Bar odmah izvršava radnju.

Postoje i izuzeci. Neke komande su u određenim situacijama odmah izvršive, a u drugim prikazuju okvire za dijalog. Primer je komanda File / Save. Kada se prvi put snima datoteka, komanda prikazuje dijalog. U svim ostalim slučajevima komanda odmah izvršava radnju. Ovakve komande nemaju tri tačke.

1.2.6.10 Okviri za dijalog sa karticama

Još jedno važno svojstvo Excela su okviri za dijalog sa karticama (engl. tabbed dialos box). U karticama su grupisane opcije koje su u određenom odnosu i čine jedinstvenu celinu. Dobar primer je dijalog koji prikazuje komanda Format> Cells.

Sve komande za formatiranje ćelija grupisane su u kartoteku okvira za dijalog Format Cells. Da biste prikazaii neku karticu potrebno je da mišem izaberete odgovarajući jezičak.

savet: Dijalozi sa karticama pamte karticu koja je poslednja upotrebljena - kada ponovo otvorite dijalog, aktivna kartica je ona koja je poslednja korišćena

1.2.7 Prikazivanje grafikona

Prava snaga Excela se vidi tek ako se podaci iz naših tabela prikažu u obliku grafova. Ovi grafovi se automatski ažuriraju ako dođe do promene podataka u tabeli

Za umetanje grafikona uradite sledeće:

· Označimo ćelije koje sadrže podatke za grafikon.

· Izaberemo stavku Insert(Chart iz menija, ili pritisnemo dugme Chart Wizard palete sa alatkama.

· U diajlogu izaberemo tip grafikona i pritisnemo dugme Next.

· Podesimo oblast ćelija i pritisnemo dugme Next.

· Po želji označimo ose grafikona i pritisnemo dugme Next.

· Izaberemo način prikazivanja grafikona: kao novi radni list ili objekat na tekućem radnom listu i pritisnemo dugme Finish.

Navedeni način je najprostiji način za prikazivanje grafikona. Šire opcije korisnik može sam da isproba.

1.2.8 Podešavanje izgleda ćelija

Izgled označenih ćellija možemo podešavati u dijalogu koji se dobija izborom stavke Format(Cells (Ctrl+1) iz menija. Dijalog se sastoji iz sledeća šest panela:

· Number
Format brojeva
· Alligment
Ravnanje i pravac ispisa sadržaja ćelije
· Font
Vrsta slova u ćeliji
· Border
Okvir ćelije
· Patterns 
Boja pozadine ćelije
· Protection
Zaštita ćelije
Posle podešavanja željenih parametara pritisnemo dugme OK.

1.2.9 Spašavanje i štampanje radnih knjiga

Radne knjige možemo da spasimo na tvrdi disk pomoću komandi 

File(Save i File(Save as. Fajlovi sa Excelovim radnim knjigama dobijaju ekstenziju .xls.

Štampanje rande knjige vrši se pomoću komande 

File(Print. U dobijenom dijalogu Print, treba izabrati željeni štampač (Printer), podesiti stranice za štampanje (Range), izabrati objekat za štampu (Print what), i broj kopija (Copies). Pritiskom na dugme OK počinje štampanje.

NAPOMENA:
Pokušali smo izneti osnove korišćenja programa Excel. Za detaljnije upoznvanje mogućnosti Excela preporučljiva je nabavka priručnika, koji se na našem tržištu mogu naći u velikom broju.

MS-Excel organizuje tabele na specifičan način. On ih povezuje u radne sveske (Workbook). Ove sveske ili drukčije rečeno fascikle se sastoje od 16 stranica. Svaka stranica sadržava jednu tabelu. Svaka stranica ima svoje posebno ime koje je predstavljeno u vidu imenika - podsetnika. Kao što smo već naveli svaka tabela se sastoji od ćelija koje sačinjavaju datu tabelu.
Na korisničkom interfejsu možemo uočiti par celina. To su:
· Linija za naslov (Title Bar) 

· Meni linija (Menu Bar) 

· Linija sa tasterima (Toolbar) 

· Linija za formatiranje

· Linija za unošenje podataka (Input Line) 

· Radni prozor Linija za fascikle

· Statusna linija (Status Line) 

Koliko god da smo iskusni u radu sa Excelom postoji mogučnost greške. Medjutim korišćenje tastera Redo i Undo je u ovom slučaju ograničeno na vračanje samo za jedan korak unazad ili unapred.

Tabela za opis tastera

	Pritisni


	Za kretanje



	strelice


	Jedna ćelija u smeru strelice



	Ctrl+gore/dole


	Na vrh / dno oblasti radnog lista koji sadrži podatke



	Ctrl+levo/desno


	Na krainju levu / desnu ćeliju radnog lista koja sadrži podatke



	Page Up / Dn


	Jedan ekran gore / dole



	Home


	Na krajnju levu ćeliju u redu



	Ctrl + Home


	Na krajnii levi ćošak radnog lista



	Ctrl + End


	Na donji levi ćošak radnog lista



	End + Enter


	Na poslednju kolonu u redu



	End + strelica


	Ako je aktivna ćelija prazna, pomera na sledeču praznu u smeru strelice



	
	


1.2.10 Kreiranje tabele

1.2.10.1 Otvaranje nove tabele

Pretpostavimo da treba formirati novu tabelu u koju ćemo upisati određene podatke. Prvi korak koji trebamo uraditi je otvoriti tabelu. To se ostvaruje izborom opcije File/New. Sada se otvara nova fascikla sa tabelama koja ima naziv Bookl ili Book2 (ako je već prethodno otvorena tabela Book2). U fascikli je startno sadržano 16 listova sa tabelama. Odsada če se umesto naziva fascikla sa tabelama upotrebljavati samo tabela. 

Kada otvorimo određenu tabelu u mogučnosti smo u nju uneti podatke.

1.2.10.2 Upisivanje podataka u tabelu

Prilikom kreiranja tabele mi u nju unosimo tri vrste podataka. To su tekstualne labele (krac'e labele), brojne vrednosti i formule. Labele se koriste za kreiranje naslova tabela, imena redova i/ili kolona, i u dokumentacionom delu tabele. Brojne vrednosti predstavljaju, kako im i samo ime kaže, numeričke vrednosti. Formule su kombinacije matematičkih funkcija koje operišu nad brojnim vrednostima.             ,.

Unošenje podataka u MS-Excelu je jednostavan proces. Na određenu čeliju odnosno poziciju u prozoru radne oblasti dovedemo kurzor miša, i kliknemo levi taster miša. Na ulaznoj liniji se pokazuje početni kurzor. Zatim ukucamo ili labelu ili brojnu vrednost ili celu formulu. Na kraju, da bismo potvrdili uneseni podatak pritisnemo taster Enter. U datoj ćeliji se pojavljuju uneseni podaci. Da bismo konkretno pokazali prethodno navedeno, dovedimo kurzor miša na poziciju B3. Kada ga dovedemo na tu poziciju pritisnimo levi taster miša. Unesimo sledeći tekst Kvartalni proračun kao naslov tabele. Pritisnimo taster Enter. Na poziciji B3 pojavljuje se unesena labela.

1.2.10.3 Proces unošenja podataka

Pohranjivanje tabele
Sada, pošto sam uneo zadati tekst u našu tabelu neophodno je pohraniti odnosno zapamtiti našu tabelu. To je neophodno kako bi mogao sledeći put ovu tabelu ponovo pozvati radi dorađivanja. Postoje dva načina procesa pohranjivanja. U prvom slučaju pohranjujemo tabelu pod novim imenom, dok je u drugom slučaju pohranjujen-io pod postojećim imenom. Prvi slučaj se odnosi

najčešće na novu tabelu. U našem slučaju, po unošenju gore napisanog teksta, izaberemo opciju File/Save As. Na ekranu se javlja novi prozor za dijalog sa korisnikom.

1.2.10.4 Izmena podataka u ćeliji

Podatke unesene u ćelije možete, naravno, da menjate. Da biste zamenili sadržaj novim, jednostavno označite ćeliju duplim klikom na nju (ili pritiskom na F2) i počnite da kucate ili menjate sadržaj na način uobičajen za Windows tekst editore. Kada završite, pritisnite Enter (prihvatanje) ili Esc (odustajanje od izmena). Excel pruža čak i mogućnost provere ispravnosti kucanja (spel checking), što podseća na programe za obradu teksta ali je ograničeno na engleski jezik.

Jedan od vrlo zgodnih alata za lakše snalaženje u kompleksnim radnim knjigama sa mnoštvom tabela i podataka, koji se uz to često premeštaju, su oblasti (ranges). Oblast je pravougaona grupa povezanih ćelija, koja može da bude deo kolone odnosno reda, ili samostalna ćelija. Označene čelije možete formatirati u jednom koraku, ili brzo odštampati samo željeni deo tabele. Ipak, najveće ustede vremena i živaca se dobijaju u formulama. Kada broj tabela preraste 3-4 pa formule i reference na razne čelije i oblasti počnu da se gomilaju, teško je promeniti mesto ćeliji, tabeli ili oblasti od interesa i onda ručno menjati adrese u svim relevantnim fonnularna -mogućnosti za grešku su više nego očigledne!

Oblasti se označavaju sidrenim tačkama (anchor points), koje su gomji levi i donji desni ugao. Tako možemo imati B4:D7, A9:D9 ili E2 oblasti.Kreiraju se najlakše mišem, tako što se označi željena oblast od gomjeg levog do donjeg desnogugla. Ukoliko se želi ista oblast na više radnih listova, prethodno ih treba selektovati na ranije opisani način. Ako treba označiti ceo red ili kolonu, klikne se samo na broj reda ili slovo kolone; ako je potreban ceo radni radni li.st, dovoljno kliknuti u prazan kvadratič u gomjem levom uglu iznad oznaka redova i levo od oznaka kolona.

Označenoj oblasti možemo dodeliti ime (u vezi sa sadržajem) i tako mnogo jednostavnije rukovati podacima, navodeči ime umesto slova i brojeva. Imena mogu biti sastavljena od malih i velikih slova, cifara i još nekih znakova i ne smeju sadržati blankove; mala i velika slova se ne razlikuju. Veoma korisna osobina imenovanja je da posle promene granica ili položaja oblasti pridružene nekom imenu ne moramo vršiti izmene na mestima koje je referišu. Treba kliknuti u kučicu rezervisanu za ime (name box) na levoj ivici menija za rad sa formulama i otkucati novo ime (dugo do 255 znakova)

koje ne sme sadržati blanko. Drugi način je da posle označavanja oblasti otvori meni Insert i izabere Name Define. Po otvaranju odgovarajučeg dijaloga otkucate ime u Names in Workbook polje i kliknete na OK. Ovaj dijalog omogućava brisanje ranije definisanih oblasti,tj. njihovih imena, kao i promenu njihovog opsega i lokacije kucanjem ili prepravkom sadržaja polja Refers to. Pomoću polja Refers to mogu se definisati i oblasti koje su sastavljene od nesusednih ćelija, a posebna mogućnost je da se imenuju konstante - mnogo je lakše pamtiti ime (npr."porez") nego ih smeštati na tabelu i referisati apsolutnim adresama

(H17). Konstanta može biti broj,tekst ili čak matrica. Defmise se iz menija Insert opcijom Name i izborom Define. Pojavljuje se dijalog Define Name, koji služi i za definisanje imena oblasti. U polju Names in Workbook unesite ime konstante, a u polju Refers to - njenu vrednost. Posle toga pritisnite taster Add i konstanta je zapamćena. Sada možete uneti novu ili zatvoriti dijalog sa Close.

U toku rada sa tabelama, često će se ukazati potreba da (neplanirano) promenite njihovu veličinu ili strukturu. Kopiranje (copy) i premeštanje (move) sadržaja ćelije se radi potpuno isto kao i u svakoj Windows aplikaciji. Treba biti oprezan pri smeštanju podataka na novu lokaciju, jer če raniji sadržaj ciljnih ćelija biti uništen. Ako su početna i ciljna lokacija za kopiranje ili premeštanje blizu(vidljive na ekranu), najbrži način za to je koriščenje vučenja i spuštanja.

Nove ćelije se unose iz Insert menija. Prvo se označi ćelija ili ćelije na mestu na kome želite da ubacite nove. Ako ih je više, Excel će ubaciti onoliko novih koliko je označeno starih. Iz Insert menija birate Cells, a u dijalog koji se pojavii unosite na koju stranu pomerate postoječe ćelije - udesno (Shift Cells Right) ili nadole (Shift Cells Down). Iz ovog dijaloga se vidi da se na isti način mogu ubacivati i celi redovi (Entire Row) i kolone (Entire Column), koji se pojavljuju levo od označene čelije ako se radi o novoj koloni, odnosno iznad nje ako se radi o redu. Brži način unošenja ćelija je da se, držeči Shift, vuče ručica za popunjavanje (kvadratič u donjem desnom uglu). Može se vući u bilo kom smeru - gore,dole,levo ili desno. Da bi se unelo više redova ili kolona, treba označiti onoliko kolona ili redova koliko novih želimo. Kolone se označavaju prevlačenjem miša preko odgovarajučih slova, dok se redovi označavaju preko njihovih rednih brojeva. Iz Insert menija se izabere Rows or Columns, posle čega ih Excel ubacuje na željena mesta. Susedni redovi se pomeraju naniže, a susedne kolone udesno.

Brisanje je vrlo sližno bilo kom drugom brisanju u Excel-u: označimo čelije koje želimo da uništimo i izaberemo Delete iz menija Edit. Posle biranja smera pomeranja preostalih ćelija ili eventualno brisanje celog reda ili kolone (dijalog je potpuno isti kao i onaj za ubacivanje) pritisne se OK i posao je gotov. Ako se briše više redova ili kolona, treba ih označiti po rednom broju ili slovu (na levoj strani i na vrhu tabele).

Excel omogućava i brisanje formata koji su primenjeni na sadržaj ćelije, samog sadržaja (čelija ostaje prazna ali zadržava formate) i napomena (koje mogu da se dodaju uz svaku ćeliju, a vide se samo kada ih zahtevamo). Treba izabrati Edit/Clear, a zatim all (brisanje formata,sadržaja i napomena), Formats (samo formati), Contens (samo sadržaj) ili Notes (samo napomene). Ako se briše samo sadržaj ćelije, dovoljno ju je označiti i jednostavno pritisnuti Delete.

Umetanje i breisanje čelija među već postoječim podacima može, ako ne obratite posebnu pažnju, izazvati ozbiljne poremec'aje u proračunima. Ako postoje formule koje se referiraju po adresi čelije na mesta koja su promenila sadržaj, te reference se moraju ručno podesiti na nove adrese.

1.2.11 Snimanje dokumenata

U ovom prozoru možemo izabrati disk, direktorij i ime datoteke. Znači možemo ispod naziva Drives izabrati disk na koji ćemo snimiti ovu datoteku koja sadržava tabelu. Isto tako, direktorij u koji čemo snimiti datoteku biramo u padajućem prozoru Directories. Na kraju treba specificirati još ime datoteke u kojoj se nalazi tabela (do 8 slova). To se vrši u padajućem prozoru za izlistavanje File Name. MS-Excel omogućava snimanje datoteka u različitim oblicima (razne vrste datoteka). To znači da snimanje datoteka sa tabelom ne mora biti u MS-Excel obliku, nego može biti i u nekom opštem obliku kao što je npr. tekst, 1-2-3 ili MS-Excel Pro forma i sl. Ukoliko želimo snimiti datoteku u nekoj drugoj formi, onda trebamo ispod naslova Save File as Type potražiti željeni oblik i izabrati ga. Po izabiranju određenog oblika, MS-Excel snimamo datoteku u datom obliku. Startno je oblik snimanja datoteke odnosno tabele postavljen na Excel Workbook.

U našem slučaju unesimo ime datoteke TABELAl, te pritisnimo taster OK. Ukoliko sada pogledamo kontrolnu liniju, videćemo novi naslov Microsoft Excel-TABELAl.XLS.

1.2.11.1 Zatvaranje tabele

Kada smo završili prve korake obrade tabele (uneli smo tekst i pohranili tabelu ga na tvrdi disk) zgodno je opisati koje je akcije potrebno poduzeti za zatvaranje tabele. To se jednostavno vrši opcijom File/Close. Po aktiviranju ove opcije i dalje se nalazimo u MS-Excel radnom okruženju, ali smo zatvorili tabelu (datoteku) koju smo do sada obrađivali. U slučaju da smo željeli, ne samo zatvoriti aktivnu tabelu, nego potpuno napustiti okruženje MS-Excela i vratiti se u MS-Windows radno okruženje, potrebno je izabrati opciju File/Exit. Ponovno startanje MS-Excela vrši se izabiranjem ikone MS-Excel for Windows.

1.2.11.2 Otvaranje postojeće tabele

Pošto smo zatvorili našu tabelu to znači da ona više nije prisutna u radnom okruženju MS-Excela. Zato, da bi je otvorili izaberemo opciju File/Open. Sada u novo prikazanom prozoru za dijalog sa korisnikom, ispod naslova File Name, unesemo ime naše datoteke sa tabelom: TABELAl. Naš izbor potvrdimo pritiskom na taster OK. Sada se otvara naša tabela TABELAl. Poštoje ona sada

aktivna možemo nastaviti sa njenim obrađivanjem (promenom sadržine, oblikovanjem, štampanjem i sl.)

1.2.12 Uređivanje i oblikovanje tabela

1.2.12.1 Formatiranje ćelija

Numeričke vrednosti su obično nešto više od pukih brojeva: one predstavljaju novčane iznose, kamatnu stopu, procenat, datum ili nešto deseto. Da bi svakome vec va prvi pogled bilo jasno o čemu se radi, treba da koristite odgovarajuče formate, pomoču kojih će sve srodne vrednosti izgledati na isti način. Excel nudi velike mogućnosti definisanja kao i neke ugraDene (najčešče korišćene) formate. Primeri su prikazani u tabeli 4. Formati su sastavljeni od znakova čije je značenje dato u tabeli. Postoje jos neki formati za preciznija podešavanja, kao i za uslovna prikazivanja i izbor boje sadržaja ćelije, kako bi se recimo, na prvi pogled videlo ko nije ispunio normu.

1.2.12.2 Unošenje formata

Kada se odlučite za odgovarajuči format, označite oblast čelija za koji želite isti način prikaza, a onda iz menija format izaberite Cells ili samo pritisnite Ctrl+1 na tastaturu. Pojavljuje se dijalog za formatiranje. ćelija kao na slici. Kliknite na tab Number; sa leve strane su kategorije (Categori), gde birate koju vrstu formata želite da koristite. Zatim u polju Type kliknite na onaj koji najbliže odgovara vašim potrebama; prikazuje se i primer njegovog efekta (Sample). Ako je potrebna neka izmena, za kategoriju birate Custom i u Type isti birate sličan format koji onda prepravite u ono što vam je potrebno. Novi format če, posle pritiska na OK, biti memorisan, tako da će te ga kasnije primenjivati bez ponovnog kucanja. Kad postanete dovoljno familijami sa znacima za formatiranje, najlakše je odmah po otvaranju dijaloga uneti ono što se želi u polje Type i time preskočiti traženje po kategorijama. Treba obratiti pažnju i na format za valutu (Currency) koji, ako se navede samo taraba, dodaje i oznaku navedenu u kontrolnom panelu samog Windows-a - ako tamo piše DIN ili YUD, taj če se tekst i pojavljivati. Na tasterskom meniju za formatiranje se nalazi nekoliko predefinisanih formata koji se mogu dobiti jednim klikom miša.

1.2.12.3 Uravnavanje teksta

Pod tablom Alignment nalaze se važne opcije za formatiranje teksta u ćelijama. Opsti format podrazumeva' podešavanje teksta na levu i brojeva na desnu ivicu, a pošto to često nije zadovoljavajuče ostavljene su velike mogučnosti za horizontalno i vertikalno podešavanje ( za razliku od Word-a), a može se zadati i orjentacija ispisa. Horizontalno formatiranje je klasično:

opšte , levo , desno, centrirano i uravnato po obe ivice (General, Left, Right , Center, Justify). Manje poznate opcije su popunjavnje ( Fill), gde se sadržaj ćelije ponavlja dok je ne popuni (može se širiti i na susedne!) i cenriranje preko selekcije (Center Across Selecion), koje centrira sadržaj ćelije preko svih označenih, što je pogodno za naslove. Na tasterskom meniju za formatiranje se nalaze najčešče korišćeni formati za horizontalno podešavanje. Po vertikali se satržaj može postaviti uz gomju ili donju ivicu (Top i Bottom), centrirati (Center) ili urediti po donjoj i gomjoj ivici tako da se popuni cela širina čelije ( Justify ).Ako tekst ne može da stane u jedan red, uključite opciju Word Wrap. Tab Font donosi mogučnosti za izbor fonta (vrsta slova ) i njegove veličine. Pošto se tekst i brojevi unose u osnovnom formatu (Default), ne izgledaju naročito lepo.Da bi ste ostavili bolji utisak, moraćete da radite na unapređenju izgleda tabele. Vrsta slova se biraju iz skupa fontova istaliranih na vašem računaru- na slici je prikazan primer tabele sa različitim atributima raznih delova teksta. Na tasterskom meniju za formatiranju se nalaze tasteri za izbor fonta, njegovu veličinu, podebljanje, iskošenje, podvlačenje i biranje boje teksta.Atribute možete menjati i pre nego što počnete sa unosom teksta u ćeliju.

Formatiranje tabela ustvari uopšte nije gubitak vremena. Da bi se ono što bolje i brže obavilo, Excel nudi dve vrlo moćne alatke: AutoFormat i Format Painter. AutoFormat donosi više predefinisanih izgleda tabela koja brzo i lako možete primeniti, dok Format Painter služi za brzo kopiranje formata. Za primenu auto formata prvo treba označiti ćelije na koje če se odnositi . Zatim se iz format menija izabere AutoFormat, posle čega se pojavljuje njegov dijalog kao na slici.Sleve strane je lista Table Format, iz koje se bira neki od predefinisanih formata. S desne strane se, u polju Sample, odmah vidi primer njegovog izgleda. Format tabele ili ćelije može da se prekopira na drugo mesto na dva načina: komandom Edit/Copy a onda Edit/Paste Special ili koriščenjem pomenutog Format Painter-a, čiji se taster nalazi na standardnom tasterskom meniju (ikona četke).

1.2.12.4 Dimenzije ćelija

Inicijalno sve čelije u radnom listu imaju istu širinu i visinu, što najčešće nije pogodno. Zato se one po potrebi mogu menjati, kako korišćenjem misa tako i iz odgovarajučeg dijaloga. Prvo se označi kolona (ako se menja širina) ili red (ako se menja visina), ili vise njih prevlačenjem preko oznaka adresa (prvi red i prva kolona).

Pomerite kursor do jedne od ivica i onda if vucite na željenu poziciju, držeći pritisnut levi taster.Preko dijaloga se takođe prvo označe željene kolone i onda se iz menija Format izabere opcija Column, a zatim AutoFit Selection.Sve označene kolone će se podesiti na širine svojih najsirih čelija. Ako se izabere Format/Width , u dijalog koji se pojavi može da se unese širina svih kolona koje sadrže ožnačene ćelije od jedno, izražena u broju karaktera standardnog fonta. Izborom Format/Standard Width određuje se širina svih ćelija na listi.

1.2.12.5 Poravnavanje podataka u ćelijama

Po celoj tabeli se možemo kretati kurzorima sa tastature ili pokretanjem miša. Poslije unošenja labele MS-Excel poravnava tekst prema levoj strani ćelije. Ako želimo drukčiji tip poravnavanja u ćeliji potrebno je pre unošenja labele ukucati jedan od sledeća tri specijalna znaka:

· poravnava tekst prema levoj strani čelije     

· poravnava teskt prema desnoj strani čelije     

· poravnava tekst u sredinu ćelije

Promena poravnavanja teksta koji je vec' unesen se vrši opcijom Format/Cells u listu Alignment.

Da bi uneseni tekst poravnali u sredinu ćelije izaberimo prvo ćeliju B3. Zatim aktiviramo opciju Format/Cells. U prozoru koji se pojavljuje izaberemo opciju Alignment., i opciju Centers.

Ponekad je potrebno uneti brojeve koji označavaju labele. U slučaju da ih unesemo na uobičajen način, MS-Excel bi ih tretirao kao brojne podatke. Zbog toga moramo "prevariti" MS-Excel. Prvo unesemo oznaku za poravnavanje teksta, pa zatim unesemo broj. To znači ukoliko želimno uneti broj 1993 kao labelu kojaje poravnana u sredinu unesemo sledeći niz slova: "1993. U ovom slučaju je MS-Excel broj 1993 prihvatio kao labelu. Brži način aktiviranja procesa poravnanja je preko 4 tastera za poravnavanje iz linije za formatiranje.

Potrebno je napomenuti da se u MS-Excelu brojevi standardno poravnavaju desno, a labele levo. Pretpostavimo da unesemo labelu čija dužina prevazilazi dostupnu veličinu - postavljenu dužinu čelije. Sada da bi videli celi tekst u ćeliji treba ppkrenuti opciju Format/Coulumn/AutoFit Selection. Posle ove opcije dužina c'elije (širina kolone) se povećava na dužinu koju zauzima najduži podatak u ovoj koloni (uzimaju se u obzir sve ćelije date kolone).

1.2.13 Imenovanje ćelija

Prilikom rada sa grupama ćelija zgodno je određenim grupama dodeliti određeno logično ime. To ime mora biti tako formirano da tačno odslikava funkciju koju vrši.naime, može se reći daje ime koje dajemo grupi čelija opisno npr. Porez, Ukupni iznos kredita i sl. Sama procedura imenovanja ćelije ili grupe ćelijajesledeća:

•  Izvršimo izabiranje ćelija kojima želimo dodeliti određeno ime.

•  Aktiviramo opciju Insert/Name/Define. Na ekranu se pojavljuje sledeći prozor.

1.2.13.1 Imenovanje grupe ćelija

U prozoru Refers To je upisana grupa ćelija kojoj želimo dodeliti ime. U taj prozor možemo i sami dopisati dodatne ćelije koje će činiti tu grupu. U prozoru Names in WorkGroup unosimo ime grupe čelija.

Jednostavniji način da se postigne imenovanje ćelija je prvo izabrati ćelije, i zatim pritisnuti kombinaciju tastera Ctrl+F3. Zatim u gomje pnkazanom prozoru na specificirano mesto upisati ime grupe ćelija.

Izbor ćelija po imenu

Da bi izabrali određenu imenovanu grupu ćelija pritisnemo taster F5 ili izaberemo opciju Edit/Goto. Na ekranu dobivamo sledeći prozor.

Ispod naslova Goto dat je spisak svih imenovanih grupa ćelija. Izaberemo određeno ime, postavimo ga u prozor Referencete i pritisnemo taster OK. U ovom trenutku smo izabrali odnosno učinili aktivnim grupu ćelija kojoj je dodeljeno izabrano ime.

1.2.14 Brisanje sadržaja ćelija

Brisanje sadržaja i formata ćelija je jednostavno. Prvo izaberemo ćeliju/e. Zatim opciju Edit/Clear/All za brisanje sadržaja i formata ćelije. Ako želimo brisati samo sadržaj ćelije onda izaberemo opciju Edit/Clear/Contents. Pod formatiranjem čelije podrazumevamo da smo postavili karakteristike grupe c'elija da mogu primati podatke samo određene vrste. Brisanje formatiranja ostvarujemo pomoc'u opcije Edit/Clear/Formats. Ukoliko želimo izbrisati ne samo sadržaj određene ćelije nego je i ukloniti iz tabele onda treba izabrati opciju Edit/Delete. Ovu opciju će propratiti sledeći prozor.

1.2.15 Kopiranje i pomeranje ćelija

Kopiranje i pomeranje ćelije ili ćelija može se izvršiti na više načina. Međutim, svaki od ovih načina započinje izabiranjem c'elija koje se ili pomeranju ili kopiraju. Posle izabiranja ćelije/a aktivira se opcija Edit/Cut ili Edit/Copy u zavisnosti da li prebacujemo ili kopiramo sadržaj ćelije/a. Zatim se postavimo na c'eliju koja predstavlja početnu ćeliju za kopiranje. Zadnji korak predstavlja izabiranje opcije Edit/Paste. Umesto izbora ove opcije isto bi postigli i istovremenim pritiskom na kombinaciju tipki Ctrl+Ins. Isto smo mogli učiniti upotrebom tastera Cut, Copy i Paste sa Toolbara. Ovakav način kopiranja vredi i za grupu ćelija.

1.2.16 Promena dužine ćelija

Podaci koje unosimo u ćelije su različite dužine. Naslovi tabela imaju najčesće najveću dužinu. Zbog toga je potrebno izvršiti usklađivanje dužine ćelija. Jednostavnije se to kaže formatiranje. Ako neki tekst ili broj sadržavaju više slova ili cifara no što startno dopušta postavljena dužina ćelija, onda su dati podaci prikazani nizom povisilica. Da bi te podatke videli potrebno je povećati dužinu čelija odnosno kolone kojoj ona pripada. To se najjednostavnije postiže sa mišem.

•   Miša postavimo na slovo koje označava ime kolone kojoj pripada data celija. Zatim pomerimo kurzor miša na poziciju izmedu te i sledeče kolone. Kurzor miša se pretvara u dvostruku strelicu.

•   Pritisnemo levu tipku miša i držec'i je vučemo miš na desno (za proširivanje ćelija) ili na levo (za sužavanje čelija).

•   Po proširenju dužine ćelije otpustimo levi taster misa.

Isto se može ostvariti pomoću desnog tastera miša. Dovedemo kurzor miša u kolonu u kojoj se nalazi čelija čiju dužinu proširujemo. Zatim pritisnemo desni taster miša. Na ekranu se pojavljuje prozor sa opcijama. Izaberemo opciju Column Width. Sada se pojavljuje novi prozor. Dati prozor je predstavljen na sledečoj slici.

1.2.16.1 Prozor za promenu dužine ćelije (kolone)

Isto tako se može promeniti visina ćelija. Izaberemo mišem red kojem želimo promeniti   visinu   izborom   broja   reda.   Sada   izaberemo   opciju Format/Rovv/Height. Na ekranu se dobiva sledeći prozor.

1.2.17 Radne sveske

Svi Excelovi dokumenti su radne sveske, i one mogu da sadrže:

• radne listove (o kojima govori ovo poglavlje)

• listove sa dijagramima (o kojima govori četvrti deo)

• listove sa makroima, module i listove sa okviriina za dijalog (o kojima govori sedmi deo).

Kada pokrenete Excel, na ekranu se automatski prikazuje radna sveska Bookl. Bookl je nova, nesačuvana radna sveska, spremna za unošenje podataka. Ako je prva stvar koju radite u Excelu 8 otvaranje postojeće radne sveske, sveska Bookl zatvara se automatski - ne morate to sami da uradite.

1.2.17.1 Izrada novih radnih svezaka

Postoji nekoliko načina da napravite novu radnu svesku. Kada je Excel pokrenut radnu svesku otvarate birajući File / New iz menija ili pritskom na dugme New Work-book palete Standard. Svaka radna sveska koju izradite tokom jednog pokretanja Excela automatski dobija ime Book sa rednim brojem, tj. Bookl, Book2 itd. Kada prvi put hoćete da sačuvate radnu svesku snimanjem na disk, možete da joj date i neko drugo ime.

Novu radnu svesku možete da napravite tako što ćete na radnu površinu Windowsa 95 postaviti jednu ikonu. Pritisnite desni taster miša pokazujući na radnu površinu da biste otvorili priručni meni i iz njega izaberite New / Microsoft Excel Worksheet. Na radnoj površini pojaviće se ikona kojom se automatski pokreće Excel i otvara nova radna sveska pod imenom Bookl.

1.2.17.2 Otvaranje postojećih radnih svezaka

Za otvaranje radne sveske koja je ranije sačuvana na disku, izaberite komandu 

File / Open ili pritisnite dugme Open na paleti Standard. 

Otvoriće se okvir za dijalog Open. Ako ste koristili druge apiikacije iz paketa Microsoft Office kao što je na primer Word, ovaj okvir za dijalog treba da vam je poznat. 

Dijalog Open ima osam važnih dugmadi u svom gornjem delu:

· Up One Level (Jedan nivo naviše): Prelaz na sledeći viši nivo u strukturi direktorijuma.

· Search the Web (Pretraži Web): Pokreće vaš čitač Web strana.

· Look in Favorites (Potraži u direktorijumu Favorites): Prikazuje datoteke, koje se nalaze u direktorijumu Favorites koji služi za smeštaj prečica do datoteka koje često koristite.

· Add To Favorites (Dodaj u direktorijum Favorites): Istaknite datoteku pa  pritisnite ovo dugme da je dodate u direktorijum Favorites.

· List (Prikaži spisak): Prikazuje spisak datoteka bez detaljnih informacija,.

· Details (Detalji): Prikazuje imena datoteka zajedno sa podacima o njihovoj veličini, tipu i datumu poslednje izmene,

· Preview (Prethodni prikaz): Prikazuje izgled izabrane datoteke u dijalogu Open.

· Commands And Settings (Komande i podešavanja): Kada pritisnete ovo  dugme pojavljuje se meni sa opcijama datoteke.

Da biste otvorili postojeću radnu svasku pritisnite dugme Start pa izaberite Open Oftice Docunient. l'ojaviće se dijalog Open (slika 2.1) koji vam omogućava da izaberete datoteku prebirajući po hijerarhiji direktorijuma na disku.

Rad pomoću  prečica Microsoft Office Shortcut Bar
Da biste napravili novu radnu svesku pomoću palete prečica Shortcut Bar pritisnite na njo] dugmence Start A New Docuinent.

Postojeću radnii svesku otvorite pritiskajući dugme Open A Document.

Snimanje urađenog
Izmene uradene u radnoj svesci sačuvaćete snimanjem na disk :

· Izaberite komandu  File / Save. 

· Drugi način je da pritisnete dugme Save na paleti Standard. Kada to radite prvi put, Excel otvara dijalog Save As da biste datoteci dali ime.

Naknadno zadate komande File / Save automatski će sačuvati datoteku pod tekućim imenom.

napomena: Imena datoteka u Excelu ne podležu ograničenjima koja je nametao DOS - osam znakova, tačka, pa još tri znaka. Isto tako nije obavezno dodavati podrazumevani nastavak imena datoteke .XLS. Medutim i dalje možete da koristite i prikazujete nastavke imena datoteka tako što ćete pokrenuti Windows Explorer, izabrati View > Options i ukloniti potvrdu opcije Hide MS DOS File Extensions.

Komanda File > Save As omogućava da datoteku sačuvate i pod drugim imenom. Dijalog ove komande jednak je onom koji se otvara kada prvi put snimate datoteku . Ova mogućnost je korisna kada treba da saćuvate različite verzije dokumenta na kojem radite.

1.2.17.2.1 Razlićiti tipovi datoteka

Padajuća lista Save as Type u dijalogu Save As omogućuje da datoteku sačuvate u jednim od više različitih formata. Na primer, datoteku možete sačuvati u formatu Excela 5/7 tako da je mogu koristiti i korisnici koji nisu prešli na Excel 8. 

1.2.17.2.2 Opcije za čuvanje datoteka

Pritisnite dugme Options iz dijaloga Save As da izaberete neku od opcija za ćuvanje. Pojavljuje se dijalog Save Options:

Opcije File sharing iz ovog dijaloga obezbeduju zaštitu radne sveske 

Potvrdite opciju Always create backup ako želite da Excel pri svakoin snimanju automatski pravi rezervnu kopiju datoteke.

1.2.17.2.3 Zatvaranje radne sveske

Aktivnu radnu svesku zatvarate

komandom File > Close. Ako u njoj ima nesačuvanih izmena, Excel će vas pitati da li želite da ih sačuvate.

savet: Ako želite da zatvorite sve radne sveske jednom komandom, držite taster Shift i izaberite meni File. Komanda Close će se promeniti u Close All kojom možete zatvoriti sve radne sveske.

1.2.17.2.4 Rad sa radnim listovima

Radna sveska može da sadrži jedan ili nekoliko stotina radnih listova, ako imate dovoljno memorije. Obično su radni listovi u okviru radne sveske u međusobnoj vezi..

1.2.17.2.5 Aktiviranje radnih listova

Da biste aktivirali radni list koristeći miša, izaberite jezičak radnog lista na dnu radne sveske.

Da biste aktivirali radni list pomoću tastature postupite na jedan od sledećih načina:

• Pritisnite tastere Ctrl+Page Down da aktivirate sledeći radni list.

• Pritisnite Ctrl+Page Up da aktivirate prethodni radni list. Istaknuti jezičak pokazuje koji radni list je aktivan.

1.2.17.2.6 Pomeranje jezičaka radnih listova

Samo nekoliko jezičaka radnih listova može se videti u jednom trenutku. Jezičke svih radnih listova možete da pregledate pomoću dugmadi za pomeranje jezičaka (engl. tab scrolling buttons) Ova četiri dugmeta kontrolišu koji će jezičci biti prikazani, ali ne menjaju aktivni radni list.

Broj vidljivih jezičaka možete da promenite pomeranjem birača broja vidljivih jezičaka (engl. tab split box) ulevo ili udesno . Postavite pokazivač na birač tako da dobije oblik dveju paralelnih linija sa strelicama usmerenim na obe strane, zatim ga povucite ulevo (da biste videli manji broj jezičaka) ili udesno (da biste videli veći broj).

1.2.17.2.7 Umetanje i brisanje radnog lista

Da biste umetnuli radni list u aktivnu radnu svesku:

· Izaberite komandu Insert / Worksheet. 

· Možete i da izaberete jezičak desnim tasterom miša, a zatim komandu Insert iz priručnog menija koji se pojavi.

Da biste izbrisali radni list iz radne sveske:

· Aktivirajte ga, zatim izaberite komandu Edit > Delete Sheet. Excel će potvrditi ovu akciju prikazivanjem odgovarajućeg okvira za dijalog. 

· Druga mogućnost je da desnim tasterom miša izaberete jezičak lista. Kada se pojavi priručni meni, izaberite komandu Delete.

1.2.17.3 Kopiranje i premeštanje radnih listova

Radni listovi se mogu kopirati ili premeštati u okviru iste radne sveske ili u drugu radnu svesku.

1.2.17.3.1 U okviru iste radne sveske

Da biste premestili radni list u okviru iste radne sveske najpre aktivirajte radni list a zatim upotrebite jedan od sledećih metoda:

• Mišem izaberite jezičak radnog lista, zatim ga povucite na novo mesto u nizu jezićaka radnih listova.

• Izaberite Edit / Move or Copy Sheet. Pojavljuje se dijalog Move or Copy. U listi Before sheet (ispred lista) izaberite novu poziciju lista i pritisnite OK.

Da biste kopirali radni list u okviru iste radne sveske postupite kao i pri premeštanju, sa sledećim izmenama:

• Držite taster Ctrl pa povucite jezičak radnog lista na novo mesto u nizu jezičaka radnih listova.

• Potvrdite opciju Create a Copy u dijalogu Move or Copy. Kopija radnog lista je umetnuta.

1.2.18 U drugu radnu svesku - lakši naćin

Najlakši način za premeštanje ili kopiranje lista u drugu radnu svesku je da se povuče i pusti njegov jezičak. Obe radne sveske moraju biti otvorene i vidljive. (U odeljku o prozorima biće objašnjeno kako više radnih svezaka može da bude vidljivo u istom trenutku.) Da biste premestili list, povucite jezičak do niza jezićaka u drugoj radnoj svesci. Da biste napravili kopiju, držite taster Ctrl dok to radite.

1.2.18.1.1 U drugu radnu svesku - teži način

Ako ne želite da obe radne sveske budu vidljive, ili ako želite da list premestite/kopirate u novu radnu svesku:

1. Izaberite komandu Edit  / Move or Copy Sheet i otvoriće se dijalog Move or Copy.

2. Navedite odredišnu radnu svesku u padajućoj listi To book. Lista će sadržati sve otvorene radne sveske, kao i mogućnost izbora nove radne sveske (New Book).

3. U listi Before sheet zadajte gde radni list treba da bude smešten u odredišnoj radnoj svesci (ispred kojeg lista).

4. Potvrdite opciju Create a copy da kopirate list, odnosno uklonite potvrdu da premestite list.

5. Pritisnite OK.

1.2.18.1.2 Rad sa više listova

Već opisani postupci za kopiranje, premeštanje i brisanje listova mogu da se primene na više listova u isto vreme. To se postiže izborom nekoliko radnih listova pre izvršavanja operacije. Izbor jezičaka radnih listova sličan je izboru više stavki iz okvira sa listama za višestruki izbor.

• Da biste izabrali ili poništili izbor nesusednih listova, držite taster Ctrl dok mišem birate jezičke.

• Da biste izabrali susedne jezičke, držite taster Shift dok mišem birate jezičke.

Da biste poništili izbor jezičaka pritisnite levim tasterom miša neki jezičak koji nije izabran ili pritisnite jezičak desnim tasterom miša pa izaberite Ungroup Sheets iz priručnog menija.

Kada ste izabrali listove koje hoćete da premestite ili kopirate, pritisnite i držite pritisnut taster Ctrl dok ih povlačite na novu lokaciju.

savet: Više radnih listova možete da uređujete i formatirate u isto vreme ako izaberete vise jezičaka radnih listova. 

1.2.18.2 Koriščenje smislenih imena za radne listove

Nije obavezno da koristite Excelova standardna imena radnih listova. Jezičci postaju veoma korisni interfejsi za rad sa radnom sveskom ako su listovi nazvani, na primer, Anaiiza Prodaje i Plan umesto Sheetl i Sheet2. Da biste preimenovali radni list uradite nešto od sledećeg:

• Izaberite komandu Format / Sheet / Rename.

• Desnim tasterom miša izaberite jezičak, a zatim komandu Rename iz priručnog menija.

• Pritisnite dvaput jezičak lista.

Kao posledica svake od ovih procedura biće istaknuto ime lista na jezičku. Upišite novo ime pa pritisnite Enter.

1.2.18.3 Promena broja radnih listova 

Nova radna sveska standardno ima 3 radna lista. Standardan broj radnih listova možete da promenite 

Komandom Tools / Options / izaberite karticu General iz dijaloga Options da otkrijete raspoložive opšte opcije iz ovog dijaloga 

Parainetar Sheets in new workbook izmenite po želji. Mada ne postoji ograničenje u pogledu broja listova koji se mogu dodati u radnu svesku, ako izuzmemo memorijska ograničenja, podrazumevani broj radnih listova definisan parametrom  Sheets in new workbook ograničen je na maksimalno 255 listova.

1.2.19 Unošenje datuma

Datumi imaju specijalan oblik. Zbog toga prilikom njihovog unošenja treba obratiti pažnju na pojedina pravila. Datumi se ukucavaju u jednom od sledećih formata:

DD-MMM-YY  -  05-JUN-93

DD-MMM   -05-JUN

MMM-YY  - JUN-93

Uneseni podatak potvrdimo pritiskom na tipku Enter. Ukoliko nismo specificirali godinu za uneseni datum (DD-MMM) MS-Excel pretpostavlja da je u pitanju trenutna godina, pa sam dodaje godinu.

1.2.20 Rad sa formulama

Još nismo razjasnili upotrebu operatora i formula. Sa operatorima vršimo osnovne aritmetičke operacije, a sa fonnulama vršimo aritmetičke, statističke, logičke i druge operacije. Oznake ćelija su date sa slovom kolone i brojem reda npr. A6 (kolona A, 6. red). MS-Excel omogučava upotrebu sledećih operatora:

Iz navedenih slučajeva može se primetiti da se početni element u formuli, ako je u pitanju ćelija, uvek označava predznakom ili + ili -.

Da bismo uneli formulu koja u ćeliju Al izračunava sumu tri ćelije npr. A3, C6 i F8 potrebnoje uraditi sledec'e:

•   Uneti vrednosti u ćelije A3, C6 i F8. Ukoliko u neku od ovih ćelija nije unesena brojna vrednost, MS-Excel uzima da ta ćelija ima brojnu vrednost 0.

•  U ćeliju npr. Bl se unese formula +A3+C6+P8 i potvrdi pritiskom na taster Enter.

Rad sa formulama
Osnovna namena Excel-a su tabelama izračunavanja. Da bi se nešto moglo da se izračuna, treba zadati formule zavisnosti odgovarajučih ćelija. Dugom evolucijom ove vrste promena, iskristelisale su se prave potrebe Ijudi i razvijeni su mnogi alati koji pomažu u nalaženju najboljeg resenja i oslobađaju jednoličan i dosadan posao, a mogućnosti prevazilaze mnoge naučne kalkulatore. Excel je izuzetno jak u ovoj oblasti. Formule mogu da sadrže operatore, reference na čelije, konstante.-.Ako, recimo, treba da izračunamo srednju vrednost tri broja upisanu u čelije A1,B1 i Cl, koristićemo: =(A1+B1+C1)/3. Svaka formula mora početi znakom jednakosti da bi je Excel pravilno protumačio. Matematički operatori koje Excel prepoznaje su stepenovanje (A), sabiranje, oduzimanje, množenje i deljenje. Operacije se u okviru formule izvode prirodnim redosledom - sleva nadesno, uz poštovanje prioriteta redosleda. "Najstarija" operacija je stepenovanje, sledeća kategorija su množenje i deljenje, a u poslednju spadaju sabiranje i oduzimanje. Zagrade se koriste na uobičajen način i služe za promenu redosleda izvršavanja. Dakle, nema izmena u odnosu na standardnu matematiku.

Formula se unosi kucanjem ili označavanjem adresa ćelija. Prvo se označi čelija u kojoj želimo da se pojavi rezultat. Zatim se kuca znak jednakosti (=) koji Excel-u govori da unosimo formulu, a za njim i sam tekst, koji se pojavljuje na odgovarajučem tasterskom meniju. Rezultat

se izračunava čim .se pritisne Enter. Drugi način je sličan, ali se adrese čelija koje sadrže operande ne unose ručno, već se na svaku od njih klikne misem, a Excel sam upiše adresu. Ovako se mogu unositi kako adrese pojedinačnih ćelija tako i oblasti (prevlačenjem).

Ako želimo da prekinemo unos i zanemarimo otkucani deo, dovoljno je da pritisnemo Esc. Na tasterskom meniju za fonnule možemo obaviti iste operacije u posebnom polju za unos. Levo od polja za unos su ikone sa oznakama "X" i "štrikla", koji imaju istu ulogu kao tasteri Esc i Enter. Tu je i taster sa oznakom fx, koji aktivira dodatni alat za unosenje složenih fonnula -čarobnjak (Function Wizard), o kome cemo govoriti nešto kasnije.

U početku ćemo verovatno da dobijamo poruke o greškama. Error! Najčešče greške su deljenje nulom (tj. sadržajem prazne ćelije), referisanje na praznu čeliju, brisanje ćelije koja se koristi u nekoj formuli ili korišcenje imena oblasti kada se očekuje adresa samo jedne čelije.

Excel u normalnom radu ne prikazuje tekstove formula koje se nalaze u čelijama, več samo njihov rezultat. Ako kliknemo na ćeliju, tekst ce se pojaviti u odgovarajučem polju tasterskog menija za formule, gde se može i prepravljati.Ponekad je potrebno da se na radnom listu vide sve formule - aktiviramo meni Tools/option, kliknemo na tab View, a zatim i na polje Formulas tako da se pojavi znak "x", označavajuči daje opcija uključena. zatim kliknemo na OK ili pritisnemo Enter. Za ovu operaciju postoji i kombinacija na tastaturi - pritiskom na Ctrl+'

1.2.20.1 Ispravljanje formula

Formula se ispravlja kao i svaki drugi tekst u ćeliji: označimo celiju, pritisnemo F2 da bi ušli u mod za prepravljanje (edit mode) ili samo kliknemo na na formului koja se pojavila u polju tasterskog menija. Može se i dva puta kliknuti na čeliju, što daje isti rezultat. Dalje ispravke teku kao i kod običnog teksta, uz koriščenje kursorskih Del i Backspace tastera. Na kraju se pritisne Enter i operacijaje završena.

Kopiranje formula je slično kopiranju ostalih podataka. Označimo čeliju koja sadrži željenu formulu, iz menija Edit izaberemo Copy i označimo jednu ili više ćelija u koje treba prekopirati formulu. Možemo se prebaciti i na drugi radni radni list ili radnu knjigu: iz menija Edit izaberemo Paste i operacijaje završena. Za brže kopiranje prostijeje koristiti "vuci-i-pusti" metod: označimo celiju i, držeči pritisnut taster Ctrl, odvučemo je na željeno mesto. Ako treba da se kopira formula na više susednih mesta, koristi se automatsko popunjavanje (AutoFil).

Treba obratiti pažnju na korisnu osobinu Excel-a da pri automatskom popunjavanju i kopiranju sam pazi na reference ćelija i podešava ih relativno u odnosu na novi položaj na radnom listu. Na primer, ako u nekoj tabeli imamo podatke koji su raspoređeni po redovima, i na kraju prvog kreiramo formulu Al+Cl+Dl, po operaciji automatskog popunjavanja nadole čelije sa formulom, one če sadržavati fonnule A2+C2+D2, A3+C3+D3 itd.

Kada ne želimo da se reference na neke čelije menjaju pri kopiranju ili pomeranju, treba da se zadaju u apsolutnom obliku. Formule u celijama B10,C10 i DIO sa slike koriste apsolutnu referencu na čeliju E2, koja sadrži predviđenu prodaju. Formule u njima dele odgovarajuče sume iz reda 9 sadržajem celije E2. Da bi referenca ćelije postala apsolutna mora da se doda znak $ispred slova koloneili reda koji Čine adresu. Tako formula u BIO glasi B9/$E$2.

1.2.20.2 Alati za rad sa formulom

Kada god menjamo sadržaj neke ćelije (nesto unosimo, brišemo ili menjamo) Excel preračunava vrednost svih formula koje se nalaze u radnoj knjizi.Možemo da isključimo automatsko preračunavanje tako što se otvori meni Tools, izabere se stavka Options i klikne na Calculation tab. Potom biramo način koji nam najviše odgovara:- Automatic - automatski mod rada. Cela radna knjiga se preračunava svaki put kada se nešto izmeni.- Automatic except Tabels - Preračunava se sve osim formula koje se nalaze u tabelama. Ovaj mod se odnosi na rad sa bazama.- Manual - ručno. Excel preračunava samo onda kada mu to naložimo pritiskom na F9 ili biranjem iz menija Tools Option/Calculation/Calc Now.

Jedna od najčešćih operacija u tabelama podataka je sabiranje, koje se izvodi funkcijom Sum. Zato se funkcija lako unosi: kliknete na ikonu AutoSum na standardnom tasterskom meniju. Kada se označava ciljna ćelija (koja treba da primi formulu, teži se da bude na kraju kolone ili reda, jer se uglavnom unose oblasti nalevo ili nagore. Ako treba da menjamo oblast kliknemo u označenu ćeliju sa formulom i oznažimo ćeliju sa formulom i prepravljamo je ručno ili prevlačenjem miša, pa se pritisne Enter.

1.2.20.3 Funkcija Wizard

Čarobnjak (Funkcion Wizard) pomaže za unošenje kompleksnih formula. Najpre se označi ćelija koja treba da sadrži rezultujuču formulu, a onda se iz menija Insert izabere opcija Function... ili na tasterskom meniju pritisne fx. Sa leve strane iscrtanog dijaloga pojavljuje se lista kategorija (Function Category), a sa desne lista funkcija koje izabranoj kategoriji pripadaju (Function Name). Ova podela je vrlo zgodna za lakse pronalaženje željene funkcije.

Funkcije se ispravljaju kao i ostale formule, uz dodatnu mogučnost upotrebe čarobnjaka. Označi se čelija sa funkcijom. Zatim se pozove čarobnjak za funkcije i pojavi se dijalog za ispravljanje argumenta potpuno isti kao i onaj za njihov unos. Po završetku operacije se pritisne Finish. Korišćenjem tastera Back vračaju se prethodni koraci tako da greska ne znači i da se ceopostupak mora da ponavlja.

1.2.21 Rad sa funkcijama

Osim unošenja formula postoji mogućnost unošenja funkcija koje su ugrađene u MS-Excel. Za funkcije je karakteristično da se prilikom unošenja započinju slovom @ iza kojeg sledi ime i argument funkcije. Pretpostavimo da trebamo prethodno sabiranje ostvariti funkcijom SUM. U tom slučaju bi u čeliju Al upisali sledeće: @SUM(A3,C6,F8). Znači, u ovom slučaju smo izvršili sabiranje funkcijom SUM čiji su argumenti A3, C6 i F8 odvojeni zarezom. Ukoliko želimo pronaći srednju vrednost određene kolone npr. kolone B, koja sadržava komponente od ćelije B3 do ćelije BIO proceduraje sledeća:

•   Postavimo kurzor na poziciju ćelije koja će sadržavati srednju vrednost date kolone.

•  U toj ćeliji unesemo formulu @AVG(B3..B10). Izbor potvrdimo tasterom Enter.

Iz navedenog se vidi da se raspon od više bliskih ćelija istog reda ili kolone označava početnom i krajnjom ćelijom koje su tačke ili dvotačkom (B1..B3 ili B1:B3). Isto tako ako imamo različite listove u fascikli Jan i Feb onda je specifikacija podataka za listove data sa uskličikom kao npr. Jan!Bl:B3. To označava da smo izabrali ćelije Bl, B2 i B3 u listu fascikle Jan.

Ugrađene funkcije možemo ili poznavati ili pronaći u priručniku ili unutar programa izabrati iz spiska funkcija. Spisak dostupnih funkcija se aktivira pdtiskom na taster Function Wizard. Na ekranu se pojavljuje prozor sa Hstom dostupnih funkcija raspoređenih po kategorijama funkcija Function Category i imenom unutar izabrane kategodje funkcija Function Name.

Sumiranje više c'elija predstavlja najčešće korišćenu funkciju. Zbog toga je ova funkcija prisutna kao taster na Toolabru. Da bi upotrebili taj taster trebamo se držati sledećeg:

•   Mišem izabreremo ćeliju u kojoj će se nalaziti rezultat sume više ćelija.

•  Ne otpuštanjem levog tastera miša razvući oblast prema svim ćelijama koje uklJučujemo u proces sumiranja.

•  Pritisnuti taster na Toolabru sa oznakom Sigma.

Ukoliko želimo kopirati formulu iz ćelije Bl, koja sadržava formulu +A3+C6+F8, u c'eliju Cl trebamo izvršiti sledeće radnje:

•   Pozicionirati miš na ćeliju B 1.

•   Izabrati iz menija Edit opciju Copy.

•   Pozicionirati miš na ćeliju Cl.

•   Izabrati iz menija Edit opciju Paste.

Navedene akcije možemo postic'i korišćenjem tastera Copy i Paste na Toolabru. Sada smo umesto formule +A3+C6+F8 iskopirali relativnu formulu B1=+A3+C6+F8. To znači ako smo to iskopirali, na prethodno navedeni način, u ćeliju Cl, došlo je do relativnog pomeranja za je jednu kolonu te je u c'eliji Cl postavljena formula C1=+B3+D6+G8.

1.2.21.1 Umetanje funkcija

Excel sadrži nekoliko stotina matematičkih, logičkih, statističkih, finansijskih i drugih funkcija, koje se mogu umetnuti u radni list na sledeći način:

· Označimo ćeliju u koju želimo umetnuti funkciju

· Izaberimo iz menija stavku Insert(Function, ili pritisnimo dugme Paste Function na paleti sa alatkama.

· U dijalogu (Paste Function) izaberimo oblast (Function category) i naziv (Function name) željene funkcije, pa pritisnimo dugme OK.

· U sledećem dijalogu, čiji izgled zavisi od funkcije, upišimo ili označimo oblast ćelija koje sadrže argumante funkcije i pritisnimo dugme OK.

NAPOMENA:
Funkciju možete izbrisati iz ćelije prepisivanjem njenog sadržaja. Iz ovog razloga, treba biti pažljiv pri unosu podataka u tabelu. Pojedine ćelije se mogu zaštiti od upisivanja, ali način zaštite prevazilazi okvire ovog gradiva. Korisnik o tome može više pročitati u bilo kom uputstvu kao i u Help-u programa.

Najčešće korišćene funkcije su sledeće:

· sum
suma

· average
prosek

· if
ako, funkcija za uslovno izvršavanje

· hyperlink
hiperveza

· count
broj pojavljivanja

· max
maksimalna vrednost

· sin
sinus

· sumif
uslovljena suma

· pmt
izračunavanje rata

· stdev
standardna devijacija

1.2.22 Rad sa apsolutnim adresama

Za slučaj da smo trebali iskopirati formulu B1=+A3+C6+F8 u čeliju Cl, odnosno daje C1=+A3+C6+F8 potrebnoje da koristimo referenciranje na apsolutne adrese. Referenciranje na apsolutne adrese se postiže postavljanjem oznake $ ispred slova koje označava kolonu. Isto vredi i za red označen sa brojem. Zbog toga, apsolutna adresa ćelije Cl je $C$1. Da bi određene ćelije napravili sa apsolutnim oznakama izaberemo date ćelije mišem, i pritisnemo taster F4.

Logički operatori služe za donošenje odluka i za grananje prilikom odlučivanja. To znači da c'e se izvršavati različite radnje ili funkcije u zavisnosti od vrednosti testiranog uslova. Da bi to pojasnili razmotrimo IF funkciju. Funkcija ima oblik:

"IF(uslov, DA, NE)"

odnosno ukoliko je uslov ispunjen tj. tačan uradi specificirano kao drugi argument funkcije, a ukoliko nije tačno uradi specificirano kao treći argument funkcije. To možemo potkrepiti i konkretnim primeromr*

IF( (B12-600000)>0, 600000*0.05, 600000*0.03)

Pojednostavljeno rečeno ukolikoje zadovoljen uslov B12 > 600000, u c'eliju u kojoj se nalazi IF funkcija postavi rezultat operacije 600000*0.05, a ukoliko uslov nije zadovoljen u istu ćeliju pohrani rezultat operacije 600000*0.03.

1.2.23 Fascikle

MS-Excel omogućava kreiranje povezanih tabela uključujući tabele u fascikle. Svaka tabela predstavlja jednu stranicu, a svaka fascikla sadrži startno 16 stranica. Svaka stranica (list) ima svoje ime. Ovakav pristup radu sa tabelama je interesantan za administrativne potrebe. Npr. na 12 stranica imamo tabele poslovanja koje predstavljaju svaki mesec godine, a na trinaestoj stranici imamo tabelu koja objedinjuje sve relevantne podatke iz prethodnih 12 stranica. Pri tom poslednja strana formira godičnji izveštaj.

Kada prvi put otvorimo MS-Excel datoteku, na ekranu dobivamo novu praznu fasciklu.

1.2.23.1 Promena karakteristika fascikle

Možemo uočiti da na fascikli imamo podsetnike po stranicama koje sadržavaju slova od Sheetl do Sheetl6. Ta imena stranica možemo promeniti i prilagoditi našim potrebama. Za to trebamo učiniti sledeće:

•  Miš postaviti iznad podsjetnika čije ime želimo menjati, i pritinuti desni taster miša. Sada trebamo iz novo prikazanog prozora izabrati opciju Rename.   To   isto   možemo   postići   i   izabiranjem   opcije Format/Sheet/Rename. Na ekranu se pojavljuje sledeći prozor.

•  Ukucano ime potvrdimo pritiskom miša na dugme OK ili pritiskom na taster Enter.

Treba još napomenuti da imena stranica ne smeju sadržavati specijalne karaktere, ali mogu sadržavati prazna polja (Space karakter).

Postoje još dodatne opcije koje možemo primeniti nad stranicama fascikle. Jedna od tih opcija je i sakrivanje izabrane stranice. To se postiže izborom stranice koju želimo sakriti i aktiviranjem opcije Format/Sheet/Hide. U tom trenutku izabrana stranica postaje sakrivena (ne vidimoje).

Međutim, na jednostavan način je možemo i "otkriti". U tom slučaju izaberemo opciju Format/Sheet/UnHide. Na ekranu se pojavljuje spisak svih sakrivenih stranica. Prozor u kome je dat spisak sakrivenih stranica fascikle prikazanje na sledećoj slici.

zborom određene stranice iz datog spiska i potvrđivanjem tog izbora sa tasterom Enter činimo da izabrana stranice nije više sakrivena.

1.2.23.2 Rad sa grupama stranica

lako se uobičajeno radi sa svakom stranicom fascikle posebno, u pojedinim slučajevima je zgodno raditi sa više stranica istovremeno. Tu mogućnost nam MS-Excel pmža. Da bi izabrali više stranica treba uraditi sledeče:

•   Mišem izabrati prvu stranicu koju uključujemo u grupu stranica fascikle.

•   Pritisnuti taster Ctrl i izabrati svaku stranicu posebno. U slučaju da stranice čine grupu kao uzastopni red onda umesto tastera Ctrl upotrebljava se taster Shift. U ovom slučaju se iza pritiska na taster Shift treba izabrati poslednja stranica u grupi.

Mi smo zapravo na ovaj način uspostavili grupu stranica u fascikli.

Ukoliko smo izvršili grupisanje stranica u fascikli onda se pri unošenju podataka u određenu čeliju jedne stranice, dati podatak unosi u datu ćeliju na svakoj stranici ove grupe.

1.2.24 Rad sa grupama ćelijama

Pri radu sa čelijama često se obrađuju cele grupe ćelija. Npr. uobičajeno je prebacivanje i/ili kopiranje sadržine grupe ćelija sa jedne na drugu lokaciju, formatiranje grupe ćelija, izvršavanje aritmetičkih operacija nad grupom ćelija i dr. Grupa ćelija predstavlja, u tabeli, jednu pravougaonu oblast koja je ograničena gomjom najlevijom ćelijom i donjom najdesnijom ćelijom. Upravo ćelije ograničavači određuju blok ćelija.

Izbor grupe ćelija je jednostavan. Mišem označimo levu gomju c'eliju pritiskom na levo dugme miša. To dugme na mišu ne puštamo nego ga držimo dok razvlačimo aktivno izabranu oblast do donje najdesnije ćelije koja formira tu grupu ćelija.

Stvar se ponešto komplikuje ukoliko grupu ćelija čine razuđene ćelije. U tom slučaju moramo stalno držati pritisnut taster Ctrl dok mišem izabiremo ćelije koje c'e činiti grupu. Još složeniji slučaj je izbor c'elija na istim pozicijama, ali na različitim stranicama fascikle. U tom slučaju moramo prvo formirati grupu stranica u fascikli i zatim izabrati određenu/e ćeliju/e. U slučaju da treba izabrati različite ćelije na različitim stranicama MS-Excel nam nudi zaista jednostavno rešenje. Prvi izaberemo ćelije na jednoj stranici, zatim na drugoj i tako sve do zadnje stranice. Prilikom tog procesa izabiranja na svakoj stranici ostaje izbor aktivan dok ne izvršimo njegovo negiranje izabiranjem drugih ćelija.

1.2.25 Ubacivanje i brisanje redova i kolona

Može nam se dogoditi da previdimo određeni red ili kolonu tokom procesa unošenja podataka u tabelu. Zbog togaje potrebno ubaciti novi red ili kolonu u večkreiranu tabelu. Proceduraje sledeća:

•   Postavimo kurzor miša na red iznad ili na kolonu ulevo od ciljnog mesta reda ili kolone koju želimo ubaciti.

•  Izaberemo opciju Insert/Rows ili Insert Columns. Brisanje se vrši nas sličan način.

•  Izaberemo red ili kolonu koju želimo ukloniti.

•   Aktiviramo opciju Edit/Delete. Na ekranu se pojavljuje sledeći prozor.

Prikazuje brojeve u tzv. novčanom formatu što znači da ispred broja dolazi ''Oiaka novčane valute. On sadržava i decimalnu tačku, ali i decimalni zarez koji ^ljuje hiljade. Negativne vrednosti se mogu pojaviti okružene zagradama.
Prikazuje datum u jednom od sledećih formata:
1) DD-MMM-YY odnosno dan-mesec-godina Primer: l-Apr-93
2) MMM-YY odnosno mesec-godina Primer: Apr-92
3) DD-MMM odnosno dan-mesec Primer: 6-Aug
4) Long intl. odnosno tzv. dugi intemacionalni Primer: 4/23/93 (mesec/dan/godina)
5) Short intl. odnosno kratki intemacionalni
Primer: 3/23 (mesec/dan)
8.Vreme
Prikazuje vreme ujednoj od sledećih formi:
1) hh:mm:ss AM/PM Primer: 10:24:55 AM

MS-EXCEL 5.0 S Baze podataka

1.3 Baze podataka

1.3.1 Osnovni pojmovi

Pored svoje osnovne namene, proračun i predstavljanje podataka omogućava kreiranje i održavanje jednostavnih baza podataka. Time vas praktično oslobađa potrebe da informacije držite u jednom programu a proračune vršite u drugom.I ovde, naravno, postoje pomagala koja život čine lakšim.

Baza podataka predstavlja specijalan način smeštanja, organizovanja i pretraživanja podataka. Ona služi za adekvatno smeštanja različitih vrsta podataka u homogenu celinu. Pri tom, u bazu mogu biti uključene informacije o imenima, prezimenima, adresama, brojevima telefona i sl. Svaki od ovih podataka čini polje (Field). Sva polja koja predstavljaju jednu ličnost čine zapis tj. slog (Record). U MS-Excelu je moguće podatke organizovati u vidu baze podataka. Međutim, moramo se pridržavafr određenih pravila. Polja predstavljaju ćelije, a redovi predstavljaju zapise.

U prvoj liniji baze podataka unose se nazivi imena polja. Znači svako ime polja označava jednu kolonu, i ta kolona određuje dato polje za svaki zapis. Celije u istoj koloni predstavljaju istu vrstu informavije dodeljene različitim zapisima. Ime polja ne sme prekoračiti 15 karaktera, i ne sme sadržavati jedno od sledećih znakova +,-,*,/,'\ Između imena polja i prve linije baze podataka nije preporučljvo ostavljati slobodni red prostora. Zapisi su određeni svakim redom u tabeli. Pri tom, ne sme biti ispušten nijedan red, odnosno svaki red mora biti popunjen informacijama. Preporučljivoje da se prva kolona označi tzv. rednim brojem. To znači da se u prvoj koloni svaki zapis označi određenim rednim brojem. Na ovaj način se pri "neprihvatljivom" načinu sortiranja podataka može baza vratiti u prethodno stanje, jer su dostupni redni brojevi svakog zapisa.

1.3.2 Kreiranje baze

Pri ovakvom radu moramo biti svesni ograničenja koja nam Excel unosi. 

Kao prvo, broj redova je maksimalno 16384, a kolona 256. 

Ako jedan korisnik koristi bazu, drugi joj ne može pristupiti. 

Baze sa kojima se radi na klasičan način moraju biti cele u memoriji. Podacima se može pristupiti i kao spoljnoj bazi, gde se obično Excel koristi kao sredstvo za analizu baze koju je kreirala neka druga aplikacija. Pošto Excel uz podatke iz tabele čuva i njihova formatiranje, formule, grafike i ostalo, baze kreirane u njima obično zauzimaju mnogo vise prostora nego da ih je kreirao specijalizovan program.

U prvi red liste unose se nazivi polja ("ime","prezime'...) Ne sme se preskočiti ni jedan red između prvog koji sadrži imena polja i sledećeg koji sadrži podatke, kao sto ne sme biti" praznih redova ni između ostalih rekorda. 

Ćelije u jednoj koloni moraju sadržati podatke istog tipa. Dakle, ako imate polja "poštanski broj", sve ćelije u toj koloni moraju ga sadržati. Mogu se kreirati i polja sa izračunatim vrednostima, tako sto se u njega unese formula (formule i rad sa njima je opisan ranije). U svakom slučaju preporučljivo je da jedna kolona sadrži redne brojeve slogova. Ako neko sortiranje kasnije ne da željene rezultate, pomoću njih se uvek možete vratiti na početak.

Pre kreiranja baze uvek treba malo razmisliti. Koja polja treba uzeti u svaki rekord? Ako kreirate bazu koja će sadržati podatke iz nekog več postojećeg organizatora, kao sto je telefonski imenik ili adresar, koristimo njegovu formu da bi videli koja polja su potrebna. Najčešce upotrebljavano polje stavljamo u prvu kolonu. Koje polje ima najduži sadržaj njega treba upotrebiti za odredjivanje širine kolona. U svakom slučaju možemo se koristiti opcijom Format/Column/AutoFit Selection, pa će Excel to uraditi umesto nas.

Kreiranje baze se sada svodi na prosto unošenje podataka u tabelu što se obavlja na potpuno isti način kao i unošenje bilo kojih drugih podataka u radni list. Možemo ostaviti prazno polje, ali to može izazvati probleme u sortiranju. Ako treba dodati neki slog izmedju dva več postoječa, dodajemo red na mestu na kome želimo da se pojavi, ili koristimo dijalog formu za unos podataka Data Form.

1.3.3 Kreiranje baza podataka- napomena

Za kreiranje baze podataka preporučljivo je slediti dalje navedenu grupu pravila:

•   Imena polja se moraju uneti na vrhu baze podataka (prvom redu).

•   Potrebno je uneti u svako polje odnosno ćeliju podatke. To je neophodno kako bi svi zapisi bili potpuno određeni.

•   Nije preporučljivo ostaviti prazan red između imena polja i prvog zapisa.

•   Pošto baza podataka operiše nad tekstom, a ne nad podacima, prilikom unošenja podataka prvo unesimo apostrof tako da se dati brojni podatak predstavi u vidu tekstualnog podataka.

U MS-Excelu baza predstavlja zapravo specijalni tip tabele koji uključuje imena polja kao kolona. Podaci se unose uobičajeno, a onda je potrebno oblast baze podataka označiti na način da predstavlja bazu podataka. Na ovaj način smo tzv. obične podatke u tabeli označili kao elemente baze podataka.

Sada kreirajmo jednu jednostavu bazu podataka. Po navedenim pravilima unesimo neke podatke. Neka naša tabela ima podatke kao na sledećoj slici.

Sve opcije za manipulaciju nad bazom podataka nalze se uglavnom u meniju Data. Od velike pomoći nam može biti opcija Data/Form. Ona omogućava da "listamo" po našoj bazi podataka, jer u svom prozoru pokazuje jedan po jedan zapis iz baze podataka. Znači, aktiviranjem opcije Data/Form na ekranu dobivamo sledeći prozor za dijalog s korisnikom.

1.3.4 Smeštanje datoteka

Pri radu sa mnogo fajlova, sigumo ćete ih grupisati u jedan direktorijum i onda odatle pozivati i nove smestati na isto mesto. Da ne biste morali stalno dase krećete kroz stablo direktorijuma, u okviru komande Open, možemo definisati polaznu lokaciju. Izabiranjem iz menija Tuls/Option/General/Default file location unosimo put do željenog direktorijuma. Ako u sekciji Menus označimo Recently Used Pile list, u meniju File će se pojaviti lista nekoliko fajlova koji su poslednji korisčeni tako da za čest rad na istoj rednoj knjigi nije potrebno svaki put koristiti komandu Open.

Čestu potrebu za premeštanjem, brisanjem, reimenovanjem, pretraživanjem i drugim operacijama za rad sa fajlovima za koje je inače potreban Explorer, pisci Excel-a 7 su najpotrebnije operacije ugradili u sam Open dijalog. Sada se pored prostora za listu fajlova i direktorijuma u njemu nalaze i mnoge druge stvari. Pri vrhu je nekoliko tastera od kojih prvi diže jedan nivo u stablu direktorijuma, a dalja dva služe za prebacivanje i traženje fajla u Favorites direktorijumu, namenjenom ukazateljima na najbitnije dokumente. Sledeća četiri tastera omogućavaju pregledanja fajlova kao listu bez i sa detaljima (datum, veličina...), osobina (Properties) bez otvaranja samog fajla i umanjenu

sliku sadržaja (Previevv). Poslednjim dugmetom u nizu mogu se obaviti opertacije- kao što su stampanje jednog ili više fajlova,izmena osobina, pa čak i često potrebno mapiranje mrežnog diska. Desnim klikom na listu fajlova dobija se meni poput Explorer-u, tako da se praktično sve može obavit iz samog Open dijaloga bez napustanja Excel-a. Upotrebom polja za ime, tip deo teksta ili osobinu, kao i vreme izmena, možemo da organizujemo složenija pretraživanja.Ne postoji ograničenje samo na Excel fajlove, već se jednako dobro pretražuju i Word,Works i drugi formati.

1.3.5 Navigacija u Excel prozom

U samom EXcel prozoru se nalazi i prozor radne knjige (workbook) sa prikazanim aktivnim listom (worksheet). Svaki radni list praktično je zasebna celina, koja sadrži mrežu kolona (označenu slovima abecede) i redova (označenih brojevima). NA presecima redova i kolona nalaze se "kućice" koje se nazivaju čelije i predstavljaju najmanju radnu jedinicu Excel-a. Svaka ćelija ima jednoznačnu adresu koja se sastoji od slova rerda i broja kolone u kojima se nalazi (A1,B3,C20...). Podaci i formule se unose u ćelije i tako se formiraju radni listovi. Broj radnih listova se može menjati po potrebi, a inicijalnoje postavljen na slici 16.

Menjanje radnog lista je jednostavno - kliknite mišem na željeni tab (nalazi se na dnu prozora radne knjige). Ako ih ima puno, pa se svi ne vide, s leve strane su strelice za njihovo pomeranje. Imajte na umu da je sadržaj ekrana samo mali deo pravog radnog lista i da je on praktično "lupa" koja se može pomerati do željene pozicije. U početku je jednostavnije za kretanje koristiti miša na potpuno isti način kao i ostalim Windows programima, ali vremenom cete primetiti da je stalno prebacivanje ruke sa tastature na miša i obratno zarnomo i oduzima puno vremena. Zato cete verovatno preći na rad sa tastature, jer se sve funkcije mogu dobiti i odgovarajućom kombinacijom tastera, u skladu sa tabelom. Naravno, sve ove skraćenice nema svrhe učiti napamet: u početku se gotovo sve radi mišem, a onda se uoči da bi se nešto   moglo uraditi brže i koriščenjem tastature. Komandu po komandu , ubrzo čete veči deo tabele držati u glavi.

Postoji i mogućnost direktnog "skoka" na željenu čeliju, pritiskom na F5 (komanda goto, idi na) i direktnim unosom njene numeričke adrese. Ako se ciljna celija ne nalazi na aktivnom radnom listu, navodi se prvo njegovo ime, zatim znak uzvika i onda regulama adresa celije, na primer sheet3m34. Omogučeno je referenciranje na ćelije i oblasti koje se nalaze u drugom fajlu, uz navođenje njegovog imena u uglastim zagradama, recimo [C:\Obaveze\Porezi]sheet2!c5. Kada se radi sa tabelama večim od ekrana, često je potrebno videti dva dela koja su međusobno udaljena. Pomoću miša i i crta za deljenje (split bar) koje se nalaze s desne odnosno gomje strane skrol bara, ekran može da se podeli na dva nezavisna dela. Gomji ili levi deo se eventualno može "zamrznuti" komandom Ereeze Panes iz menija Window, a kasnije odmrznuti sa Window/Unfreeze Panes.

1.3.6 Radsa radnim listovima

Sa radnim listama se rukuje gotovo kao i sa samim čelijama - mogu se označavati (select), kopirati, premeštati... u okviru jedne ili više radnih knjiga. Selekcija je jednostavna -samo se klikne na tab željenog lista. Ako je potrebno nekoliko, postoje dva načina: kada želimo da označimo nekoliko susednih listova kliknemo na prvi, a zatim, držeci pritisnut Shift, na poslednji u grupi. Za nesusedne listove klikčemo na njihove tabove držeči pritisnut Ctrl. Dodavanje (insert) novih listova se obavlja tako što se izabere list ispred koga treba dodati novi, zatim se otvori Insert meni i izabere Worksheet. Briše se tako tako što se neželjeni listovi označe i izvrši Edit/Delete Sheet.

Premeštanje i kopiranje se izvodi na sličan način - označavanjem pracenim sa Edit/Move or Copy. zatim se u dijalog prozoru unese podatak u koju knjigu idu listovi i ispred kog lista se ubacuju. Ako želite kopiranje a ne premeštanje, samo se klikne na "Create a Copy" kvadratič. Drugi način za ove operacije Vuci-i-spusti (drag and drop): označe se tabovi listova koje želimo da premestimo, i onda se mišem "odvuku" na željeno mesto. Kopiranje se izvodi na isti način, ali uz pritisnut taster Ctrl pri odvlačenju.

Radnim listovima se mogu menjati imena, tako što se list označi i uradi Format/Sheet/Rename - sigumo je preglednije imati imena kao što su "nabavka", "zalihe", "tabela" ... nego sheet3. Ako je potrebno, radni listovi se mogu privremeno i "sakriti" pomoču Format/Sheet/Hide, a kasnije vratiti sa Unhide.

1.3.7 Rad sa podacima

Radni listovi su samo "kontejneri" za podatke, koje treba unositi u njegove ćelije. Postoje razni tipovi podataka: tekst,brojevi,datumi,vremena,formule,funkcije...

Tekst je bilo koja kombinacija slova i cifara. Unosite ga tako što kliknete na željenu čeliju, otkucate tekst i pritisnite Enter; tekst se automatski poravnava na levu marginu čelije. Ako želite da prekinete unos, pritiskate Esc. Zbog ugrađene logike koja sama prepoznaje tip unetog podatka, ako se unese broj koji treba da se tretira kao tekst (npr. poštanski broj) ispred njega treba otkucati apostrof, recimo '32000.

Brojevi se sastoje od cifara i specijalnih znakova kao što su + - (),.% i automatski se poravnjavaju na desnu marginu ćelije. Brojevi se unose na potpuno isti način kao i tekst -dolazak na čeliju, unos, Enter. Ako se umesto broja pojave znaci "tarabe" (#), znači da je ćelija suviše mala da se broj prikaže u celini, ali je sam podatak korektno memorisan.

Datumi i vremena se prepoznaju ukoliko su uneti u nekom od standardnih formata prikazanih u tabeli 2. Mada na prvi pogled nije bitno kako ih unosimo, povremeno se nad njima vrše računske operacije (do kog datuma traje vas 25-dnevni odmor?), što je sigumo zgodno prepustiti samom Excel-u. Nije bitno da li koristite mala ili velika slova, a "/" možete zameniti i znakom"-"

1.3.8 A utomatsko popunja vanje i liste

Veoma korisna funkcija Excel-a je popunjavanje (fill) susednih ćelija   srodnim sadržajem, kao što su imena dana u nedelji, meseci u godini, ili obično ubacivanje rednih brojeva. Kad želite da popunite veći broj čelija istim sadržajem, dovoljno je da ga otkucate samo u prvoj. Zatim miša dovedete iznad nje i prevučete je (pritiskom na levi taster) preko onih koje želite da popunite. Onda iz Edit menija izaberete Fill, iz njegovog podmenija smer u kome želite da popunjavanje - biče prekopiran sadržaj i format početne čelije. Ova vrsta kopiranja može da se izvede i iz jednog radnog lista u druge: najpre se označe tekući i ciljni listovi, pa tek onda željene ćelije. Bira se Edit/Fill/Across Workshets. Za kopiranje sadržaja i formata čelije, bira se All, samo za sadržaj Contens, a za fonnat Formats, praćeno naravno sa Ok.

Za razliku od funkcije Fill koja samo kopira sadržaj, AutoFill je mnogo "pametniji" i može mnogo da olakša česta i dosadna popunjavanja rednih brojeva ili povezanih imena. Ako, recimo, želite da unesete dane u nedelji, dovoljno je da otkucate samo prvi (Monday) i povučete "ručicu za popunjavanje" (ima je svaka označena ćelija, predstavlja je mali kvadrat u donjem desnom uglu) u željenom smeru. Kada se miš dovede iznad njega, strelica se pretvara u mali znak "+". Po otpuštanju dugmeta na mišu, Excel će sam popuniti dodatne ćelije odgovarajućim danima, naravno na engleskom.

Većini nas to ne bi bilo od velike pomoći da slične liste ne možemo da kreiramo i sami, takoo da je veoma jednostavno uneti bilo kakve nizove na našem jeziku. U Tools meniju izaberemo Options, pa zatim Custom Lists tab. Pritiskom na Add dugme, kursor se pojavljuje u List Entries polju. Stavke liste se sada jednostavno otkucaju razdvajajući ih sa Enter, a cela operacija se završava pritiskom na OK. Nova lista se može pdmah koristiti potpuno ravnopravno sa ostalim predefinisanim. Ako ste već negde otkucali listu, nema potrebe da to ponavljate u Custom Lists: dovoljno je da pre odlaska u dodavanje lista selektujete željeni opseg, a zatim u Custom Lists selektujete Import.

1 pored toga što je automatsko popunjavanje dobro za manje serije podataka, sigumo čete nailaziti na situacije gde je potrebna veća kontrola ili ćete imati velike nizove ćelija sa inkrementalnim sadržajem. Excel prepoznaje četiri načina rada, kao stoje prikazano u tabeli 3.

Kreiranje serije je, kao i većina operacija u Excel-u, veoma jednostavno: prvo se unese vrednost u početnu ćeliju, što će biti polazna ili krajnja vrednost. Označite ćelije koje treba da budu popunjene. Otvorite meni Edit, zatim Fill/Series. U Series dijalogu izaberete da li će se serija širiti po koloni (Columns) ili redu (Rows) i prema tabeli 3 izaberite vrstu serije. Podesite korak (Step) i krajnju vrednost koju želite da se unese (Stop) ako je potrebno. Ako ste izabrali datumsku seriju, treba da izaberete i njenu vrstu

(dan, sedmica, mesec, godina). Sve se naravno završava sa OK. U većini slučaja Excel će "shvatiti" šta želite i samim povlačenjem ručice za popunjavanje, ali da biste došli do željenih rezultata, treba malo eksperimentisati, što će se sigumo brzo isplatiti.

novost verzije 7 je još jedno olakšanje unosa podataka, Auto Complete logika, koja prati šta ste unosili u prethodnim čelijama i intemo formira bazu različitih stavki. Kad u praznu ćeliju počnete da ukucavate nešto, prema prvim unesenim karakterima će se iz baze vaditi odgovarajući

sadržaj koji će biti prikazan označeno pored onoga što ste otkucali, tako da ga možete obrisati jednim pritiskom na Del. Ako je izbor dobar, samo pritisnete Enter i idete dalje, a ako nije... kucate dalje.

U statusnoj liniji (levo od statusa nekih tastera) je smešten minijatumi kalkulator posebne namene - Mikrosoft se uvek užasne kada neki korisnik Excel-a pored ruke drži klasičan kalkulator. Mogućnosti ovog intemog kalkulatora su vrlo ograničene, ali zna da uštedi puno vremena pri raznim proverama i računanjima na brzinu. Deluje stalno na trenutno označene čelije (koje ne moraju biti susedne), a funkcija se menja desnim klikom na njegovo polje, čime se pojavljuje meni sa stavkama za zbir, minimum, maksimum, srednju vrednost, broj stavki i broj stavki koje su brojevi. Nije puno, ali je dobro odabrano.

1.3.9 Štampanje

Pre bilo kakvog štampanja treba proveriti da li su pravilno podeseni parametri strane, odnosno lista papira na koji se štampa. Otvaranjem menija File i biranjem opcije Page Setup, dolazi se do dijaloga u kome treba podesiti tip papira (A4 a ne Letter).

Page tab: Paper Size je veličina papira, obično A4.0rientation - ako su tabele uglavnom široke, treba se opredeliti za horizontalan (landscape) položaj, umesto klasičnog (portrait). Scaling služi za promenu veličine (uvećanje ili smanjenje) materijala za štampu. Print Quality zavisi od mogućnosti štampaža, za najbolji ispis treba postaviti najveću vrednost, ali to obično znači i najduže štampanje.First Page Number je broj koji će biti ispisan na prvoj odštampanoj strani, od koga kreće numeracija. Pritisak na taster Options prebacuje u masku za podešavanje drajvera za štampač.

Margins tab: Top, Bottom, Left, Right - podešavanje gomje, donje, leve i desne margine, tj. udaljenja ivice teksta od ivice papira. From Edge-udaljenost hedera i futera od gomje i donje ivice papira. Center on page - centriranje onoga što se štampa u odnosu na stranu, po horizontali i/ili vertikali.

Header/Footer tab: Može se izabrati neki od več ponuđenih hedera (tekst koji se ispisuje na dnu svakog lista) i futera (tekst koji se ispisuje na dnu svakog lista), ili napraviti svoj, opcijom Custom.

Sheet: Opcije za izbor podataka za stampu. U print Area se može uneti oblast po adresama ćelija koje je potrebno odstampati, ili jednostavno prevući miša preko te oblasti. Ako se ništa ne izabere, Excel podrazumeva da se na papir prenose sve ćelije koje sadrže podatke. Print Titles - štampanje naslova. u slučaju da se tabela prostire na više strana, može se odrediti red ili kolona koja će se stampati na svakoj strani. Print - dodatne opcije. Recimo, mreža se štampa samo ako je označeno polje Gridlines. Page order - određuje redosled ispisivanja podataka iz radne knjige. U sekcijama od vrha nadole (Down, then Across) ili sleva nadesno (Across,then Down).

Opcijom Print Preview se proverava kako će sve izgledati na papiru, i na vrteme uočavaju eventualne greške. Tasterima Next i Previous se krećemo po stranama; ako je potreban detaljniji pregled sadržaja pritisnemo Zoom ili kliknemo na željenu oblast. U ovom se mogu podešavati margine pritiskom na taster Margins - Excel će prikazati isprekidane linije koje označavaju ivice sadržaja strane i na krajevima imaju ručice za pomeranje, kojima vizuelno možemo odrediti potrebna odstojanja. U slučaju da se na listu nalazi i neka tabela, pojaviće se ručice na vertikalama između ćelija, čijim pomeranjem na licu mesta menjamo širine odgovarajućih kolona. Kadaje sve gotovo, zatvara se ovaj mod sa Close ili direktno se štampa sa Print.

Da bi se, posle podešavanja i provere izgleda, nešto i dobilo na papiru iz menija File se bira opcija Print (ili se jednostavno pritisne Ctrl+P). Pojavi se dijalog u kome mogu da se podešavaju razne opcije.

Print What - omogućava da se štampaju trenutno označene ćelije, označeni radni listovi ili cela radna knjiga.

Page Range - dozvoljava štampanje jedne ili više stranica. Ako če označena oblast zauzeti 15 stranica, a vi hočete da se štampaju samo one od pete do desete, početnu unosite u polje From, a krajnju u polje To. Obratite pažnju na način na koji Excel raspoređuje strane kada se dovodi da kompletan tekst po horizontali ne može da stane na jedan list. Kada se podese svi parametri vezani za štampanje, ne postoji česta potreba za njihovom izmenom, tako da seza dobijanje jedne kopije može koristiti i dugme iz tasterskog menija sa alatima (tool mar), čime se kompletan dijalog preskaže i tako štedi na vremenu.

Kada se radna knjiga štampa, sam Excel određuje gde padaju prekidi strana, prema određenoj veličini papira,,marginama i njenoj veličini. Naravno prekidi mogu da se postave na najzgodnija mesta.

1.3.10 Stilovi i šabloni

Kada se unose podaci koji treba da budu formatirani na isti način ili se radi sa velikom tabelom, može biti vrlo korisna mogučnost promene osnovnog formata; posle toga se samo prefonnatiraju samo one ćelije koje predstavljaju izuzetke. Stil se referiše po imenu a bitno je napomenuti da ako se neki stil izmeni, sve ćelije na koje je primenjen će automatski poprimiti te promene. Svaki stil sadrži specifikaciju zajednu ili više opcija: Number Format (kontroliše izgled brojeva, kao sto su valute i datumi), Font (vrsta, stil, veličina, boja i dmge osobine teksta u čelijama), Alignment ( pozicija sadržaja u ćeliji), Border (pozicija linija i njihov stil), Pattems (senčanje i boja pozadine čelija), Protection (zastita sadržaja ćelija od promena)... Excel ima nekoliko predefenisanih stilova, od kojih su neki dostupni i preko tasterskog menija za formatiranje.

Postoječi stil se menja izborom ćelija na koje treba da se primeni i opcije Style iz Format menija; pojavljuje se dijalog kao na slici. 

Name i pojaviče se lista postojećih stilova. Kliknite na onaj koji želite da promenite, pritisnite Enter taster ili kliknite na OK. Dobra praksa je prepravljanje Normal stila prema svojim potrebama (Obično samo veličinu slova i font), jer se on koristi za sav " neformalan" tekst. Lista stilova se može ubaciti i u tasterski meni, tako da uvek bude u blizini ako ih često menjate. Izaberite View / Toolbars / Customize, kliknite na kategoriju za formatiranje, i odvucite pravougaonik sa stilovima na željeni tasterski meni (toolbar). Sa njega ćete možda morati da prvo sklonite neke tastere (najbolje baš one koji sadrže nepotrebne stilove) da biste napravili mesta.

Večini Ijudi predifinisani formati ne odgovaraju u potpunosti, a uvek zatreba i nešto posebno. Toga su očigledno bili svesni i programeri iz Microsoft-a, tako da je kreiranje stilova sasvim pojednostavljeno.Može se obaviti na tri načina: definisanjem stila "ni iz čega", tako što se navede ime i onda odrede svi potrebni atributi,definisanjem prema primeru,označavanjem ćelije koje sadrže formatiranje koje želite da koristite ili kopiranjem formata, označavanjem ćelije u drugoj radnoj knjizi koja sadrži željeni format i povezivanjem sa listom formata u tekučoj knjizi.

Za kompletno definisanje stilova otvorite meni Format, i izaberite Style. U polju Style Name otkucajte novo ime stila koji kreirate,i kliknite na dugme Add; ime je sada dodato na listi i možete pristupiti modifikacijama. Izbacite "x" iz polja koja ne želite da obrađujete iz grupe Style Includes. Klikom na Modify pojavljuje se poznati dijalog za formatiranje ćelije; kada zavrsite sa izmenama kretanjem preko tabova, kliknite na Ok ili pritisnite Enter na tastaturi i ... gotovo. Stil je kreiran i snimljen. Defmisanje stila prema primeru se izvodi na sličan način. Prvo označite čeliju koja sadrži željeni format, otvorite Fon-nat meni i izaberite opciju Style. Otkucajte ime stila u polje Style Name, kliknite na Add i dodali ste stil na listu; klikom na Ok ili pritiskom na Enter operacija je kompletna. Ovaj način je vrlo pogodan za slučajeve kada ste već primetili neke atribute a anda poželeli da te promene snimite i za kasniju upotrebu. Kopiranje postojećeh stilova iz druge radne knjige počinje otvaranjem obe. Pređite u onu u koju želite da iskopirate stilove, izaberite Format / Style, kliknite na Merge dugme, izaberite ime radnog lista sa koga kopirate i, sa Ok ili Enter, zatvorite dijalog.

Kada često radite na sličnim poslovima, koristite iste fontove i formate za grafikone i tabele, sigumo želite da učinite što dostupnijim stilove koji ih sadrže, a koje ste sami kreirali ili odabrali. To se postiže koriščenjem šablona (Template); šablon je zapravo čitava radna sveska, sa tekstom koji je unet u njene celije. Ako se radi sa tipičnim dokumentima, kao što su profakture, sva zaglavlja i stilove, formule, tekst, eventualno i grafikone treba smestiti u jedan šablon i kasnije samo pozvati po potrebi. Kreiranje se ne razlikuje od normalnog rada sa sveskom: napravite novu ili učitajte neku gotovu, unesite izmene i podešavanja i kod snimanja izaberite Save As. Unesite ime u odgovarajuće polje, a zatim u listi Save File As Type izaberite opciju Template. Ekstenzija fajla automatski se menja iz XLS u XLT, sto označava da če biti snimljen kao šablon. Šablon možete snimiti gde hoćete, ali je veoma preporučljivo da to uradite u direktorijumu XLSTART. Kada sledeći put budete kreirali novu radnu knjigu pomoču File/Nevv, pojavice se dijalog sa listom šablona koji su na raspolaganju.

Pored standamog Workbook-a, tu će se naći i vaši - kliknite na onaj koji je potreban i u prozoru če se pojaviti kopija. Kažemo kopija, jer šta god sada da radite u novoj radnoj knjizi, neće se odnositi na šablon, koji će biti sačuvan netaknut za nove primene. Ovo je dobar način za smanjenje posla i unifikovanje dobijenih    izveštaja. Posebna vrsta su autošabloni (AutoTemplates), koji se nalaze u direktorijumu XLSTART i imaju rezervisana imena:

BOOK.XLT ( sve nove radne sveske), SHEET.XLT (novi radni listovi ), CHART.XLT (novi listovi sa dijagramima), MODULE.XLT (novi VBA, Visual Basic for Applications moduli), DIALOGBX.XLT ( novi listovi sa dijalozima) i MACRO.XLT (novi .XLM listovi sa makroima). Pošto svi ovi šabloni (Osim BOOK.XLT ) kontrolišu pojave jednog lista, treba da sadrže samo jedan radni list.Ako su ovi šabloni prisutni u XLStart direktorijumu, pri otvaranju nove radne knjige biče primenjen BOOK.XLT, pri otvaranju novog radnog lista SHEET.XLT. u

1.3.11 Dijalog Forme

Dijalozi forme su slični indeksnim karticama- postoji jedna dijalog forma za sve rekorde u bazi podataka. Uglavnom je lakše kretati se kroz ove kartice i pomoću njih menjati sadržaj baze, nego da im pristupamo direktno na radnom listu. Da bi ga prikazali, iz menija Data treba izabrati Form. Po slogovima se krećemo koristeči skrol bar, tastere za predhodni (Find Previous)i sledeći (Find Next), ili strelicama na tastaturi. Da bi promenili ili uneli sadržaj polja u slog, kliknemo na njega mišem, a kada završimo taster Enter.Ako smo se predomislili pre nego što pritisnemo Enter, početno stanje podataka možemo vratiti klikom na taster Restore. Novi slog se na kraj baze dodaje klikom na New, a tekući briše pritiskom na taster Delete.

Baza vremenom može da poraste. U tom slučaju ne dolazi u obzir kretanje po jedan rekord gore ili dole, pa se mora koristiti dijalog forma za unos promene, a onda pritisne taster za

unošenje kriterijuma Criteria. Za pretraživanjese može uneti kriterijum za svako polje, i to koristeči džoker znake ili matematičke operatore poredjenja (ako tražite Ijude kojima ime počinje sa M unećemo u polje imena M*, ili trgovce koli su imali prodaju veću od 100000 din.unečemo >100000)Džoker znacfsu zvezdica * koja predstavlja bilo koji niz karaktera i upitnik ? koji predstavlja jedan karakter, a operatori su = < > <= >= <>.
Pri kliku na Criteria pojavljuje se dijalog kao na slici. Da nadjemo odredjene rekorde u bazi, unosimo kriterijume za svako polje po kome želimo pretraživanje. Polja koja nisu označena za pretraživanje ostaviti prazna. Zatim kliknemo na taster Form ili pritisnemo Enter i tasterima Find Previousi Find Next stupamo po rekordima koji zadovoljavaju opisane kriterijume. Pozavršetku pregleda pritisnemo Close

Podaci u bazi mogu i da se eortiraju. Najpre odlučujemo po kojem poljuče se sortirati: po imenu firme, gradu, imena u okviru grada i sl. Svako odpolja po kome se sortira naziva se ključ. Dakle, za sortiranje se može primenitiviše ključeva, a Excel omogućava maksimalno tri. U pomenutom primeru prvi bi bioime, drugi grad a treci zemlja.

Prvi korak sortiranjaje označavanje oblasti nad kojom ce se obavitioperacija. Treba paziti de se ne označi prvi red, onaj sa nazivima polja, jerbi onda i on verovatno promenio mesto. Ako se sortira celokupne lista, dovoljnoje označiti samo jednu celiju bilo gde u njoj. Zatim se iz menija Data izabereopcija Sort. Pojavljuje se dijalog za sortiranje. Prvi, glavni ključ se unosi upolje Sort by, a eventualni sledeci u polja Then by. Pored svakog ključa se nalazi i mogucnost sortiranja u rastucem ili opadajučem redosledu. Na dnu jeopcija za isključivanje prvog reda iz sortiranja, koja ce isključiti prvi red sa imenima polja, ako smo ga slučajno i označili (My List Has/Header Row).   Ključ se najlakse odredjuje klikom na strelicu pored polja za unos kojomse otvara lista imena svih polja u slogu. Potrabno je samo da kliknemo na ime čeljenog ključa. Pritiskom na taster Options, pojaviče se spisak predefinisanih lista, koji služi za automatsko popunjavanje polja u tabeli, što omogucava sortiranje po mesecima ili danima u nedelji. U slučaju večih tabela preporučuje se snimanje pre sortiranja. Da bi sortirali samo po jednom ključu pozicioniramose na kolonu koja ga sadrži i pritisnemo dugme za sortiranje Sort Ascending iliSore Descending na standardnom tasterskom meniju.

Ako želimo da prikažemo samo grupu slogova odabranih po jednom ili više kriterijuma, Excel nudi alat pod nazivom AutoFilter. Pomocu njega možemo prikazati tabelu Ijudi koji su zapošljeni na mestu trgovca, i onda obaviti neku računsku operaciju nad njima ili nacrtati grafikon. Najpre selektujemo celu bazu uključujući i prvi red koji služi za definisanje imena polja u rekordima, otvorimo meni Data/Filter/AutoFilter i Excel prikazuje strelicu padajuče liste pored svakok imena polja na vrhu baze. Kliknemo na strelicu nekog od polja i izaberemo željenu vrednost (naprimer listu svih Ijudi koji žive i Čačku). Pod Castom opcijom pojavljuje se dijalog u kome možemo navesti po dva kriterijuma pomocu džoker znaka i matematičkih operatora poredjenja, povezanih tako da moraju biti ispunjena oba (And) ili bilo koji od njih (Or).

Knterijumi se mogu unositi u proizvoljan broj kolona. Kada listu treba vratiti u početno stanje, dovoljno je izabrati Data/Filter/Show All. Pored ovih obratimo pažnju i na Top 10 filtriranje koje omogucava jednostavno biranje slogova prema dva uslova: prvi/poslednji i broj stavki/procenat.

Jedna od posebno korisnih mogučnosti Excela je da tekst pretvori u tabelu tako da je prekucavanje nepotrebno. Za ovu operaciju postoji čarobnjak koji se startuje sa Data/Text to Columns, posle označavanja teksta. Stavke mogu biti raznih formata.Data/Consolidate služi za povezivanje podataka iz više tabela na raznim radnim listovima, radnim knjigama ili Lotus 1-2-3 tabelama koje mogu i ne moraju biti otvorene.

1.3.12 Sumiranje podataka

Tabele su samo prvi deo posla- potreban je efikasan način za generisanje preglednih izveštaja koji omogućuju analizu. Excel-ov čarobnjak za pravljenje izvedenih tabela PivotTable Wizard radi sam ovaj posao. Izveštaj se može napraviti povezivanjem podataka iz tabela koje ne moraju biti ni otvorene, a za tim se ti izveštaji predstavljaju u lako čitljivom fonnatu, koji se uz to vrlo lako (povlačenjem miša) reorganizuju prema potrebama.

Recimo da imamo bazu (tabelu) u kojoj smo pratili mesečnu prodaju po proizvodu i prodavcu. Možemo kreirati izveštaj koji sumira količinu svih prodatih proizvoda i to za svaki mesec i po svakom prodavcu,a zatim brzo prepraviti tabelu tako da analiziramo podatke na razne načine.

Kreiranje pivot tabele počinje otvaranjem menija Data/PivotTable. Čarobnjak za pivot tabele prikazuje prvo od četiri koraka,a to je dijalog u kome se navodi izvor podataka koji će se koristiti. U ovom slučaju to je Excel list, a može biti i spoljnja tabela, višestruke oblasti ili druga pivot tabela. Pritiskom na taster Next prelazimo na drugi korak u kome se odredjuje oblast na radnom listu, koja može da se prepravi kucanjem ili označavanjem mišem. Treći dijalog zaslužuje posebnu pažnju. Moraju se odrediti četiri elementa:

Pages- omogučavaju da se kreira padajuća lista za jednu od kolona ili redova tabele koja če sadržati sve njene stavke. Kolona "prodavac" če recimo sadržati imena svih prodavaca. Izborom prodavaca iz liste vidi se koliki mesečni promet on ostvaruje.

Row- navode se polja koja če formirati redove izveštaja. Može ih biti najviše osam.

Columns- navode se polja koje će formirati kolone izveštaja. Takodje ih može biti samo osam.

Sum of Value- vrednosti koje želite da dodate na svakom preseku redova i kolona. Prikazivanje meseci u redovima i prodavaca u kolonama indicira koliko je svaki prodavac prodao svakog meseca.

Sada na odgovarajuća polja mišem vučemo željene stavke (imena polja u tabeli) koje su navedene sa desne strane. Kliknemo na ime polja i odvučemo ga na željeno mesto. Pritisnemo dugme Next i pojaviće se četvrti dijalog prozor. U njemu treba odgovoriti na pitanje gde da se smesti nova pilot tabela, kako se zove i par dodatnih opcija. Posle toga, kliknemo na Finish i posao je završen. Ako ne navedemo lokaciju za gotovu tabelu, Excel če je smestiti na novi radni list koji će se ubaciti ispred tekučeg.

Kada konačno pogledamo gotovu tabelu, možemo je menjati na licu mesta odvlačenjem odgovarajućih delova na nova mesta. Ako je potrebna radikalna izmena, dovoljno je ponovo startovati čarobnjaka i u njemu prepraviti neke od vrednosti. Naravno, i ova tabela se može kasnije formirati kao i svaka druga.

1.3.13 Zaštita podataka

Postoji više nivoa zaštite.Najviši je postavljen na datoteke koje sadrže radne knjige. Dobija se otvaranjem File/Save As/Option. U dijalog koji se pojavljuje ubacujemo opciju za

pravljenje rezervne kopije pri snimanju (Always Create Backup). Backup fajl če imati isto ime i ekstenziju BAK.

Ako se označi opcija Read Only Recommended,pre otvaranja radne knjige ce se pojaviti poruka koja sugeriše da radnu knjigu otvaramo samo za čitanje.

Ako u polje Protection Password unesemo našu lozinku pri otvaranjutakvog fajla prvo če se tražiti unos ispravne lozinke.

Radna knjiga se može sakriti od neželjenih pogleda izborom komande Hide iz menija Window.

Sledeci nivo je zaštita na radnoj knjizi. Iz menija TooIs/Protection/ Protect Workbook u dijalog koji se pojavljuje, unosi se šifra u polje Password. Sprečavanje promena u strukturi radnog lista izvodi se uključivanjem opcije Structure i tako se sprečava brisanje, sakrivanje, promena imena...Ako treba zaštititi radne listove iz menija izaberemo Tools/Protect Workbook/Protect Worksheet. U polje Password unosimo lozinku za pristup radnom listu. Nivoi zaštite redjaju se dalje sve do nivoa zaštite same celije.

Excel 8, poznat i kao Excel 97, predstavlja novu verziju vodećeg programa za tabelarne proraćune. Microsoft jc godinama unapređivao i Excel i ostale programe paketa Microsoft Office i redovno izdavao njihove poboljšane verzije. Prelaz sa Excela 4 na 5 predstavljao je značajno unapređenje, a prelaz sa Excela 5 na 7 (Excel 95) doneo je samo minorna poboljšanja. (Nije bilo verzije Excel 6.) Ovaj poslednji prelaz na Excel 8 (Excel 97) takode je znaćajno unapređenje, obogaćeno nizom novih mogućnosti i velikim brojein dorada postojećih.

Svakome će se dopasti nove mogućnosti koje su korisne u svakodnevnom radu kao sto je recimo:

· Označavanje bojom područja izabranih ćelija kojim se olakšava unošenje i uređivanje formula. 

· Unapređene su Excelove mogućnosti izrade dijagrama. Izvedene tabele doživele su velika poboljšanja. 

· Važna novina su i deljene radne sveske, 

· Obilje mogućnosti vezanih za Internet. 

1.3.14 Statusna linija

Na statusnoj liniji  prikazuju se poruke o statusu i druge informacije koje umeju biti veoma korisne - Na primer, na statusnoj liniji obično piše Ready, Sto znači da je radna površina spremna za novi posao. Ako izaberete meni, komandu ili pokažete na neku alatku, na statusnoj liniji se prikazuje kratak opis funkcije izabranog menija, komande ili alata. Ako Excel nešto radi, recimo snima radnu svesku, na statusnoj liniji piše šta se upravo dešava. Kada Excel izvršava radnju koja duže traje, recimo otvara datoteku sa mnogo veza, učiniće vam se da je program zaboravio na vas jer se na ekranu ništa ne dešava. Ako tada pogledate statusnu liniju, videćete neku; poruku (recimo, Link") i traku za merenje trajanja radnje.Ponekad statusna linija prikazuje uputstvo šta treba dalje raditi. Na primer, ako isecate ili kopirate ćeliju, na statusnoj liniji piše: 

,,Select destination and press ENTER or choose Paste" (izaberi odrediste i pritisni ENTER ili izaberi Paste). 

Sa desne strane statusne linije nalaze se polja koja pokazuju da li je ukljućen ili isključen neki režim rada tastature (Caps Lock, ; Number Lock i Overwrite).•
napomena:kao dobar uvod poslužiće svojevrstan vodič koji ćete pokrenuti na sledeći način: pritisnite dugme Start i izaberite stavku Help. U dijalogu koji se pojavi pritisnite jezičak Contents i zatim izaberite desetominutnu turu, Ten minutes to using Windows.

1.3.15 Radne sveske

Excelov dokument jeradiin sveskci (engl. workbook). Radne sveske imaju jedan ili više rcidmh listova (engl. workslieets) i druge tipove listova, kako ćete kasnije videti.

• Radnu svesku zamislite kao resistrator.
• Svaki radni list zamislite kao stranu registratora.

Prvo što obično vidite kada pokrenete Excel jeste radna sveskaBook 1. 

Book 1 je nova, nesačuvana radna sveska koja se standardno prikazuje kao početna.

savet; Možete promeniti podrazumevani broj radnih listova u novoj radnoj svesci. 

Izaberite Tools / Options / General pa promenite broj u polju Sheets in New Workbook.

1.3.16 Otvaranje datoteka napravljenih u ranijim verzijama Excela

Excel 8 je u stanju da čita i upisuje datoteke napravljene u ranijim verzijama Excela. Otvaranje stare Excelove datoteke ne traži nikakvu posebnu proceduru .

Koristi se komanda File / Open.

Kada hoćete da sačuvate datoteku, Excel vas pita da li želite da je prevedete u novi format. Ako je odgovor negativan, datoteka ostaje u starom formatu ali neće biti sačuvane formule i formati nepoznati staroj verziji. Ukoliko vaši saradnici i dalje koriste starije verzije Excela, međusobna razmena datoteka je još uvek moguća. Samo upamtite da ne treba da ih ažurirate u formatu Excela 8. 

1.3.16.1 Radni listovi u okviru radnih svezaka

Radni listovi su stranice radne sveske. Radni list se sastoji od mreže ćelija (engl.cells), slično običnim obračunskim listovima kakvi se koriste u računovodstvu. Ćelije su raspoređene u redove i kolone i koriste se za upisivanje brojeva, teksta ili fonnula. Radni listovi nisu ograničeni samo na upis brojeva i teksta - mogu da sadrže i grafičke objekte, kao što su dijagrami, strelice i slike.

Standardna radna sveska sadrži tri radna lista obeležena sa Sheetl, Sheet2 i Sheet3. Može da ih bude i više - jedino ograničenje je raspoloživa memorija. Radni listovi koji su u odredenom odnosu obično čine jednu radnu svesku kako bi sve intbrmacije bile na jednom mestu. 

Na dnu radne sveske nalaze se jezičci pomoču kojih se aktiviraju radni listovi. Aktiviranje radnog lista je i sto što i stavljanje neke strane na početak registratora. 

1.3.17 Rad sa celijama

Svaki radni list se sastoji od mreže ćelija u obliku tabele. Ima ukupno 65.536 redova ćelija numerisanih od 1 do 65.536, duž leve margine radnog lista. Ima 256 kolona označenih po abecednom redu od A do IV, najpre sa po jednim a zatim sa po dva slova duž gornje margine radnog lista.

savet: Kolone možete označiti i brojevima ako promenite stil ćelijskih referenci. 

To znači da svaki radni list sadrži preko 16.000.000 ćelija. U ćelije mogu da se unose tekst, brojevi i formule. Imajte na umu da ipak postoje i praktična ograničenja koja morate uzeti u obzir: ako nameravate da u svaku ćeliju stavite neke podatke, verovatno ćete naići na probleme sa memorijom.

1.3.17.1 Reference ćelija 

snalaženje u radnom listu
Ćelije se navode pomoću slovne oznake za kolonu iza koje sledi broj reda. Na primer, koordinata A2 odnosi se na ćeliju u koloni 1, red 2. U terminologiji tabelarnog izra-čunavanja koordinate ćelije određene redom i kolonom zovu sereference ćelije. U poglavlju 4 naučićete više o referencama ćelija.

1.3.17.2 Aktivna ćelija

Kada mišem izaberete ćeliju, ili se zaustavite na njoj koristeći tastaturu, ona postaje aktiviia čelija. Polje za ime (engl. nnine box) sa leve strane linije za formule (engl. formulu bar) prikazuje referencu aktivne ćelije.

1.3.18 Dijagrami i graficki elementi

Excelovi radni listovi nisu ograničeni samo na brojeve i tekst. Dijagrami i drugi grafićki objekti takode mogu da se smeste u radni list i omoguće izradu reprezentativnih grafičkih prikaza.

· Postoji nekoliko načina za izradu dijagrama, ali je najlakši i najbrži pomoću programa ChartWizard. Ovom programu možete da pristupite aktiviranjem alata ChartWizard. Pruža vam se izbor za rad sa nekoliko različitih osnovnih tipova dijagrama. Alatka ChartWizard je na standardnoj paleti. 

· Dijagrami se obično povezuju sa podacima koji se čuvaju u radnim listovima i automatski se menjaju kada se menjaju podaci. 

· Excel koristi program za crtanje koji zajedno koriste i ostale aplikacije paketa Microsott Office. Alati za crtanje omogućuju crtanje različitih objekata u radnom listu.

· Grafički elementi iz drugih programa mogu se prenositi u radne listove. 

· Mnoge opcije formatiranja mogu da se primene neposredno na ćeliju, na primer fontovi, okviri i boja. 

1.3.19 Pomoc u toku rada

Pomoć koju Excel nudi u toku rada velika je i raznovrsna. Ne samo što nudi mogućnost pretrage po indeksu tema pomoći nego su tu i nove mogućnosti kakav je recimo Office Assistant, animirani pomoćnik koji obezbeđuje pomoć usklađenu sa kontekstom. Postoji više načina da se pristupi raznim vrstama Excelove pomoći.

1.3.19.1 Meni Help

Najočiglednije mesto za pristup ugrađenoj pomoći je meni Help. On obezbeđuje nekoliko mogućnosti za ulaz u sistem za pomoć u toku rada (engl. onlme help).
1.3.19.2 Korišćenje Office Assistanta

Komanda Help / Microsoft Excel Help prikazuje animiranu figuru pomoćnika koji obezbeduje prečice za dobijanje pomoći u skladu sa kontekstom i savete za poboljšanje produktivnosti u radu. Iz imena Office Assistant vidi se da je ovaj pomoćnik prisutan i u drugim programima paketa Microsoft Office.

Kada se Assistant pojavi možete ga pritisnuti kad god vam zatreba pomoć ili kada nešto hoćete da ga pitate. Kada se u njegovom prozorčiću pojavi sijalica, pritisnite je a zatim pritisnite dugme Tips. Pojaviće se savet koji objašnjava brži način izvršavanja neke akcije. Možete mu postaviti i pitanje na engleskom jeziku, on će ponuditi spisak tema pomoći koje bi mogle biti odgovor na vaše pitanje.Office Assistant se može konfigurisati. Pritisnite ga a zatim pritisnite dugme Options i pojaviće se dijalog:Ovaj okvir za dijalog određuje za koje će teme Assistant obezbeđivati pomoć. 

Da biste promenili lik pomoćnika, pritisnite jezičak Gallery i izaberite animaciju koja vam najviše odgovara.

1.3.19.3 Pretraživanje indeksa pomoći

Izaberite Help / Contents and Index i pojaviće se okvir za dijalog Help Topics. Ovo je verovatno najkorisniji pristup ugradenoj pomoći.

· Kartica Contents prikazuje sadržaj ugrađenog sistema pomoći.

· Kartica Index prikazuje indeks tema.

· Kartica Find omogućava traženje pomoci na određenu temu.

1.3.19.4 Dobijanje pomoći u skladu sa kontekstom

Komanda Help / What's This? pretvara uobičajeni pokazivač miša u pokazivač pomoći - normalni pokazivač kome je pridružen veliki upitnik. Ovim pokazivačem možete pritisnuti bilo koji objekat ili izabrati bilo koju komandu i dobićete pomoć koja je usklađena sa kontekstom (ako postoji). Pokazivač se vraća na prethodni oblik pritiskom na taster Esc.
1.3.19.5 Ostale vrste pomoći

Komanda Help / Microsoft on the Web -pokreće čitač Weba i prelazi na izabranu Web stranicu. 
Koristeći komandu Help /  Lotus 1-2-3 korisnici koji sa Lotusa 1-2-3 prelaze na Excel dobiće odgovarajuću pomoć.
U toku rada pomoć je dostupna i za svaki dijalog. Pritisnite dugmence sa upitnikom u gornjem desnom uglu dijaloga, a zatim bilo koji element okvira za dijalog. Pojaviće se prozorčić sa objašnjenjem.
1.3.19.6 Traženje pomoći na određenu temu u programu Help

Šta se dešava kada želite da proverite pravopis u radnom listu, a ne možete da se setite kako se to radi? Do ugrađene pomoći na određenu temu dolazi se na više nacina:

· Izaberete Help / Contents and lndex / karticu Contents (ili pritisnete F1) i pregledanjem više nivoa informacija dođete do onoga što vas zanima. Najbrži način je da do pomoći na određenu temu dođete traganjem. Izaberite Help / Contents and lndex /  karticu Find. Kada prvi put pritisnete tu karticu čarobnjak će vas provesti kroz proces formiranja indeksa.

· Upisite temu. Dok pišete, Excel pretražuje listu tema, i sa svakim slovom koje upisujete dolazi sve bliže temi koju tražite. U sličaju provere pravopisa (engl. spelling) dovoljno je upisati spel da biste dobili spisak tema o proveri pravopisa. Izaberite temu (recimo spelling checking), a zatim pritisnite dugme Display. U donjoj polovini okvira za dijalog Find pojaviće se lista tema. Sa dva pritiska na taster miša izaberite temu koj'a vam se čini najkorisnijom, ili izaberite temu pa pritisnite Display.

1.3.20 Sta je novo u Excelu 8

Evo pregleda značajnih poboljšanja koja ćete naći u Excelu 8 sa ukazivanjem ,

Osnovne mogućnosti
Potražite sledeće nove osnovne mogućnosti i poboljšanja u Excelu:
Veći radni listovi: Broj redova u radnom listu povećan je sa 16.384 na 65.536. Dosadašnjim korisnicima Excela ovo je verovatno jedno od najvažnijih poboljšanja.
Povećan kapacitet ćelije: U svaku ćeliju sada može da se smesti do 32.000 znakova umesto dosadašnjih 256.
Formule sa običnim rečima: U ranijim verzijama korisnici Excela morali su da uče razna zamršena pravila imenovanja kako bi postigli ono što je sada omo-guceno formulama u kojima se koristi običan jezik. 

Vise nivoa poništavanja: Poput Microsoftovog Worda i Excel sada podržava više nivoa poništavanja izvedenih akcija (Undo). Komandom Edit> Undo možete poništiti poslednjih 16 aktivnosti. 

Područja ćelija označena bojom: Kada unosite formule koje se odnose na jedno ili više ćelijskih područja, formula i područja se ističu bojama što znatno olakšava uredivanje formula.. Označavanje područja bojama koristi se i pri izradi dijagrama.

Pregled preloma strana: Ova nova mogućnost veoma pojednostavljuje postavljanje i promenu preloma strana.

Komanda za umetanjc fimkcije: Komanda Insert Function je poboljšana i znatno olakšava unošenje funkcija.

Deljene radne sveske: Mnogim organizacijama ovo će biti najznačajnija novost u Excelu 8. Komanda Tools / Share Workbook omogućava da više osoba istovremeno ureduje istu radnu svesku. Mogućnosti formatiranja
Nekoliko novih mogućnosti za formatiranje ćelija naci ćete u okviru za dijalog koji se otvara komandoni Format > Cells . Tu spadaju spajanja ćelija, rotiranje teksta, uvlačenje ćelija i još neke:

Spojene ćelije: Dve ili više ćelija mogu se spojiti u jednu veću komandom Format / Cells / Alignment. 

Rotiran tekst: Kartica Alignment dijaloga koji se otvara komandoin Format / Cells omogućava da rotirate tekst.

Uslovno formatiranje: Za ovu mogućnost zadužena je komanda Format / Conditional Formatting. Omogućeno je formatiranje ćelija uslovljeno vrednošću njihovog sadržaja ili funkcijama radnog lista. (Ova mogućnost je jedna od najtraženijih kad su u pitanju napredniji korisnici Excela.)

Mogućnosti za izradu dijagrama i grafikona
Excelova mašinenja za pravljenje dijagrama je pravi užitak. Navedimo sarno nekolicinu iz mnoštva novih mogućnosti:

Novi tipovi dijagrama: Dodato je nekoliko novih tipova dijagrama i opcija za formatiranje. Tu su novi kružni dijagram iz kružnog dijagrama (pie-of-a-pie}, prugasti dijagram iz kružnog dijagrama (bar-of-a-pie) i mehurasti dijagrami [bubble). Dodati su i novi oblici: piramide, kupe i cilindri. 

Vise podataka: U pitanju je značajno poboljšanje ako na dijagramu treba predstaviti veliku količinu podataka. U dvodimenzionalnim dijagramima sada je ograničenje pomereno na 32.000 tačaka - značajan pomak u odnosu na 4.000 tačaka Excela 7.

Obaveštenja o elementima dijagrama: Kada je dijagram aktivan i pokazivač postavite na neki objekat unutar dijagrama, pojaviće se natpis sa imenom objekta. Zaljubljenici u dijagrame sigurno će poželeti srdačnu dobrodošlicu ovoj mogućnosti ako se setimo koliko objekata ume da se nađe na dijagramu i kako blizu mogu da budu jedan u odnosu na drugi.

Vremenska osa: Ako pravite dijagram sa podacima koji predstavljaju datume, automatski se koristi vremenska osa.

Crtanje: Excelove crtačke i grafičke mogućnosti dramatično su poboljšane. Nova paleta za crtanje, zajednička svim programima paketa Microsoft Office, sadrži bezbroj oblika i opcija. 

Novi grafički filtri: Podrška formatima GIF i JPEG omogućava da izvozite dijagrame na World Wide Web.

Mogučnosti analize podataka
U novoj verziji Excela očekuju vas nove ili dorađene mogućnosti analize podataka:

Izvedene tabele: Ovo značajno analitičko sredstvo je veoma poboljšano. Naročito je značajno to što su dodata izračunata polja i izračunate stavke, pored brojnih drugih poboljšanja. 

Microsoft Query: Ovaj program (koji je sastavni deo Excela) pojednostavljen je za korišćenje zahvaljujući čarobnjaku Query Wizard koji novajlije provodi kroz proces definisanja upita za bazu podataka.

AutoFilter: Ova komanda koja spada u domen baza podataka  sada omogućava da vidite 10 najvećih vrednosti polja.

Pozadinski upiti: Upiti baza podataka mogu se obavljati i u pozadini omogućavajući vam da nastavite rad u Excelu dok se upit obrađuje. Pozadinsko izvršavanje upita podržavaju i izvedene tabele zasnovane na spoljašnjiin podacima. 

Provera podataka: Omogućava da uspostavite pravila koja podatak mora zadovoljiti da bi se upisao u ćeliju. Na primer, možete zadati da se u ćeliju sme upisati samo onaj podatak ćija je vrednost u granicama od 1 do 10. 

GETPIVOTDATA: Nova funkcija radnog lista koja omogućava da se referenciraju podaci u izvedenoj tabeli.

1.3.21 Excel  i  Internet

Excelu 8 dodat je čitav niz mogućnosti u vezi sa Internetom. 0 njima se govori u poglavlju 29.

Hiperveze: Ćak i da niste korisnik Interneta nemojte prevideti ovu mogućnost - veoma je korisna i kad je upotrebljavate samo u Excelu. 

Paleta Web: Ova paleta alatki koja je na raspolaganju u celom paketu Office, omogućava da krstarite kroz Officeove dokumente jednako kao što biste krstarili kroz World Wide Web.

Snimanje u formatu HTML: Naučite kako da sačuvate tabele i dijagrame snimajući ih u formatu HTML koji se koristi na Web stranicama.

U ovom poglavlju upoznali ste se opštim izgledom i osobenostima Excelovog okruženja i pročitali šta je novo u Excelu 8. U sledećem poglavlju naučićete kako da pravite, snimate i manipulišete Excelovim dokumentima i kako da menjate Excelov radni prostor da biste ga prilagodili svojim potrebama.

1.3.22 Rad sa prozorima u Excelu

Mnogi korisnici se iznenade kada shvate da ,,prozori" i ,,radne sveske" nisu isto. Jedna radna sveska može biti prikazana u više prozora. Jedna od najboljih posledica ove mogućnosti je da se istovremeno može prikazati više radnih listova. Na primer, ako ste statističke podatke o trendovima prodaje organizovali tako da svaki mesec ima svoj list, možete uporediti informacije o prodaji u toku nekoliko meseci otvaranjem više prozora. Isto tako možete gledati numeričke podatke na jednom listu i odgovarajući dijagram na drugom.

1.3.22.1 Prikazivanje radne sveske u vise prozora

Pretpostavimo da je Bookl aktivna radna sveska. Ako želite da je prikažete u jos jednom prozoru izaberite komandu Window / New Window da otvorite drugi prozor za Bookl. Sada ćete imati dva otvorena prozora: Bookl  i Book2. To su dva prozora sa pogledom u istu radnu svesku. Sve što unesete u jednom videće se u drugom i obrnuto.
1.3.22.2 Raspoređivanje prozora

Ima nekoliko načina da se brzo rasporedi više prozora da budu vidljivi. Da biste razumeli sve načine na koje prozori mogu da se rasporede, uradite ovu malu vežbu:
1. Otvorite tri ili više prozora birajući Window / New Window nekoliko puta.
2. Izaberite komandu Window / Arrange. Prikazaće se sledeci dijalog:
3. Sada iz dijaloga izaberite jednu od opcija Arrange:

Tiled- Svaki prozor je potpuno vidljiv, a Excel odlučuje o njihovom rasporedu na osnovu broja otvorenih prozora.

Horizontal- Svaki prozor je potpuno vidljiv, a raspored je horizontalan

Vertical- Svaki prozor je potpuno vidljiv, a raspored je vertikalan.

Cascade- Prozori se preklapaju i vidi se naziv svakog prozora.

1.3.22.3 Raspoređivanje samo aktivne radne sveske

Ako imate vise otvorenih radnih svezaka i više otvorenih prozora za svaku od njih, koristite polje za potvrdu uz opciju Windows of active workbook kako biste rasporedivanje prozora ograničili samo na aktivnu radnu svesku:

• ako je opcija potvrdena, rasporeduju se samo prozori aktivne radne sveske.

• ako .nije potvrdena, raspoređuju se svi prozori svih otvorenih radnih svezaka.

1.3.22.4 Kretanje između prozora

U Excelu postoje razni načini za kretanje iz jednog u drugi prozor.

• Na dnu menija Window navedeni su svi otvoreni prozori - izaberite onaj koji želite da aktivirate,

• Ako su prozori raspoređeni tako da je više prozora vidljivo, mišem izaberite pro-zor koji želite da aktivirate.

• Pritisnite Ctrl+F6 da aktivirate sledeći prozor, odnosno Ctrl+Shift+F6 da aktivirate prethodni prozor.

1.3.22.5 Zatvaranje prikazanih prozora

Kada se na ekranu nalazi otvoreno više prozora koristite kontrolni meni. Na primer, ako želite da zatvorite samo jedan od prozora, komanda File > Close nij'e uvek pravi izbor jer se njome zatvaraju svi prozori. Da biste zatvorili samo jedan prozor upotrebite komandu Close iz kontrolnog menija odredenog prozora. Da biste otvorili kontrolni meni aktivnog prozora, mišem izaberite ikonu na levoj strani linije naslova prozora 

Da biste zatvorili samo jedan prozor:

· Mišem izaberite kontrolnu ikonu prozora a zatim Close iz menija; 

· Pritisnite dvaput taster miša pokazujući na kontrolnu ikonu prozora. (Komande iz kontrolnog menija nisu komande Excela, već Microsoftovog programa Windows.)

1.3.22.6 Sakrivanje prozora

Ponekad će biti potrebno da privremeno saknjete prozor da biste rasćistili radnu površinu. 

· Izaberite komandu W!ndow  / Hide da sakrijete aktivni prozor. 

· Kasnije možete komandom Window / Unhide da otkrijete prozor.

napomena; Radne sveske i prozori nisu obavezno sinonimi. Jedna radna sveska može biti prikazana u više prozora. Ako je radna sveska prikazana u samo jednom prozoru, tada su prozor i radna sveska sinonimi - zatvaranjem prozora zatvarate i radnu svesku.

1.4 Promena prikaza na ekranu

Irna mnogo različitih parametara koji određuju kako če slike biti prikazane na ekranu. Oni se odnose na različite elemente: radnu površinu, radnu svesku, radni list i prozor. 

1.4.1 Kontrola prikaza radne površine

Parametri koji se odnose na radnu površinu primenjuju se na celu Excelovu radnu površinu, a ne na posebnu radnu svesku ili radni list.

1.4.1.1 Sakrivanje linije za formule i statusne linije

Osnovni razlog za sakrivanje linije za formule i statusne linije jeste dobijanje dodat-nog prostora na ekranu. Ako želite da ih sakrijete uradite sledeće:

• Izaberite View s- Formula Bar da sakrijete ili prikažete liniju za formule.

• Izaberite View / Status Bar da sakrijete ili prikažete statusnu liniju.

Excel pamti ove parametre od sesije do sesije. Ako sakrijete liniju za formule i izađete iz Excela, linija za formule biće sakrivena kada sledeći put udete u Excel.

1.4.1.2 Prikazivanje preko celog ekrana

Komanda View > Full Screen prikazuje Excel preko celog ekrana sakrivajući liniju naslova, palete, statusnu liniju, liniju menija i trake za pregled. Na taj način dobija se dodatni prostor za rad. Ćesto se koristi za predstavljanje Excelovih dokumenata uz pomoć projektora. Excel pamti ovaj parametar od sesije do sesije.

Da biste se prebacivali iz prikaza preko celog ekrana u normalni prikaz i obrnuto, možete da koristite i paletu Full Screen: samo izaberite View / Toolbars / Full Screen.

1.4.2 Kontrola prikaza radne sveske ili prozora

Parametri radne sveske čuvaju se zajedno sa radnom sveskom. Ako promenite bilo koji parametar i sačuvate radnu svesku, zatvorite je i kasnije ponovo otvorite, parametar će biti sačuvan. Parametrima za promenu prikaza radne sveske ili prozora pristupa se 

· Izborom komande Tools  / Options  / zatim kartice View 

1.4.2.1 Horizontal scroll bar/Vertical scroll bar 

Trake za horizontalno i/ili vertikalno pome-ranje možete da prikažete ili sakrijete potvrđujući ili uklanjajuci potvrdu sa polja za potvrdu Horizontal scroll bar odnosno Vertical scroll bar.

1.4.2.2 Sheet tabs 

Ova opcija kontroliše prikaz jezičaka radnih listova u dnu radne sveske. Ukoliko distribuirate radnu svesku sa više listova ali tako da se vidi samo jedan list, potrebno je da sakrijete jezičke ostalih radnih listova. U tu svrhu treba da uklonite potvrdu iz polje za potvrdu Sheet tabs.

1.4.2.3 Kontrola prikaza radnog lista

Parametri radnog lista odnose se samo na aktivni radni list i čuvaju se samo za taj radni list. Parametri radnog lista, kao i parametri za prikazivanje radnih svezaka i prozora, zadaju se izborom komande Tools > Options, zatim kartice Vievv iz dijaloga (slika 2.7). Evo tih opcija:

1.4.2.4 Rovv & column headers 

Ako je ovaj parametar potvrđen, zaglavlja redova i kolona su vidljiva, a ako nije, sakrivena su.

Gridlines. Ako je ovaj parametar potvrđen, na radnom listu su vidljive linije mreže. Ako nije, mreža je isključena i za radni list na ekranu i za štampani radni list.

napomena: Linije mreže nisu isto što i okvirne ivice ćelija - linije mreže se vide ili ne vide sve zajedno, a ivice ćelija se definišu selektivno. Okvirne ivice ćelija, mnogo su upadljivije kada se uklone linije mreže.

1.4.2.5 Gridlines Color 

Različite boje za linije mreže možete da izaberete iz padajuće liste Color .Probajte svetlo sivu varijantu koja je manje napadna.

1.4.2.6 Page breaks 

Ako je ovaj parametar potvrđen, prelom strane prikazan je kao isprekidana linija duž odgovarajuće linije mreže na kojoj dolazi do preloma. Ako nije, prelom strane se ne vidi sve dok se strana ne odštampa. (Linije koje označavaju pre-lome strana vide se samo na ekranu - ne pojavljuju se na odštampanom materijalu.)

1.4.2.7 Zero values 

Ako je ovaj parametar potvrđen, u ćelijama sa sadržajem nula biće prikazana nula; u suprotnom, ćelija će biti prazna. Ne zaboravite da se ovaj parametar odnosi na ceo radni list. U poglavlju 5 objašnjene su neke tehnike tbrmatiranja za selektivniju primenu ovog parametra.

1.4.3 Podela prozora na okna

Prozor možete da podelite na okna (engl. pane) da dobijete dva ili četiri dela koja se zasebno pomeraju.Jedan od čestih razloga za razdvajanje okana je dobijanje zaglavlja redova i/ili kolona koja se pomeranjem neće izgubiti sa ekrana. Drugi razlog je, jednostavno, da biste videli više delova lista u isto vreme.

Da biste podelili prozor na okna, prvo izaberite ćeliju (ćelije) za tačku razdvajanja.

• Izaberite celu kolonu da razdvojite okna vertikalno.

• Izaberite ceo red da razdvojite okna horizontalno.

• Izaberite jednu ćeliju da razdvojite okna po linijama tačno iznad i sa leve strane ćelije.

Zatim izaberite komandu Window / Split. Svaki od četiri dela pomera se posebno tj. svaki se može pregledati kao da je zaseban prozor.

1.4.3.1 Zamrznuta okna 

Ako se prozor deli na okna zbog zamrzavanga naslova redova i/ili kolona, 

izaberite komandu Window " Freeze Panes da zaključate podelu na mestu gde jeste. Tada se dešavaju sledeće promene:

• linije podele postaju pune linije;

• okno iznad horizontalne linije razdvajanja ne može više da se pomera;

• okno sa leve strane vertikalne linije razdvajanja ne može više da se pomera. Sleded koraci će vam pomoći da shvatite podelu prozora i zamrzavanje okana. 

1. Unesite u prazan radni list: nazive za sve kolone (A-E) upišite u prevom redu

2. Izaberite ćeliju B2.

3. Izaberite komandu Window > Split. Sada treba da imate četiri okna slična onima na slici 2.8, od kojih se svako posebno pomera.

4. Izaberite komandu Window > Freeze Panes. Red 1 i kolona A sada su zamrznuti u mestu. Kada pomerate radni list, zaglavlja ostaju vidljiva.

savet: Drugi naćin podele na okna je povlačenjem delitelja prozora (engl. split boxes). Podela na okna ne mora da ide duž linija okvira ćelija.

1.4.3.2 Uklanjanje podele 

Da biste ponovo spojili sva okna u jedan prozor uradite jedno od sledećeg:

• Izaberite komandu Window > Remove Split da uklonite horizontalno i verti-kalno razdvajanje.

• Ako prozor nije zamrznut pritisnite dva puta taster miša na liniju podele ili mišem povucite delitelje prozora na krajeve traka. Ako je podela zamrznuta, pre no što je uklonite morate da izaberete komandu Window / Unfreeze Panes da odmrznete okna.

1.4.3.3 Zumiranje

Da biste smanjili ili povećali uvećanje prikaza prozora: 

· Izaberite nivo uvećanja ili umanjenja sa padajuće liste na paleti Standard. 

· Izaberite View- Zoom da biste otvorili dijalog prikazan dole. Manje uvećanje omogućava da vidite veći deo rad-nog lista na ekranu, dok veće uvećanje list čini većim.

savet: Ukoliko koristite novog Microsoftovog miša sa tockićem umesto srednjeg tastera,  točkićem možete uvećavati ili umanjivati prikaz prozora.

Možete da izaberete jedno od nekoliko ugradenih uvećanja iz dijaloga ili da uvećanje precizno zadate pomoću opcije Custom. Ako izaberete opciju Fit selection, izabrani deo se uvećava toliko da ispuni prozor, najviše do 400%.

napomena: Podela na okna, zamrzavanje okana i zumiranje ne utiču na štampani dokument.

1.4.4 Rad sa radnim listovima

Radni listovi se sastoje od pojedinačnih ćelija a ćelije mogu da sadrže brojeve, tekst, formule itd. U ćelijama se nalaze i podaci za dijagrame, liste i tabele. Raditi u radnim listovima znači naučiti kako se radi sa ćelijama, kako prikazi-vati i sintetizovati podatke i kako povezivati ćelije da bi se dobile različite perspektive.

1.4.4.1 Sve o celijama

Celija je osnovni element Excelovog radnog lista. Osnovne osobine ćelija su sledeće:

• mogu da sadrže tekst ili brojeve;

• mogu da sadrže formule koje se koriste za izračunavanje;

• mogu da se formatiraju pomoću raznovrsnih opcija za forrnatiranje, kao što su fontovi, okviri, boje i opcije za poravnavanje podataka unutar ćelije.

Ćelije se identifikuju prema položaju na mreži radnog lista, pri čemu slova označavaju kolonu, a brojevi red. Na primer, ćelija B4 nalazi se na preseku druge kolone i četvrtog reda. Adresa ćelije, kao što je B4, naziva se referencom ćelije.

napomena: Oznake kolona i redova možete promeniti tako što ćete za stil referenci odabrati R1 C1. (Izdajte komandu Tools > Options pa u kartici General izaberite ovaj stil.) 

1.4.4.2 Aktivna ćelija

Jedna ćelija je uvek aktivna. Referenca aktivne ćelije nalazi se uvek u polju za ime sa leve strane linije za formule. Lak način za aktiviranje ćelije je da je izaberete mišem. Posle toga svaki unos odlazi u aktivnu ćeliju.

Postoje slučajevi kada nemo aktivne ćelije, na primer kada se izabere grafički objekat.

1.4.4.3 Biranje više ćelija u isto vreme

Postoje situacije kada treba da kopirate, premeštate ili na bilo koji drugi način manipulišete sa grupom ćelija. Za takve slučajeve Excel omogućava izbor skupa  ćelija odnosno područja (engl. range) ćelija. Skup ćelija najlakše možete da odaberete ako mišem izaberete jednu ćeliju, povučete pokazivač preko nekoliko ćelija držeći levi taster miša i zatim pustite taster. Izabrane ćelije zovu se selekcija. I kada se izabere skup ćelija, aktivna je samo jedna. 

• B2:D5 - dve tačke ovde znače do.
1.4.4.4 Tipovi ćelijskih podataka

Postoje četiri različita tipa podataka koji se unose u ćelije: tekst, brojevi, logičke vred-nosti i vrednosti greške. Pogledajmo svaki pojedinačno.

Tekst

•Tekst u ćeliji može da se sastoji od bilo koje kombinacije slova, brojeva i sim-, bola sa tastature.

• Ćelija može da prihvati 32.000 znakova (prethodna verzija Excela prihvatala je samo 255).

• Ako Sirina kolone ne dopušta da se sav tekst vidi, tekst se proteže na susedne ćelije. Medutim, ako su susedne ćelije zauzete, prikaz će biti presečen.

Brojevi

U programima za tabelarne proračune najčešće se izvode nuiTierički proračuni pa ćete u sledećih nekoliko poglavlja naučiti mnoge načine za obavljanje izračunavanja i for-niatiranje brojeva na radnom listu. Da biste razumeli kako Excel postupa sa broje-vima, potrebno je nekoliko važnih objašnjenja:

• Broj može da se prikaže sa zarezima, u naučnoj notaciji ili u nekom od ugrađenih numeričkih formata. Nemojte izjednačavati format prikaz broja i njegovu brojnu vrednost. Format prikaza je ono što vidite u ćeliji, a brojna vrednost je izračunata vrednost (koju možete videti u liniji za formule). 

• Datum i vreme su brojevi, ali posebnog formata.

• Excel se veoma trudi da razume značenje numeričkog unosa i tbrmatira ga na odgovarajući način. Ukoliko pokušate da unesete 1-9 kao tekst, Excel će unos tumačiti kao datum i prikazati ga kao 9-Jan (ili 1. sep).

• Kada neformatiran broj ne može da stane u ćeliju, koristi se naučna notacija za njegov prikaz.

• Ako t'ormatiran broj ne može da stane u ćeliju, na ekranu će biti prikazani znakovi (f###.

Logičke vrednosti

U ćeliju mogu da se unesu logičke vrednosti TRUE i FALSE (tačno i pogrešno). Logičke vrednosti se najčešće koriste pri pisanju uslovnih tormula. Isto tako, rezultat izvršavanja nekih formula je logička vrednost.

Greška

Formule mogu u rezultatu da daju grešku. Vrednost greške je poseban tip podatka. Na primer, ako u formuli postoji deljenje nulom rezultat je vrednost greške #DIV/0!.

Unošenje, izmena i brisanje sadržaja celija

Sledi opis uobičajenih procedura za unošenje podataka u ćeliju, izmenu podataka u ćeliji i brisanje sadržaja ćelije.

1.4.5 Unošenje podataka u ćeliju

Da biste podatak uneli u ćeliju postupite ovako:

1. Mišem izaberite ćeliju.

2. Unesite brojeve, tekst ili kombinaciju brojeva i teksta.

3. Pritisnite Enter (ili zeleni znak potvrde koji se pojavljuje na liniji za formule dok kucate).

Kada izaberete ćeliju podaci u ćeliji prikazuju se i u liniji za formule. Ovaj detalj postaće još značajniji kada počnete da radite sa formulama. U toj liniji prikazuje se formula sadržana u aktivnoj ćeliji dok se rezultat prikazuje u ćeliji.

1.4.5.1 Unošenje brojeva

1. Numerički unos može da se sastoji od brojeva od 0 do 9 .Excel prihvata brojeve iz raspona od 9,99999999999999307 (približno 100 biliona stepenovano sa 307) do -9,99999999999999307.

savet: Brojeve sa fiksnim dedmalnim taćkama možete da unesete:

Izborom Tools / Options / izaberete karticu Edit / Aktivirajte opciju Fixed Decimal i izaberite potreban broj fiksnih decimalnih mesta. 

ZNAKOVI  KOJI SU  DOZVOLjENI  PRI  UNOŠENjU BROJEVA 

Znak             Funkcija
· 0 do 9            Bilo koja kombinacija brojeva 

· +                 Koristi se u kombinadji sa E da označi eksponent

· Znak za negativan broj 

· ()                 Označava negativan broj 

· , (zarez)       Znak za razdvajanje hiljada *

· /                  Znak za deljenje, razlomačka crta (kada se ispred razlomka nalazi jedan razmak)    ili         znak za razdvajanje datumskih podataka

· $                  Znak za valutu

· %                Znak za procenat

· . (tačka)      Dedmalna tačka *

· E                 Znak za eksponent

· e                 Znak za eksponent

· :                  Znak za razdvajanje podataka o vremenu

· (jedan razmak)     Za razdvajanje složenih razlomaka (npr. 4 1/2) i podataka o datumu i vre-menu(npr. 1/2/945:00**)

Napomena: U Windowsu možete podesiti da tačka služi za razdvajanje hiljada, a zarez da bude decimalni zarez.: Razni alfabetski znaci takođe se mogu protumačiti kao delovi datuma ili vremena, na primer, 4-Jan ili 5:00 AM)

1.4.5.2 Unošenje brojeva kao teksta

Šifra proizvoda može da se sastoji samo od numeričkih znakova, ali vi ne želite da Excel takav unos tumači kao broj. Na primer, kada unesete 1-9 kao broj koji treba da predstavlja kod proizvoda Excel c'e prikazati datum9-Jan (ili 1. sep). Da bi unos bio prihvaćen kao tekst, prvi znak treba da bude apostrof. Apostrof se neće videti u ćeliji, niti će biti štampan, ali videćete ga kada obrađujete ćeliju. Kada se apostrofom zada da broj postane tekst, na ćeliju se više neće primenjivati numeričko formatiranje niti se taj broj može koristiti za izračunavanja.

1.4.5.3 Unošenje datuma i vremena

Kada unesete broj koji Excel tumači kao datum ili vreme, broj ce biti tako i formatiran.

' savet: Unutar ćelije tekst se standardno poravnava ulevo, a brojevi udesno. Tako odmah možete da uoćite da 11 je Excel unos protumačio kao tekst ili kao broj.

1.4.5.4 Izmena sadržaja ćelije

Ne brinite ako otkrijete grešku koju ste napravili prilikom upisivanja. Izrnenu sadržaja ćelije možete da obavite na dva mesta: u liniji za formule ili u ćeliji.

· Linija za formule Izaberite ćeliju pa pritisnite liniju za formule. Kursor prelazi u liniju formule.

· U ćeliji Pritisnite dvaput taster rniša pokazujući na ćeliju ili pritisnite F2 . Kursor se premešta na kraj sadržaja ćelije.

Aktiviranje izmene sadržaja u ćeliji je opcija koja može da se uključuje i isključuje. 

Izaberite komandu Tools / Options / karticu Edit pa potvrdite ili uklonite potvrdu sa opcije Edit directly in cell. 

Mogućnost isključivanja izmene sadržaja u ćeliji ima nekoliko prednosti:

• Izbor ćelije sa beleškom odnosno komentarom sa dva pritiska na taster miša omogućava izmene komentara u ćeliji.

• Kada ćeliju koja je u vezi sa drugim ćelijama izaberete sa dva pritiska na taster miša, to će vas odvesti do drugih ćelija.Izmenite sadržaj ćelije ili linije za formule koristeći osnovne tehnike za uredivanje teksta:

• Sa dva pritiska na taster miša izaberite reč. Upotrebite miša da postavite kursor ili izaberete tekst.

• Istaknut tekst zamenjuje se onim što unesete.

• Pritisnite Home da se vratite na početak, ili End da odete na kraj.

• Upotrebite tastere sa levom i desnom strelicom za kretanje levo i desno.

• Dok u formulama definišete ili menjate reference ćelija, taster F2 menja značenje tastera sa strelicom nalevo, odnosno nadesno. Na taj način tasteri sa strelicama mogu da se koriste i za kretanje kroz list, a ne samo kroz formulu.

Pritisnite Enter  ili mišem izaberite polje za unos u liniji za formule da završite izmenu sadržaja ćelije.

1.4.5.5 Poništavanje unosa i izmena sadržaja ćelije

Ako tokom rada promenite mišljenje o nekom unosu, možete da ga poništite pre nego što pređete na drugi unos:

• Ukoliko još niste pritisnuli Enter, ono što ste uradili tokom unošenja ili izmene sadržaja ćelije možete da opozovete pritiskom na taster Esc ili dugme Cancel. (Dugme Cancel vidi se jedino pri uredivanju sadržaja ćelije - to je malo dugme u liniji za formule oznaćeno sa X).

• Ukoliko ste već pritisnuli Enter, ali posle toga niste preduzeli nikakvu drugu radnju, možete da izaberete komandu Edit  / Undo.

Excel omogućava i da obrnete redosled više aktivnosti. Dugme Undo na paleti Standard ima padajuću listu sa spiskom poslednjih 12 aktivnosti. Dok idete unazad poništavajući ono što ste radili Excel dopunjava listu prethodnim aktivnostima izvedenim od trenutka kada ste otvorili radnu svesku.

1.4.5.6 Brisanje sadržaja ćelije

Brisanje sadržaja ćelije isto je što i brisanje greške gumicom. 

Komanda Edit> Clear razlikuje se od Edit > Delete po tome što Delete prouzrokuje da se pomaknu ćelije ispod i/ili desno. Najbrži način da se obriše sadržaj izabrane ćelije (ćelija) jeste da se pritisne taster Delete. Time se briše sadržaj ali ostaje formatiranje i upisane beleske odnosno komentari. Komandom Edit > Delete briše se ćelija.

Izaberite ćeliju (ćelije) čiji sadržaj treba da bude obrisan i izaberite komandu Edit> Clear, zatim jednu od sledećih komandi iz njenog podmenija:

All: briše sve (sadržaj, formate i beleške) iz izabranih ćelija.

Format: briše formate.

Contents: briše samo sadržaj; isto što i taster Delete.

Comments: briše samo komentare iz ćelije.

savet: Ukoliko želite da zamenite sadržaj ćelije nekim drugim unosom, nije potrebno da prvo obrišete ćeliju. Izaberite ćeliju i počnite da unosite nov sadržaj; stari sadržaj će biti zamenjen.

1.4.6 Kretanje kroz radne listove pomocu miša

Za efikasnije kretanje kroz radni list, na primer direktni odlazak u odredene ćelije, možete da koristite neke tehnike rada sa mišem. To će vam uštedeti vreme koje biste proveli koristeći trake za pregled. Sledi opis tehnika za efikasno kretanje kroz radni list pomoću miša.

1.4.6.1 Odlazak na početak ili kraj bloka ćelija

Kada radite sa blokom podataka često vam zatreba da se premestite na početak ili kraj bloka da biste nešto promenili ili dodali. Brz način za odlazak na kraj bloka punih ili praznih ćelija jeste da dva puta pritisnete onaj deo okvira ćelije koji odgovara smeru u kome želite da se krećete. Na primer, da odete na dno kolone podataka, pritisnite dva puta donju liniju okvira ćelije. Da odete na kraj reda, pritisnite dva puta desnu liniju okvira ćelije. Izabrana ćelija biće poslednja (ili prva) ćelija u redu ili koloni.

1.4.6.2 Direktan odlazak do određene ćelije

U radnom listu možete da odete do bilo koje određene ćelije ili područja. Najbrži način da direktno dodete do neke ćelije jeste putem polja za ime u liniji za formule. Poslužite se bilo kojim od sledećih metoda:

• Izaberite polje za ime i unesite referencu ćelije, zatim pritisnite Enter.

• Ako ćelija ima ime, izaberite ga iz padajuće liste.

Pritisnite strelicu usmerenu nadole sa leve strane linije za formule da biste otvorili listu.

1.4.6.3 Odlazak do ćelije komandom Go To

Komandom Go To možete da predete na određenu ćeliju ili područje odnosno skup ćelija naročito u slučajevima kada treba da se vratite na prethodnu a ne možete da se setite gde je bila:

1. Izaberite Edit s> Go To (ili pritisnite F5). Pojavljuje se dijalog Go To .

2. Izaberite čeliju ili skup ćelija iz liste sa imenima, ili unesite referencu ćelije u polje Reference. Znak za dolar ne morate da kucate.

3. Pritisnite OK.

Excel pamti poslednje četiri reference izabrane opisanom metodom i nabraja ih na vrhu liste okvira za dijalog Go To . Svaka ćelija koja ima ime u radnoj svesci biće navedena ispod poslednje četiri reference.

1.4.7 Kretanje kroz radne listove pomocu tastature

Za kretanje u Excelu većinom ćete koristiti miša, ali u nekim slučajevima zgodnija je tastatura. 

savet: Proverite da li su deaktivirani tasteri Scroll Lock i Num Lock na tastaturi. Kada je Scroll Lock aktivan, pritiskanjem tastera sa strelicama pomera se ceo radni list, umesto da se pomerate samo unutar ćelije, a neke tastature i nemaju izdvojene tastere sa strelicama.

1.4.7.1 Kretanje kroz skup ćelija

Ako radite sa nekim skupom ćelija (selekcijom) zgodno je da se krećete samo unutar njega. Možete da izaberete skup ćelija, zatim da upotrebite tastere  da se krećete kroz izabrani skup.

savet: Ako prelazite na neko udaljenije područje na radnom listu služeći se mišem ili trakama za pregled a niste izabrali novu ćeliju, pritisnite Ctrl+Backspace (jedan znak unazad), da se brzo vratite na aktivnu ćeliju.

Kada treba da radite sa skupom ćelija (na primer da im svima promenite format, obrišete sadržaj ili obavite neku računsku operaciju sa podacima koje sadrže) najpre morate da ih izaberete. Možete upotrebiti miša, tastaturu ili kombinaciju miša i tastature.

1.4.8 Biranje ćelija pomoću miša

Postoji nekoliko načina da izaberete ćelije pomoću miša, 

Biranje skupa ćelija povlačenjem

1. Izaberite ćeliju na uglu, ali nemojte pustiti taster miša.

2. Povucite miša da izaberete skup.

3. Kada izaberete skup, pustite taster. '

napomena: Dok birate skup ćelija, polje za ime ćelije prikazuje dimenzije izabranog skupa. Ukoliko izbor obuhvata četiri reda i dve kolone, videćete 4R x 2C. Ove dimenzije možete videti na ekranu samo dok birate— čim pustite taster miša dimenzije se zamenjuju referencama ćelija.

1.4.8.1 Biranje velikog skupa bez povlačenja 

Biranje velikog skupa pomoću miša može da bude nezgodno. Evo drugog načina:

1. Izaberite celiju u jednom uglu skupa.

2. Držite Shift i izaberite ćeliju u suprotnom. uglu skupa. Ceo skup je automatski izabran.

1.4.8.2 Druge mogućnosti biranja mišem 

Da izaberete

Uradite sledeće

· Da izaberete  jedan red uradite sledeće : Izaberite broj reda na levoj strani radnog ista 

· Da izaberete  više redova uradite sledeće: Povucite miša gore ili dole, kroz brojeve redova 

· Da izaberete  nesusedne redove uradite sledeće: Drite Ctrl dok birate brojeve redova 

· Da izaberete  nesusedne kolone  uradite sledeće: Isto kao za redove, ali izaberite oznaku kolone

Da izaberete  ceo radni list uradite sledeće: Pritisnite dugme SelectAllu gornjem levom uglu radnog lista 

Da izaberete  više skupova uradite sledeće: Držite Ctrl dok birate

Da izaberete  oblast sa tekućim podacima uradite sledeće: Izaberite ćeliju iz oblasti sa podacima, aktivirajte alatku Select Current Region 

1.4.9 Biranje ćelija pomoću tastature

Ako više volite da su vam prsti na tastaturi, skupove ćelija možete izabrati i koristeći samo tastaturu i kombinacije tastera za raznovrsne mogućnosti označavanja selekcije ćelija.

Prečice sa tastature za izbor pravougaonih skupova ćelij'a
Ćesto je potrebno izabrati celu oblast (engl. region) koju cini pravougaoni skup susednih ćelija, da bi se nešto obavilo, na primer da bi se kopirala tabela, napravio dijagram od izvedene (engl. pivot) tabele, primenio okvir ili formatirao skup ćelija. Početnici obično takav skup biraju povlačenjem misem, što jeste efikasno. Medutim, šta ako je pravougaoni skup veći od prozora? Najbrži način da se izabere ceo pravougaoni skup susednih ćelija jeste kombinadja Ctrl+Shift+*.

Postoje još dva nacina: ako ne želite da pamtite tastere, postavite alatku Select Current Region na paletu alatki i izaberite je da biste izabrali aktivnu oblast (u poglavlju 7 naučićete kako se prave namenske palete alatki); drugi način je da otvorite okvir za dija-log Go To iz menija Edit (pritisnite F5), priti5-nete dugme Special, a zatim izaberete opciju Current Region.

Kombinacije tastera za izbor grupe ćelija

Tasteri
Biraju

· Ctrl+razmaknica- celu kolonu

· Shift+razmaknica- ceo red

· Ctrl+Shift+razmaknica- ceo radni list

· End, Shift+tasteri sa strelicama- proširuju izbor do kraja bloka podataka

· End, Shift+Home- proširuju izbor do donjeg desnog ugla radnog lista

· End, Shift+Rnter- proširuju izbor do poslednje c'elije u tekućem redu

· Ctrl+Shift+* (zvezdica)- tekuću oblast podataka

· F8, tasteri sa strelicama- isto kao kada držite Shift dok koristite tastere sa strelicama, izuzev sto je taster F8 preklopnik. Možete otpustiti taster F8 a zatim koristiti samo tastere sa strelicama. (Pritisnite F8 ili Esc da biste ga isključili).

1.4.10 Kopiranje i premeštanje celija

Postoje mnoge situacije kada je lakše kopirati sadržaj jedne ili više ćelija nego iznova ukucavati podatke, na primer, kada ćelija sadrži neku složenu formulu. Ćelije mogu da se kopiraju i premeštaju pomoću miša (tehnikom povlačenja i puštanja), ili pomoću komandi iz menija.

1.4.10.1 Premeštanje i kopiranje ćelija pomoću miša

Najlakši način za premeštanje ćelija je povlačenjem i puštanjem pomoću miša.

1. Izaberite ćelije koje želite da premestite (mora da bude skup susednih ćelija).

2. Postavite pokazivač miša na spoljašnji deo okvira izabranog skupa. Pokazivač miša postaje strelica.

3. Pritisnite taster miša, povucite ćelije na novo mesto, zatim pustite taster. Ćelije će biti premeštene na novo mesto.

upozorenje: U donjem desnom uglu izabranih ćelija nalazi se marker koji se zove ručica za popunu (engl. fill handle). Kada pokažete na ručicu za popunu, pokazivač miša postaje crni krstić. Kada povlačite mišem, pazite da slučajno ne upotrebite ručicu za popunu. 

Kopiranje pomoću miša izvodi se isto kao i premeštanje, ali se tokom procesa drži taster Ctrl. Strelica kursora dobija dodatni znak plus (+) da bi ukazala da je u pitanju kopiranje a ne premeštanje.

napomena: Mogućnost povlačenja i puštanja (engl. drag and drop) može da se uključuje i isključuje iz dijaloga komande Tools / Options, izborom kartice Edit i uključivanjem odnosno iskljucivanjem opcije Allow cell drag and drop.

1.4.10.2 Korišćenje priručnog menija za povlačenje i puštanje

Ukoliko držite desni taster miša dok povlačite ćelije, kada otpustite taster pojaviće se priručni meni (engl. shortcut menu).
Opisane su komande iz priručnog menija.

Move Here - Premešta ćelije na odredište

Copy Here- Kopira ćelije u odredisne ćelije

Copy Here as Values Only - Kopira samo vrednosti

Copy Here as Formats Only - Kopira samo formate

Link Here- Povezuje odredište sa kopiranim ćelijama

Create Hyperlink Here - Pravi hipervezu odredista sa kopiranim ćelijama

Shift Down and Copy - Umeće kopirane ćelije, pomera postojeće ćelije nadole

Shift Right and Copy - Umec'e kopirane ćelije, pomera postojeće ćelije nadesno

Shift Down and Move - Umeće premeštene ćelije, pomera postojeće ćelije nadole

Shift Right and Move- Umeće premeštene ćelije, pomera postojeće ćelije nadesno

1.4.10.3 Premeštanje ćelija pomoću komandi iz menija

Povlačenje mišem je efikasno kada se ćelije premeštaju na male udaljenosti. Komande iz menija (i prećice palete sa alatkama) mogu da se pokažu efikasnijim kada je ciljna ćelija (engl. target cell} udaljenija od izvorne ćelije (engl. source cell).

Evo kako se ćelije premeštaju pomoću komandi iz menija:

1. Izaberite ćeliju (ćelije) za premeštanje.

2. Izaberite komandu Edit / Cut ili pritisnite dugme Cut na paleti Standard.

3. Izaberite gornju levu ćeliju iz oblasti gde ćelije treba da budu postavljene.

4. Izaberite komandu Edit / Paste ili pritisnite dugme Paste na paleti Standard. 

Ćelije se premeštaju na novo mesto.

1.4.10.4 Kopiranje ćelija pomoću komandi iz menija

Povlačenje mišem je efikasno kada se ćelije kopiraju na male udaljenosti. Komande iz menija (i prećice palete sa alatkama) mogu da se pokažu efikasnijim kada je ciljna ćelija (engl. target cell} udaljenija od izvorne ćelije (engl. source cell).

Kopiranje ćelija komandama iz menija slično je premeštanju:

1. Izaberite ćelije za kopiranje.

2. Izaberite komandu Edit  / Copy ili pritisnite dugme Copy na paleti Standard.

3. Izaberite gornju levu ćeliju iz oblasti gde ćelije treba da budu postavljene.

4. Izaberite komandu Edit / Paste ili pritisnite dugme Paste. Celije se kopiraju na novo mesto.

1.4.11 Umetanje i brisanje ćelija

Kada napravite radni list može se ispostaviti da je potrebno umetnuti ili izbrisati ćelije kako bi se list prilagodio novim informacijama. Broj redova i kolona u radnom listu je fiksan - umetanjem ne nastaju nove ćelije, nego se postojeće pomeraju. Umetanje neće prouzrokovati da se podaci koji se nalaze na kraju radnog lista izgube. Na primer, ukoliko postoje podaci u ćeliji IV2 (drugi red poslednje kolone) i vi hoćete da umetnete kolonu, Excel prikazuje upozorenje i ne dopušta umetanje.

1.4.11.1 Umetanje ćelija

Da biste umetnuli ćeliju (ćelije) izaberite celije na mestu na kome je potrebno umetanje. To može da bude jedna ćelija, skup ćelija, celi redovi ili cele kolone. Ako izaberete dva reda, Excel će umetnuti dva reda itd. Ćelije možete umetnuti na sledeći način:

1. Pritisnite desni taster miša pokazujući selekciju pa iz priručnog menija izaberite Insert.

2. Iz menija Insert:

• izaberite komandu Rovvs za umetanje celih redova;

• ili, izaberite komandu Columns za umetanje celih kolona;

• ili, izaberite komandu Cells da umetnete skup ćelija. Prikazaće se okvir za dija-log Insert sa

1.4.12 Umetanje ćelija pomoću komandi iz menija

Da biste umetnuli isečene ili kopirane ćelije korišćenjem komandi iz menija, uradite sledeće:

1. Izaberite ćelije, zatim ih isecite ili iskopirajte.

2. Izaberite ćeliju na mestu gde treba da se umetnu nove.

3. Izaberite komandu (Copied Cells ili Cut Cells, iz menija Insert zavisno od operacije obavljene u prvom koraku.)

4. Pojavljuje se okvir za dijalog Insert Paste  koji omogućava da zadate kaku će se umetanje obaviti.

1.4.12.1 Umetanje pomoću miša

Da urnetnete isečene ili kopirane ćelije pomoću misa, ponovite isti postupak kao kada se celije premeštaju ili kopiraju pomoću miša (obradeno ranije u poglavlju), ali držite taster Shift dok povlačite ćelije, a Shift+Ctrl dok prevlačite kopiranje ćelije. Pojaviće se sivi marker za umetanje. Kombinacije tastera mogu da vas zbune dok kopirate.

1. Izaberite ćelije za premeštanje ili kopiranje.

2. Pokažite na ivicu skupa tako da pokazivač miša postane strelica. Pritisnite taster miša držeći pritisnut taster Shift i povucite ćelije na novo mesto. Videćete sivu liniju umetanja izmedu redova i kolona umesto okvira skupa.

3. Držite taster Shift+Ctrl dok povlačite ćelije.

1.4.12.2 Brisanje ćelija

Kada brišete jednu ili više ćelija komandom Delete, ćelije koje se nalaze ispod ili one koje su sa desne strane pomeriće se na mesto izbrisanih ćelija. (Za razliku od toga, brisanje sadržaja ćelija komandom Clear, naprotiv, ne izaziva takvo pomeranje.) Da biste obrisali ćeliju ili ćelije postupite ovako:

1. Izaberite ćelije koje želite da obrišete. To može da bude jedna ćelija, skup ćelija, celi redovi ili cele kolone.

2. Izaberite komandu Edit > Delete:

• ako izaberete ceo red ili kolonu, red ili kolona brišu se odmah;

• ako ste izabiali jednu ili više ćelija prikazuje se dijalog Delete (slika dole), koji omogucava da odredite šta treba da bude obrisano.

1.4.12.3 Promena visine reda i širine kolone

Kada ćelija sadrži veliku količinu podataka treba povećati sirinu ili visinu reda da bi podaci biti čitljiviji. U nekim situacijama treba smanjiti širinu ili visinu reda. Kao i u mnogim drugirn slučajevima visinu reda i širinu kolone možete da izmenite na neko-liko naćina - komandama iz menija ili mišem.

1.4.13 Razlika između brisanja ćelije i brisanja sadržaja ćelije

Novi korisnici obično ne znaju razliku između brisanja sadržaja ćelije (komanda Clear) i brisanja ćelije (komanda Delete). Brisanje sadržaja ćelije znaci ostaviti čeliju bez sadržaja (ili formatiranja, ili beleški). Ono ne utiče na strukturu radnog lista. Brisanje celije uklanja ćeliju iz radnog lista, kao kada biste izvadili jednu ciglu iz zida; ali za razliku od zida, u rad-nom listu ne ostaje rupa. Ćelije ispod ili sa desne strane obrisane ćelije se pomeraju i popunjavaju prazninu. Zabuna se produbljuje činjenicom da taster Delete ne brise ćeliju -on brise samo sadržaj ćelije.

• Da biste obrisali izabrane ćelije iz radnog lista, izaberite Edit > Delete.

• Da biste obrisali sadržaj ćelije, izaberite Edit / Clear ili pritisnite taster Delete. Nemojte praviti grešku i upisati razmak u ćeliju da biste obrisali sadržaj ćelije - Excel razmak smatra znakom, bez obzira što ga vi ne vidite; zato čelija nije prazna. To može da stvori probleme koji se tesko otkrivaju u radu sa funkcijama radnog lista i komandama baze podataka.

1.4.14 Zadavanje širine kolone

Da biste podesili širinu kolona ponioću komandi iz menija izaberite bilo koju ćeliju ili ćelije u koloni kojoj želite da promenite dimenzije. Zatim izaberite komandu Format > Column. Pojavljuje se podmeni kao na sledećoj slici:

Objašnjenje komandi iz podmenija Format  / Column.

· Width - Prikazuje dijalog koji pita za širinu kolone

· AutoFit Selection- Dimenzioniše kolonu (kolone) prema najširem ulaznom podatku sadržanom u ćelijama unutar izabranog skupa

· Hide - Uklanja izabranu kolonu (kolone) iz vidnog polja

· Unhide - Otkriva sakrivene kolone

· Standard Width- Postavlja širinu kolone na standardnu vrednost

Ako želite da promenite širinu kolone pomoću miša:

1. Pokažite na liniju izmedu slovnih oznaka kolona. Pokazivač miša postaje dvosmerna strelica.

2. Povlačenjem miša promenite širinu kolone. (Dok povlačite, prikazaće se nova širina u polju za ime.)

savet: Mišem možete da promenite širinu nekoliko kolona u isto vreme. Izaberite kolone kojima želite da promenite širinu (za nesusedne kolone držite taster Ctrl) i povucite okvir bilo koje od izabranih kolona.

1.4.14.1 Promena širine kolone po meri podataka

Miš može da se upotrebi za brzo izvrsavanje iste funkcije koju obavlja i 

komanda Format / Column / AutoFit. Sa dva pritiska na taster misa izaberite liniju između zaglavlja kolona. Kolona će dobiti širinu prema najširoj vrednosti koja se u njoj nalazi.

Na slićan naćin možete da upotrebite miša umesto komande Format / Row / AutoFit. Sa dva pritiska na taster miša izaberite donju liniju izmedu zaglavlja redova. Red će dobiti visinu prema najvišoj vrednosti koja se u njemu nalazi.

savet: Kada u c'eliji koja sadrži broj ugledate #####, znači da je kolona previše uska da bi se broj prikazao. Upotrebite gore opisanu tehniku (izaberite liniju izmedu zaglavlja) da koloni odmah date dimenzije u koje se uklapaju sve vrednosti.

1.4.14.2 Visina reda

Visina reda menja se na isti način kao širina kolone, s tim što redovi automatski menjaju visinu zavisno od promene veličine fonta ili teksta prenetog u nov red. 

Izaberite red ili ćeliju iz reda, a zatim odgovarajuće komande Format > Row da zadate visinu, ili sakrijete/otkrijete redove. Komanda AutoFit za redove zasnovana je na najvećem fontu i tekstu koji je prenet u nov red.

savet: Mišem možete prikazati i skriveni red ili kolonu. Da biste ponovo prikazali skrivenu kolonu postavite pokazivač desno od zaglavlja kolone koja je sakrivena tako da se pokazivač pretvori u dvosmernu strelicu sa dve paralelne crte po sredini (razlikuje se od pokazivača koji ima oblik dvosmerne strelice sa punom linijom po sredini koji se obično vidi između zaglavlja kolona). Pomerite taj pokazivač udesno da prikažete skrivenu kolonu. Ako je u pitanju skriveni red postavite pokazivač neposredno ispod zaglavlja gde je skriveni red (tako da se pretvori u dvosmernu strelicu sa dve paralelne crte) i povucite nadole.

1.4.15 Pretraživanje i zamena

Komande Edit / Find i Edit / Replace koriste se za pretraživanje radnog lista po zadatim vrednostima da bi se, po potrebi, zamenile. 

1.4.15.1 Pronalaženje vrednosti

Da biste pronašli vrednost na aktivnom radnom listu, uradite sledeće:

1. Izaberite komandu Edit > Find. Pojavljuje se dijalog Find 

2. Znakove koje želite da pronadete unesite u polje Find what.

3. Pritisnite Find Next da pronadete sledeću ćeliju koja sadrži traženu vrednost. Ako treba da suzite opseg pretraživanja nastavite prateći sledeće korake:

4. U polju liste Look In zadajete gde treba da se obavi pretraživanje:

• Value: pretražuje vrednosti iz ćelija;

• Formula: pretražuje formule;

• Coniments: pretražuje komentare iz ćelija.

5. Odredite redosled pretraživanja redova ili kolona pomoću liste .Search.

6. Aktiviranje opcije Match case ograničiće pretraživanje na tekst koji potpuno odgovara unosima u polje Find what po malim i velikim slovima (na primer, ukoliko tražite reč Račun, biće zanemaren unos račiin).

7. Uključivanje opcije Find entire cells onlv ograničiće pretraživanje samo na tačan pojam. Na primer, ukoliko tražite reč Vlada, u pretraživanju ćete dobiti i Vladan i Vladanko, ali sa uključenom opcijom Find entire cells only, dobićete samo Vlada.

Zamena vrednosti
Opcija Replace pronalazi zadatu vrednost kao i Find, ali dozvoljava da se pronadeni iskaz zameni drugim. Pokušajte da uradite sledeće:

1. Unesite sledeći tekst u prazan radni list:

2. Izaberite Edit > Replace da prikažete dijalog Replace 

3. Unesite Siniić u polje Find what.

4. Unesite Perić u polje Replace with.

5. Izaberite Replace All da zamenite sve slučajeveSiffiic'sa Perić.

1.4.15.2 Definisanje oblasti pretraživanja

Možete da pretražujete ceo radni list, skup ćelija ili više radnih listova u okviru radne sveske. Pre nego sto izaberete komandu za uredivanje ili zainenu:

• izaberite samo jednu ćeliju da pretražite ceo list;

• ili, izaberite skup ćelija da pretražite skup ćelija;

• ili, izaberite više listova da pretražite više listova .

1.4.15.3 Korišćenje džokera

U pretraživanju teksta kao džokeri mogu da se upotrebe znak pitanja (?) i zvezdica (*).

• Zvezdica predstavlja jedan ili više znakova - traganje za A*Z pronaći ćeABZ i ABCZ.

• Znak pitanja predstavlja jedan znak - traganje za A?Z pronaći ćeABZ i ACZ, ali ne ABCZ.

savet: Ukoliko želite da tražite znak pitanja ili zvezdicu, ispred znakova stavite tildu ( ). Na primer, da pronađete znakovni niz QUIT?, a da ne uzmete u obzir QUITO, kao znakovni niz za pretraživanje unesite 

QUIT-?.

1.4.16 Korišcenje formula i funkcija

Radni list je dobar onoliko koliko i ope-racije koje možete da obavite sa njim. Excel svojim korisnicima nudi obilje opcija za grafičko predstavljanje i izračunavanje podataka u radnim listovima. U ovom poglavlju bavićemo se nekim od najvažnijih tema za nove korisnike Excela. Naučićete kako da koristite ret'erence ćelija, spoljne reference i veze izm@dy datoteka, a otkrićete i kako da koristite funkcije da biste pisali formule. Takode ćete naučiti kako se na formule primenjuju složeni uslovi i kako se obavljaju istovremena izraćunavanja na više radnih listova.

1.4.16.1 Izraćunavanje pomoću formula

U ovom poglavlju biće objašnjeno kako se vrše izračunavanja pomoćufonnula. Formule su moćno sredstvo kada se u Excelu rade analize i modelovanje - pravljenje funkcionalnih sistema radnih tabela. Omogućavaju obavljanje velikog broja različitih numeričkih operacija, uključujući sabiranje, oduzimanje, množenje i deljenje. Takode omogućavaju uredivanje teksta i pregledanje tabela. Unošenje jednog broja u jednu ćeliju pri upotrebi formula može da izazove čitav niz promena u složenom modelu.

Formula je u suštini niz vrednosti i operatora koji počinje znakom jednakosti (=) i kao rezultat daje novu vrednost. Excel raspolaže sa nekoloko stotina ugrađenih formula zvanih funkcije, koje su napravljene da obavljaju razne vrste izračunavanja. Funkcija SUM je zgodna za demonstriranje rada formula i lako se unosi pomoću alatke AutoSum sa palete Standard.

Formule u Excelu imaju neke zajedničke osobine:

• Sve formule počinju znakom jednakosti (=).

• Po unošenju formule, u ćeliji se prikazuje reznltat.

• Kada izaberete ćeliju sa formulom, formula se vidi na liniji za formule.

1.4.16.2 Korišćenje alatke AutoSum

Funkcija SUM je funkcija koja se verovatno najčešće koristi, a alatka AutoSum olakšava njeno unošenje. 

1. Unesite sledeće podatke u prazan radni list:
2. Izaberite ćeliju A5.

3. Mišem izaberite alatku AutoSum sa palete Standard.

4. Pritisnite Enter  (ili mišem pritisnite dugme Enter u liniji za formule).

Excel pogada koje ćelije želite da saberete ispitujući susedne ćelije - formula u ćeliji A5 sabira ćelije A1:A4 Važno je proveriti da li je Excel dobro pogodio - naročito ako su izabrane i suvišne prazne ćelije. Imajte na umu da u slučaju kada Excel ne može pouzdano da utvrdi treba li sumirati kolonu ili red, AutoSum podra-zumeva kolonu.

AutoSum se ne koristi samo za pojedinačne ćelije. Pretpostavimo da se brojevi nalaze u ćelijama A1:C3. Ako izaberete A4:C4 pa pritisnete AutoSum, formule za sumiranje biće unesene za sve tri kolone.

savet: Zbirove svih kolona neke tabele možete uneti jednim pritiskom miša. Izaberite tabelu tako što ćete izabrati jednu njenu ćeliju pa pritisnuti Ctrl+Shift+*. Zatim pritisnite alatku AutoSum.

1.4.16.3 Ručno unošenje formule

Za unošenje formule jednostavno izaberite ćeliju u koju hoćete da je unesete i počnite sa kucanjem. Prvi znak mora biti znak jednakosti kao sto ćete videti u ovom kratkom primeru:

1. Izaberite ćeliju Al na praznom radnom listu.

2. Upišite =1+2 i pritisnite Enter. U ćeliji se pojavljuje rezultat 3.

Ova jednostavna formula koristi samo konstantne vrednosti (1 i 2); umesto formule u ćeliju možete uneti i vrednost 3. Medutim, uskoro ćete videti pravu snagu formula kada naučite kako da ih koristite ne navodeći u njima konstantne vrednosti nego reference ćelija.

1.4.17 Uređivanje formula

Formule se ureduju na sličan način kao brojevi i tekst . Možete da  upotrebite liniju za formule ili da uređujete neposredno u ćeliji. Kada pritisnete dvaput taster miša pokazujući na ćeliju koja sadrži formulu, formula će se prikazati u ćeliji, ali se dešava još nešto. Excel ističe izvorne ćelije formule obojenim ivicama; to su bojom kodovani skupovi ćelija. Povlačenjem obojenih ivica, možete uredivati ili premeštati ćelije u formuli a ručicom za popunu možete upravljati skupljanjem ili proširivanjem izvornih ćelija. Na izvestan način obojena područja ćelija ponašaju se kao izabrane ćelije ali manipulišu elementima formule. 

savet: Hoćete li da vidite odjednom sve formule u radnom listu, umesto da ih gledate jednu po jednu u liniji za formule? Pritisnite Ctrl+'(Ctrl plus akcenat grave koji se obično nalazi levo od znaka uzvika) da pređete sa prikaza formula na prikaz vrednosti, i obratno. Ovo je naročito korisno kada želite da saznate koje ćelije sadrže formule ili kada treba da dokumentujete formule korišćene u radnom listu.

1.4.17.1 Formatiranje formula sa prelomom reda radi bolje čitljivosti

Dugačke  formule se često teško dešifruju. Pretpostavimo da imate dugačku formulu koja jednostavno ne može da se skrati - kako olakšati njeno čitanje? U formulu možete umetnuti znake za prelom reda. Evo jedne dugačke formule:

=(A1 +A2)*5-(A3+A4)/12-A5+2

Sa prelomom reda izgleda ovako:

=(A1 +A2)*5

-(A3+A4)/12

-A5+2

Prelom reda se u formulu unosi pritiskom na Alt+Enter.

1.4.17.2 Aritmetički operatori u formulama

Standardne operacije sa podacima

=1+1
sabira l i 1

=10-5
oduzima 5 od 10

=4/2
deli 4 sa 2

=2*2+10
množi 2 sa 2 i sabira sa 10

=3^2
kvadrira broj 3

=435,67*10%
nalazi 10% broja 435,67

1.4.17.3 Redosled izračunavanja

Formule često sadrže više od jednog operatora. Excel izvodi izračunavanja posebnim redosledom o kojem morate voditi računa kada unosite ili uređujete formule. Množenje je starija računska radnja od sabiranja; zato, formula

"1+2*5

daje rezultat 11 (1 plus rezultat množenja 2 i 5), a ne 15 (zbir 1 plus 2, što čini 3, puta 5).

Kada imamo više operatora istog prioriteta, izračunavanje se vrši sleva nadesno. Na primer, pošto su množenje i deljenje raćunske radnje istog prioriteta, formula

"10/5*2 daje rezultat 4 (10/5 puta 2), a ne 1 (10 podeljeno sa 5*2).

1.4.17.4 Promena redosleda računskih radnji

U formuli se matematički izrazi grupišu pomoću zagrada. Računska radnja matematičkog izraza u zagradi starija je od ostalih računskih radnji.

=1+2*3      daje rezultat 7 

=(1+2)*3     daje rezultat 9

1.4.17.5 Spajanje teksta

Znak & (ampersand) spaja tekstove - postupak koji nazivamo povezivanje u niz ili nadovezivanje. Na primer, ako spojiteABC sa XYZ dobićete ABCDXYZ. Uzmimo recimo radni list u funkciji profakture: neka je u ćeliji DIO na dnu profakture ukupan znos od 500 USD a vi hoćete da umesto gole cifre piše ,,Ukupna vrednost iznosi 500 USD". Dovoljno je da na dnu radnog lista unesete formulu koja nadovezuje tekst na viednost u ćeliji DIO:

-"Ukupna vrednost iznosi "&D10&" USO" Rezultat je

Ukupna vrednost iznosi 500 USD

Isti rezultat može se dobiti funkcijom CONCATENATE mada većina korisnika radije koristi operator & jer se tako manje kuca. 

1.4.17.6 Kada formule kao rezultat daju grešku

Kada postoji problem sa formulom, rezultat je greška. Jedna od najčešćih grešaka nas-taje kada pokušate deljenje nulom. Unesite formulu=l/0u ćeliju. Rezultat je greška #DIV/0!. U tabeli 4.3 objašnjene su različite greške koje mogu da nastanu iz pogrešne formule.

1.4.18 Šta su kružne reference 

Pretpostavimo da ste u ćeliju A1 uneli formulu =B1 +C1. Pritisnete Enter, i na vaše iznenađenje dobijate upozorenje ,,Cannot resolve circular references" (kružne reference se ne mogu rešavati). 

Kružna referenca (engl. circular refe-rence) je ona koja referencira samu sebe, direktno ili indirektno. To je formula koja zavisi od sopstvene vrednosti. Pošto na upozorenje odgovorite pritiskom na dugme OK (a drugo vam ne preostaje), pogledajte statusnu liniju. Na njoj pise na primer Circular:A1, što znači da je ćelija A1 sa kružnom referencom tj. jedna od ćelija u formuli sadrži formulu koja zavisi od vrednosti u ćeliji A1.

Kružne reference se obicno stvaraju greškom, a rešavaju se izmenom formule. Ponekad su tu namerno jer služe nečemu, a Excel ih može rešavati ako u izračunavanje uvrstite iteracije, odnosno ponavljanje izračunavanja. Da biste uključili iteracije, izaberite Tools >-Options. Zatim izaberite karticu Calculation i potvrdite polje Iterations. Podrazumeva se da

Excel dozvoljava 100 iteradja. To znači da 100 puta ponavlja izračunavanje formula, pribli-žavajući se tačnom rezultatu sa svakim pro-računom. Takvo odvijanje procesa izraču-navanja se zove konvergendjfi. Excel prati koliko se vrednost menja sa svakom iteraci-jom, a kada se veličine promene svede na vrednost zadatu  parametrom  Maidmum Change (ili se dostigne maksirrialan broj iteracija) Excel zaustavlja konvergiranje.

Vrednosti parametara Maximum Iterations i Maximum Change menjaju se u okviru za dijalog Tools / /Options / Calculation. Izračunavanje se ubrzava zadavanjem manjeg broja iteracija ili veće vrednosti za Maximum Change, ili se mogu dobiti preciznija resenja zadavanjem vise iteracija i manje vrednosti za Maximum Change. Pri zadavanju iteracija opciju Calculation treba postaviti na Manual, jer će Excel inače izračunavati kružnu refe-rencu sa svakim novim unosom u ćeiiju. Iteracije i konvergencija su metodi kojim Solver i Goal Seek rešavaju probleme. 

1.4.19 Zamrzavanje vrednosti

U nekim situacijama potrebno je da ,,zamrznete" izveštaj tako što ćete formule zameniti vrednostima. Na primer, treba da štampate izveštaj koji se dostavlja i drugim Ijudima u vašoj organizaciji. Kasnije može da vam zatreba da pogledate šta je bilo u originalnom izveštaju - formulama se izveštaj lako menja. Postupak zamrzavanja ćelija je sledeći:

1. Izaberite ćeliju ili ćelije koje želite da zamrznete.

2. Izaberite komandu Edit / Copy.

3. Izaberite komandu Edit / Paste Special.

4. Izaberite opciju Values iz dijaloga Paste Special, zatim pritisnite OK.

Sve formule u izabranim ćelijama biće zamenjene konstantnim vrednostima.

1.4.20 Reference ćelija

Referenca čelije je adresa ćelije i može da se odnosi ili na apsolutnu lokaciju ćelije na nekom radnom listu (na primer Sheetl!$B$2) ili na relativnu lokaciju u odnosu na neku drugu ćeliju. Svaki od primera formula koje smo do sada prikazali u ovom poglavlju sadrži tekst i numeričke konstante. Ali, formula koja sadrži samo konstante nije naročito korisna. Da biste funkcije bolje iskoristili, pomoću referenci u tbrmule možete da ugradite promenljive; koristeći reference ćelija možete da menjate rezultate

formula u zavisnosti od vrednosti koje postavite u referencirane ćelije, kao što pokazuju sleded primeri:

=A1*2      množi sa 2 vrednost u ćeliji Al 

=A1*B1     množi vrednost iz ćelije Al vrednošću iz ćelije Bl 

="ABC"&A1 povezuje u niz znakove ABC i vrednost iz ćelije Al 

=A1&B1     povezuje u niz vrednost iz ćelije Al i vrednost iz ćelije Bl 

Probajte ovu jednostavnu vežbu na praznom radnom listu:

1. Unesite broj 2 u ćeliju Al.

2. Unesite broj 4 u ćeliju A2.

3. Unesite formulu =A1+A2 u ćeliju A3 (rezultat je 6).

4. Promenite vrednost u Al i posmatrajte kako se automatski menja vrednost u A3 (u 12).

Upravo ste videli jednu od osnovnih odlika programa za tabelarno izračunavanje - automatsko preračunavanje formula pri promeni vrednosti u ćelijama. Kada vaše potrebe prevaziđu nivo jednostavnih izračunavanja veoma je važno da dobro upoznate reference ćelija.

napomena: Ćelija koja se poziva na drugu ćeliju naziva se zavisnom ćelijom (engl. dependent cell) jer njen sadržaj zavisi od vrednosti neke druge ćelije. Ćelija na koju se poziva druga ćelija naziva se matičnom ćelijom (engl. precedent cell).

1.4.21 Stilovi referenci u Excelu

U Excelu postoje dva stila referenci ćelije:

Stil Al: Ovo je Excelov standard. Kolone su označene slovima od A do [V, što znači da ih ukupno može biti 256. Redovi su označeni brojevima od 1 do 65536.

Stil R1C1: 1 redovi i kolone označeni su brojevima. Na primer R3C2 u ovom sistemu je isto što i B3 u prethodnom sistemu.

Reference stila Al su de facto standard za skoro sve programe za tabelarno izračunavanje, uključujući i Excel. Nema naročitog razloga da se radi sa oba stila, a uključivanje oba u priručnike za Excel samo bi dalje komplikovalo već dovoljno složenu materiju. Ova knjiga se bavi isključivo stilom Al. Kada shvatite Al, lako ćete razurneti i RlCl.

1.4.22 Razlikovanje vrsta referend

Upoznali smo dva stila reterenci - Al i RlCl. Bez obzira koji stil koristite, postoje i tri vrste reterenci ćelija. Reference ćelija mogu biti relatime, apsolutne ili kombinovane. Da bismo ih objasnili upotrebićemo analogiju sa kućnom adresom da bisnio pokazali kako se različite vrste referenci odnose na istu kuću:

Apsolutna referenca: Odnosi se na određenu ćeliju ili ćelije. Isto kao kućna adresa, recimo Takovska 10.

Relativna referenca: Odnosi se na ćeliju ili ćelije koje su u nekom odnosu sa datom pozicijom, recimo ,,idite jednu ulicu niže i dve zgrade levo".

Kombinovana referenca: Jedna od koordinata je apsolutna a druga relativna:

,,Skrenite u Takovsku. Gospodin Zorić stanuje tri zgrade niže".

napomena: Excel podržava trodimenzionalne reference ćelija koje se koriste u kombinaciji sa funkdjama. 3-D reference se koriste kada se radi sa više listova radne sveske.

1.4.22.1 Apsolutne reference

Znak za dolar ispred koordinate ćelije označava apsolutnu referencu.

$A$1 je apsolutna referenca ćelije Al. SBS2 je apsolutna referenca ćelije B2.

Apsolutna referenca se ne menja kada je kopirate u drugu ćeliju, što pokazuje sledeća vežba:

1. Unesite =SAS1 u ćeliju Bl.

2. Kopirajte i prenesite ćeliju Bl u B2.

Formula u ćeliji B2 je nepromenjena; još uvek glasi =$A$1.

1.4.22.2 Relativne reference

Stilom Al relativne reference se označavaju slovom kolone i brojem reda kao recimo B13 ili C34. Relativne reference se koriste da ukažu na ćelije koje suu nekom odnosu sa čelijom koja sadrži fonnulu. Formula =A1 uneta u ćeliju Bl u stvari znači ,,sadržaj ove ćelije jednak je sadržaju ćelije koja je sada prva sa leve strane" (Al je jedno mesto levo od Bl). Dalje, pošto formula koristi relativnu referencu, referenca se automatski podešava kada se ćelija kopira na drugo mesto.

Probajte sledeći primer:

1. Unesite =A1 u ćeliju Bl. Na taj način cclija Bl dobija isti sadržaj kao njena susedna ćelija Al (prva sa leve strane).

2. Kopirajte i prenesite ćeliju Bl u B2.

Formula u ćeliji B2 se automatski menja; Excel je izvršio podešavanje tako da ona sada glasi: =A2 čime ćelija B2 ponovo dobija isti sadržaj kao njena susedna ćelija sa leve strane (u ovom slučaju ćelija A2).

napomena: Za razliku od kopiranja i prenošenja (engl. copy/paste), ako isečete i prenesete 1 (engl. cut/paste) ćeliju sa relativnjm referencama, reference se neće promeniti.

1.4.23 Upotreba apsolutne i relativne reference?

Sledeći primer ilustruje razliku izmedu apsolutnih i relativnih referenci. Unesite konstante u prazan radni list:

Kako ne treba raditi Evo jednog načina za unošenje vrednosti, ali ne baš najboljeg:

1. Unesite formulu =SBSS*SC$5 (apsolutne reference) u ćeliju D5.

2. Kopirajte formulu D5 u ćelije D6 i D7.

Pošto su upotrebljene apsolutne reference, u celije D6 i D7 greškom se prenose (pomnožene) brojke iz reda 5, što nismo želeli.

Kako treba raditi Evo mnogo boljeg načina za unošenje podataka:

1. Unesite formulu =B5*C5 (relativne reference) u ćeliju D5.

2. Kopirajte formulu iz D5 u ćelije D6 i D7. Još bolje je da ručicom za popunu povučete formulu.

Pošto D5 sadrži relativne reference, Excel pri kopiranju automatski podešava refe-rence i proizvodi su sada ispravni.

Sada ćemo jednačini dodati jednu apsolutnu reterencu. Pretpostavimo da se popust u ćeliji C2 (slika 4.1) odnosi na svaki red:

1. Unesite formulu =(B5*C5)-((BS*C5)*SC$2) u ćeliju D5. Formula znači:

,,Sadržaj ove ćelije jednak je svega - Popust". Obratite pažnju da ćelija $C$2 ima apsolutnu referencu.

2. Kopirajte formulu u ćelije D6 i D7. Excel če prilagoditi relativne reference, ali ne dira apsolutnu referencu.

napomena: Formula u tački 1 ima dodatne zagrade koje se koriste radi lakše čitljivosti. Ove zagrade ne utiču na redosled računskih radnji.

1.4.24 Kombinovane reference

Upoznali ste apsolutne reference (sa znakom za dolar ispred koordinate) i relativne reference (bez dolarskog znaka). Kombinovana referenca ima jednu apsolutnu koordi-natu i jednu relativnu koordinatu. A$l i $A1 primeri su kombinovanih referenci. Koordinate sa znakom dolara su apsolutne a koordinate bez znaka dolara, relativne. Na primer, $A1 se odnosi na apsolutnu kolonu (A) i relativni red (1). Primera radi unesite sledeće konstante u prazan radni list:

savet: Umesto da stalno kucate i brišete znak dolara da biste promenili vrstu reference, dovoljno je da postavite kursor bilo gde unutar reference i pritiskate taster F4 kojim se ciklično prebacujete na sve vrste referenci redom.
U ovom primeru vozarina za međunarodni i domaći transport izračunava se na osnovu vozarine po komadu iz kolone B. Za izračunavanje vozarine potrebne su for-mule u kolonama D i F. Problem je moguće rešiti na dva načina.

Manje delotvoran način
1. Unesite formulu =B4*C4 u ćeliju D4 i kopirajte je u ćelije od D5 do D7.

2. Unesite formulu =B4*E4 u ćeliju F4 i kopirajte je u ćelije od F5 do F7. (Bi'to bi pogrešno kopirati formulu iz D4 u kolonu F zbog upotrebe isključivo relativnih referenci.)

Mada je rezultat tačan, postoji i brži način. Ista formula može da se koristi u kolonama D i F upotrebom kombinovane reference. Zbog jednostavnosti primera ovo možda izgleda kao neznatna ušteda vremena i energije. Uvek kada možete da se izvučete upotrebom iste formule oslobod'ićete se brige i uštedećete vreme, naročito ako na jednom unetu formulu morate da se vratite radi izmena.

Delotvorniji način
1. Unesite formulu =SB4*C4 u ćeliju D4. SB4 je kombinovana referenca - prva koordinata je apsolutna, a druga relativna. Kopirajte D4 u ćelije D5 do D7.

2. Kopirajte D4 u ćelije od F4 do F7.

Proverite formule u kolonama D i F posle kopiranja. Excel je prilagodio relativni deo; apsolutni deo je ostao nepromenjen.

savet: Reference se u velikoj meri pojednostavljuju upotrebom imena. Imena doprinose jasnosti: na primer, formula koja glasi =Prodaja-Troškovi mnogo je razumljivija od formule =$B$25-$B$47. Dodeljivanje imena obrađeno je u poglavlju 8.

1.4.25 Pozivanje na više ćelija

U svim dosadašnjiin primerima refercnce su se odnosile na pojedinaaie čelije. Ret'e-renca ćelije može takođe da se odnosi miskup ćeliji.i. U reterenci At:A3, početna ćelija je Al, dve tačke znače ,,do", a A3 je završna ćelija. Pozivanja na skupove c'elija imaće veći značaj kada počnete da radite sa formulama dalje u ovom poglavlju. U međuvremenu, dajemo jednostavan primer:

1. Pritisnite F5 (prečica za Edit >- Go To).

2. Unesite A1:A3 kao referencu, pa izaberite OK. Biće izabran skup ćelija Al do A3.

1.4.25.1 Unošenje referenci ćelija mišem

Nije neophodno da reference ćelija upisujete kada unosite ili uređujete formule. Refe-rence se mogu uneti u formule i pomoću miša. Evo jednog primera:

1. Unesite brojeve u ćelije Al i A2 praznog radnog lista.

2. Izaberite ćeliju A3. Upišite znak jednakosti za početak formule.

3. Mišem izaberite ćeliju Al. Na liniji za formule videćete da je referenca ćelije Al dodata formuli.

4. Upišite znak plus.

5. Mišem izaberite ćeliju A2 da je dodate formuli.

6. Pritisnite J da dovršite tbrmulu, čime će ćelije Al i A2 biti sabrane.

1.4.25.2 Pozivanje na druge radne listove u okviru iste radne sveske

U svim dosadašnjim primerima reference su se odnosile na ćelije u istom radnom listu. Isto tako možete da se pozivate na ćelije iz drugih radnih listova. Vratimo se na analogiju sa kućnom adresom. Umesto da kažete Takovskci ulica 10, morate da kažete Takovska ulica 10, Kragiijevac, zbog toga što je adresa u drugom gradu. Isto važi za reference ćelija iz drugih radnih listova. Uradite sledeću vežbu u novoj radnoj svesci:

1. Unesite 10 u ćeliju Al na listu Sheetl.

2. Aktivirajte Sheet2 izborom njegovog jezička.

3. Unesite znak jednakosti u ćeliju Bl za početak formule.

4. Aktivirajte Sheetl izborom njegovog jezička - obratite pažnju da se formula još uvek upisuje.

5. Izaberite mišem ćeliju Al da je dodate formuli.

6. Pritisnite J da završite formulu.

7. Formula u čeliji Bl (na listu Sheet2) glasi =Sheetl!Al a u ćeliji će biti prikazan broj 10.

Obratite pažnju da ispred reference ćelije stoji ime lista i znak uzvika. (Znak uzvika razdvaja ime lista od reference ćelije.) Ne dozvolite da vas zbuni pozivanje na druge radne listove - to je u suštini isto kao i pozivanje na isti radni list. Primenjuju se ista pravila.

Ako u imenu radnog lista postoji razmak, ime mora da bnde izmedu jednostrukih navodnika kada se iz drugih radnih listova pozivate na taj radni list. Na primer:

=Plan  prodaje ' !B3
Medutim, ako se razmak doda imenu lista posle određivanja reference, Excel automatski stavlja jednostruke znakove navoda u zavisne ćelije.

1.4.25.3 Ćemu pozivanje na druge listove?

Pozivanje na ćelije iz drugih radnih listova je česta radnja. Radna sveska može da sadrži planove po sektorima, po jedan radni list za svaki od npr. četiri sektora. Peti list može da se upotrebi za zbirni plan. Zbirni radni list će se pozivati na ćelije iz svakog od četiri sektorska lista.

1.4.26 Spoljne reference:

1.4.26.1 Pozivanje na radni list u okviru druge radne sveske

Referenca na drugu radnu svesku naziva se spoljnom referencom (engl. extemal refe-rence). Ovoga puta adresa ne samo da se nalazi u drugom gradu, već i u drugoj državi. Logično, država mora da postane deo adrese. Uradite sledeću vežbu:

1. Otvorite dve nove radne sveske, Bookl i Book2. Rasporedite ih horizontalno pomoću komande Window > Arrange.

2. U ćeliju Al lista Sheetl sveske Bookl unesite Zdravo.

3. U ćeliju Bl lista Sheetl sveske Book2 unesite znak jednakosti za početak formule.

4. Aktivirajte svesku Bookl tako što ćete mišem izabrati bilo koju ćeliju unutar radne sveske.

5. Izaberite mišem ćeliju Al (Sheetl, Bookl) da je dodate formuli.

6. Pritisnite Enter da završite formulu.

7. Formula u ćeliji Bl (Sheetl, Book2) glasiće

= [Bookl]Sheet l !$A$ l 

i u ćeliji će se pojaviti Zdravo.

Referenca počinje imenom sveske u uglastim zagradama. (Podrazumeva se da je referenca apsolutna.)

1.4.27 Šta se dešava sa referencama pri premeštanju ćelija?

Pri premeštanju ćelija referencama mogu da se dogode razne stvari, zavisno od toga kako i kuda se ćelije premestaju.

Isti list: Kada se ćelija premešta na drugo mesto u istom radnom listu, ćelije koje se pozivaju na tu ćeliju (zavisne ćelije) ažuriraju se automatski tako da ukazuju na novu referencu celije, bez obzira na način na koji je ćelija premeštena. To važi čak i kada se zavisna ćelija nalazi u zavisnoj radnoj svesci - ali samo ako je zavisna radna sveska otvorena kada se ćelija premešta.

Različit list: Kada isečete i prenesete ćeliju u drugi radni list (u istoj Ui drugoj radnoj svesci), u zavisnim ćelijama pojavi se poruka greske #REF! (greška u referenci).

Zavisna ćelija: Kada se zavisna c'elija premesti ona i dalje pokazuje na istu ćeliju ili ćelije na koje je prvobitno pokazivala, bez obzira na način premeštanja. Ovo važi i kad je zavisna ćelija premeštena u drugi radni list ili radnu svesku.

Povezivanje datoteka pomoću spoljnih referenci

Kada se unese spoljna referenca izmedu datoteka se automatski stvara veza (eiigl.link). Veza se uvek gradi između dve radne sveske - zavisne radne sveske i izvorne radne sveske:

Zavisna radna sveska (engl. dependent workbook): Radna sveska koja sadrži spoljnu referencu i zato zavisi od druge radne sveske.

Izvorna radna sveska (engl. source workbook): Radna sveska koja sadrži izvorne ćelije na koje se poziva spoljna referenca.

Zavisna radna sveska je vezana za izvornu radnu svesku. Izvorna radna sveska nije vezana - ona uopšte nema inforrnaciju da je neka radna sveska vezana za nju.

1.4.28 Prednosti korišćenja veza

Povezane radne sveske se često koriste čak i u relativno jednostavnim modelirna. One imaju nekoliko ključnih prednosti nad korišćenjem više radnh listova u jednoj radnoj svesci:

• Više korisnika može da uređuje radne sveske u isto vreme. Na primer, rukovodilac zapadnog regiona može da ureduje ZAPAD dok direktor istočnog regiona uređuje ISTOK.

• Ne mora da se otvara odjednom ceo model, što ubrzava otvaranje, preračuna-vanje i čuvanje radnih svezaka. Isto tako može da se dogodi da veliki model iz jedne radne sveske ,,ne stane" u memoriju.

1.4.29 Reference stila R1C1

Već ste naucili da A1 znaci adresu ćelije, pri čemu slovo označava kolonu a broj označava red koje vidite i na radnom listu. R1 C1 je adresa ćelije u kojoj se i red i kolona oznaćavaju brojevima. Brojeve redova i kolona videćete na radnim listovima ako iz okvira za dijalog Tools / Options i kartice General iza-berete Reference Style as R1C1. Ako stil reference promenite preko okvira za dijalog

Tools / Options, sve reference stila A1 promeniće se u reference stila R1C1.

Kao i stil A1, R1C1 ima apsolutne i relativne reference. Apsolutna adresa ćelije R2C2 ekvivalentna je $B$2 - odnosi se na presek određenog reda i određene kolone. Relativne adrese ćelija definišu se u odnosu na ćeliju koja sadrži formulu, a ne na koordinate rad-nog lista. Na primer, relativna adresa R[-2]C[3] znaci ,,ćelija 2 reda iznad i 3 kolone desno". Pozitivni brojevi redova i kolona označavaju redove ispod i kolone nadesno. Negativni brojevi redova i kolona označavaju redove iznad i kolone nalevo. Referenca bez broja odnosi se na ,,ovaj red" ili ,,ovu kolonu".• Objedinjeni pregled može se dobiti povezivanjem radnih svezaka na više nivoa.

Mada se veza uvek odnosi na samo jednu radnu svesku, radna sveska može da bui povezana više puta, na mnogo načina:                         '<
• Jedna radna sveska može biti povezana sa više različitih izvornih radnih svezal

• Jedna izvorna radna sveska može imati više zavisnih radnih svezaka.

• Radna sveska A može da se poveže sa radnom sveskom B. Radna sveska B možt da se poveže sa radnom sveskom C. Drugim rečima, jedna radna sveska može i. bude i zavisna i izvorna sveska.

• Dve radne sveske mogu da se povežu i jedna sa drugom, pri čemu je svaka zavi sna od druge.

1.4.30 Prepoznavanje veznih putanja

Excel pamti celu putanju izvorne sveske, a kada se izvorna sveska zatvori, cela putan se pojavljuje kao spoljna referenca. Na primer, spoljna referenca izvorne sveske PRODAJA, smeštene u direktorijumu DATOTEKE na disku C, izgleda ovako:

Kada je izvorna radna sveska otvorena:

= [PRODAJA.XLS]Sheetl!$A$l Kada je izvorna radna sveska zatvorena:

-'C:\DATOTEKE\[PROOAJA.XLS]Sheetl'!$A$1

1.4.31 Promena veze

Jedan način za promenu veze je izmena formule koja sadrži spoljnu referencu. Ali, šta ako zavisna sveska sadrži desetine spoljnih referenci? Izaberite komandu Edit / Links  da se otvori dijalog Links.

Izaberite izvornu datoteku koju želite da izmenite, potom dugme Change Source da otvorite dijalog Change Links.

Dijalog Change Links izgleda i ponaša se slično dijalogu File / Open. Možete da se krećete kroz sistem datoteka da pronađete radnu svesku sa kojom želite da se pove-žete. Kada izaberete novu izvornu datoteku za povezivanje, automatski se menjaju sve spoljne reference. Pretpostavimo da ste zamenili izvornu datoteku PROIZVOD datotekom PLASMAN. Sve spoljne reference u zavisnoj svesci menjaju se automatski u PLASMAN.

1.4.32 Otvaranje zavisne radne sveske

U trenutku kada se otvara zavisna radna sveska, Excel se ponaša različito zavisno od toga da li je izvorna sveska otvorena ili zatvorena.

• Ako je izvorna sveska već otvorena, zavisna radna sveska se automatski preraču-nava (osim ako ste u režimu ručnog izračunavanja).

• Ako izvorna radna sveska nije otvorena Excel će prikazati sledeći dijalog. Pritis-nite Yes da ažurirate spoljne reference.

savet: Kada se preračunavaju formule koje se odnose na zatvorene radne sveske tekuće vred-nosti se uzimaju iz zatvorenih datoteka radnih svezaka a da se sveske ne otvaraju. Međutim, neke funkcije, kao što su OFFSET i VLOOKUP, ne rade kada je radna sveska zatvorena jer su suvise složene. 

1.4.32.1 Izbegavanje velikih datoteka radnih svezaka kada se koriste spoljne veze

lako se to ne vidi, zavisne radne sveske čuvaju i vrednosti sadržane u izvornim radnim sveskama (spoljne vrednosti). Na primer, ako se radna sveska A poziva na ćelije A1:A999 u svesci B, svih 999 vrednosti nalaziće se u svesci A. Ovo svojstvo ima jednu nepoželjnu manifestadju: ponekad na izgled mala radna sveska zauzima neobjašnjivo veliku količinu memorije. Radna sveska može da se podesi dane aiva spoljne vred-nosti. 

Izaberite komandu Tools / Options / karticu Calculation / Uklonite potvrdu sa opcije Save external link values . Medutim, tada će se izvorna radna sveska preračunavati kada se otvori jer bi u protivnom zavisne ćelije sadržale greške.

upozorenje: Povezivanje sa radnom sveskom koja nikada nije bila sačuvana nije dobra ideja;

ako zatvorite izvornu svesku, a ne sačuvate je, zavisna radna sveska je povezana sa nepostojećom sveskom. U principu, dobro je sačuvati izvorne sveske pre zavisnih.

1.4.33 Hiperveze

U Excelu postoje dve vrste hiperveza. Prve funkcionišu kao i hiperveze u HTML  dokumentima na Internetu (Web strane); kada pritisnete taster miša pokazujući na njih, skačete sa mesta na mesto. 

Druga vrsta hiperveze u Excelu je funkcija HYPERLINK. 

1.4.33.1 Izbegnite upozorenje o ažuriranju veza

Kada otvorite radnu svesku koja sadrži spoljne ili udaljene reference, pojaviće se upozorenje ,,This document contains links. Re-establish links?" (Ovaj dokument sadrži veze. Veze uspostaviti ponovo?). To upozorenje zbunjuje nove korisnike. Ako odgovorite ,,Yes", ažuriraće se sve veze u novootvorenoj radnoj svesci. Ako odgovorite ,,No", formule koje sadrže spoljne ili udaljene veze neće biti izračunate sa tekućim podacima.

Postoji nacin da se spreci pojava ovog upozorenja, kako bi se veze automatski ažurirale: 

Izaberite Tools / Options / karticu Edit / uklonite potvrdu iz polja Ask to update automatic links. To je globalni parametar i ne može da se postavi samo za jednu radnu svesku. Drugi način izbegavanja upozo-renja je otvaranje izvorne radne sveske pre otvaranja zavisne radne sveske.

1.4.33.2 Korišcenje funkcija radnog lista

Zamislite radni list koji u ćelijama od Al do A9 sadrži brojeve koji treba da se saberu. Mogli biste da unesete formulu:

"A1+A2+A3+A4+A5+A6+A7^A8+A9

Ovaj način je zamoran i kada sabirate samo devet ćelija, a postaje neprimenljiv ako treba sabrati nekoliko hiljada ćelija. Isti rezultat može se dobiti i upotrebom funkcije SUM:

-SUM(A1:A9)

Funkcija SUM je jedna od nekoliko stotina ugradenih funkcija. Ugrađene funkcije su ono što pri rukovanju tekstom i brojevima Excelu daje pravu moć. Bilo koja funkcija može da se koristi sama, kao funkdja SUM u gornjem primeru, ili kao deo složene formule.

Većini funkcija mora da se obezbedi jedan ili više podataka koji se nazivaju argumenti. Argumenti se stavljaju u zagrade iza imena funkdje, kao u primeru =SUM (A1:A9). Ako ima više argumenata oni se moraju razdvojiti zarezima (ili nekim drugim znakom definisanim u Windowsu). Funkciji ne prethodi znak jednakosti, izuzev ako se nalazi na početku formule.

1.4.33.3 Uparivanje zagrada u formulama

Kada učite da pišete formule (pa čak i kada se u tome izvežbate), ispravno uparivanje zagrada je priličan poduhvat, naročito u du-gačkim formulama. Ponekad Excel shvati šta želite i posao obavi sam. Na primer, u jed-nostavnim formulama kao sto su funkcije SUM i INDEX bez ugneždenih funkcija, zatvorene zagrade se mogu izostaviti. Kada pritisnete Enter, Excel dodaje zatvorenu zagradu automatski.

U složenijim formulama Excel ne zatvara zagrade umesto vas. Umesto toga, pojavljuje se upozorenje ,,Parantheses do not match" (Zagrade se ne podudaraju) i istice se neispravan deo formule. Kada upišete zatvorenu zagradu, nakratko se istice odgovarajuća otvorena zagrada.

Još korisniji je trik za pronalaženje parova svih zagrada u formuli: upotrebite tastere sa strelicama da se u formuli krećete od znaka do znaka. Svaki put kada dođete do zagrade, obe zagrade iz para biće nakratko istaknute.

1.4.34 Reference no obicnom jeziku

Reference na običnom jeziku (engl. Natural Language References) su ustvari reference koje koriste reči iz zaglavlja redova i kolona. Kada napravite tabelu, tekstualne oznake zaglavlja kolona i1i redova možete koristiti u formulama. U prethodnim verzijama Excela najpre ste morali da pravite imenovana područja ćelija , a korišćenjem referenci na običnom jeziku ta imena se formuaju automatski. Pogledajmo kako možete upotrebiti ovu novu mogućnost.

savet: Budite pažljivi kada u nekoj formuli pokušate da upotrebite oznaku koja je istovremeno i referenca c'elije. Na primer, ako ste sa Q1 oznacili neku kolonu pa pokušate da napišete for-mulu =Q1 Istok misleći na ćeliju koja se odnosi na presek kolone Q1 i reda Istok, Excel će potražiti ćeliju Q1 a ne kolonu označenu sa Q1.

1.4.35 Reference preseka reda i kolone

Pretpostavimo da imate tabelu planiranih sredstava sa kolonama označenim imenima meseci (Januar, Februar itd.) i redovima označenim kategorijom (Dostavnice, Pokloni itd.). Šta ako vam treba podatak o ko-ličini dostavljenih sredstava u rnartu i vrednosti poklona u oktobru? Postoji naročit način da se pozovete na ćeliju koja se nalazi u pre-seku datog reda i kolone (na primer Mart i Pokloni): koristite znak za razmak. Taj znak služi da označi presek. Na primer, formula =C:C 2:2 je zaobilazni način da ukažete na ćeliju C2 i u stvari se sastoji od sledećih delova:

C:C         Referenca kolone C 

Razmak     Operator preseka 

2:2         Referenca reda 2

Pošto referenca pomoću preseka ne zahteva obavezno upotrebu imena ili oznaka njena upotrebljivost se najbolje uočava kada se oni koriste. 
1.4.36 Podrazumevani presek

Oznake mogu da služe kao relativne reference ćelija. Na primer, koristeći radni list iz gornjeg primera upišite formulu =Istok+Zapad u ćelije E3, E4 i E5. Mada su Istok i Zapad skupovi ćelija, formule se tačno izračunavaju na osnovu vrednosti u istom redu. To je posledica podrazumevanog preseka. Upišite sada formlu =Istok+Zapad u celiju E6. Broj 0 se pojavljuje zato što ne postoje vrednosti u susednim ćelijama reda 6.

Kad pišete formule koristeći običan jezik Excel će ako imate više od jedne oznake sa istim imenom odabrati prvu koju nađe, obično gornju levu, ili će vam pomoću dijaloga Identify Label zatražiti da navedete koju oznaku želite da upotrebite:

Ponekad nije zgodno koristiti oznake u ćelijama sa formulama. Da biste isključili ovu mogućnost najpre izaberite Tools > Options pa karticu Calculation, a zatim uklonite potvrdu sa opcije Accept labels in formulas .

1.4.37 Preračunavanje radnog lista

Excel preračunava formule radnih listova kada to zahtevaju izmene vrednosti ćelija. Automatsko preračunavanje je verovatno najvažnije svojstvo programa za tabelarno izračunavanje, pa je značajno da naučite kako da upravljate njime. Da biste postavili režim izračunavanja, 

izaberite komandu Tools > Options, a zatim karticu Calculation 

1.4.38 Režimi preračunavanja

Režim preračunavanja je važan parametar za celu radnu površinu - to nije parametar radne sveske. Ovde su opisana tri raspoloživa načina preračunavanja:

1.4.38.1 Automatsko preračunavanje

Režim koji se podrazumeva. Odvija se kada se vrednost ćelije proineni a postoje t'ormule koje se pozivaju na izmenjenu celiju. Dok se vrši preračunavanje, na statusnoj liniji se pojavljuje poruka o procentu uradenog preračuna.

1.4.38.2 Automatsko preračunavanje isključujući tabele

Poseban režim koji preračunava sve osim tabela sa podacima. 

savet: Dok Excel obavlja preračunavanje rad može i dalje da se odvija, mada se preračunavanje zaustavlja dok vi radite.

1.4.38.3 Ručno preračunavanje 

Koristi za skracivanje vremena potrebnog za odgovor. Kada radite sa velikim modelom, poželjno je da se preračunavanje odloži dok se ne unesu svi podaci. Reč Calculate na statusnoj liniji podseća vas da sledi pre-računavanje. Pritisnite Calc Now (F9) da izvršite sva preračunavanja u isto vreme, ali da ostanete u ručnom režimu. Pritisnite dugme Calc Sheet ako hoćete da preračunavanje obuhvati samo aktivnu radnu svesku, a ne i celu radnu površinu.

1.4.38.4 Preciznost prema prikazanim vrednostima

Vrednost koja se vidi prikazana u ćeliji nije obavezno ista kao i prava vrednost uskla-dištena u ćeliji. Excel skladišti brojeve sa tačnošću do 15 brojnih mesta, dok ćelija može biti formatirana tako da, na primer, prikazuje samo dinare i pare. (Linija za for-mule uvek prikazuje pravu vrednost.) Razlike između formatiranih brojeva i pravih vrednosti ćelija mogu da dovedu do na izgled netačnih rezultata, što računovodama zadaje velike brige. Da biste uradili preračunavanje na osnovu formatiranih vrednosti ponovo odaberite Tools > Options, izaberite karticu Calculation pa potvrdite opciju Precision as displayed.

upozorenie: Ovaj parameter se odnosi na radnu svesku i čuva se zajedno sa radnom sveskom, za razliku od parametara automatskog i rucnog preračunavanja.

1.4.38.5 Proširivanje formule SUM da obuhvati umetnute redove

Pretpostavimo da imate vrednosti u ćelijama A1:A10 i formulu =SUM(A1:A10) u ćeliji All. Na kraj liste želite da dodate novu vrednost, pa zato umecete novi red na mestu reda 11 (odmah iznad funkcije SUM) i upisujete novu vrednosti u ćeliju A11. Medutim, skup vred-nosti za sabiranje ne sadrži novu vrednost. Kako ćete uvrstiti novu vrednost na kraj liste i automatski proširiti skup za sabiranje da je obuhvati? To ćete postići uz pomoć trikova.

Prvo, na kraju skupa možete ostaviti pra-zan red (u ovom slucaju red 11) i uvrstiti ga u formulu za sabiranje. Tada formula glasi =SUM(A1:A11). Zatim umećite red iznad praznog reda (reda 11) uvek kada je potrebno dodati vrednost, a skup za sabiranje će se automabki prilagoditi i obuhvatiti i novi red.

Drugi način je da upotrebite sledeću for-mulu da saberete skup koji uvek sadrži ćeliju iznad formule:

-SUM(prva_će1ija:INDEX(ko1ona :ko1ona,ROW()-l))

Argument prva_će1ija odnosi se na prvu ćeliju iz skupa za sabiranje (u ovom slučaju, ćeliju A1). Argument kolona:

kol ona odnosi se na kolonu koja se sabira (u ovom primeru, $A:$A). U tom slucaju formula u ćeliji All glasi =SUM( $A$1: INOEX( $A:   $A , ROM ( ) -1)) .  

1.5 Formatiranje radnih listova

Neki korisnici smatraju da je važan jedino sadržaj dokumenta. Ukoliko i vi imate isto mišljenje, znajte da je mnogo i onih koji ne misle kao vi. Kao korisnik grafički bogatog programa za tahelarno izračunavanje sigurno ste uvideli znaćaj lepog izgleda izvestaja. Prilično jednostavnim metodama formatiranja pored lepog izgleda postižu se brojna poboljšanja:

• Formatiranjem možete da istaknete značajne intormacije;

• jednostavnim postupcima formatiranja postiže se bolja ćitljivost izveštaja;

• Upotrebom stilova dobijaju se skladnost i ujednačen izgled.

• Uslovnim tbrmatiranjem istiću se intbrmacije koje su se promenile.

Ovim poglavljem obuhvaćeni su razni oblici tbrmatiranja. Osnovni postupak je uvek isti: izaberete ćelije koje želite da tbrmatirate a zatim komandu za formatiranje.

Excel 8 dodatno sadrži i izvestan broj novih mogućnosti formatiranja uključujući uslovno formatiranje, spajanje ćelija i poravnavanje teksta pod uglom, o kojima ćemo govoriti u ovom poglavlju.

1.5.1 Rad sa fontovima

Jedan od osnovnih načina da se poboljša izgled i upotrebljivost radnog lista je upotreba formatiranja fonta. Formatiranje fonta u Excelu obuhvata podešavanie ili izbor nekoliko karakteristika znakova kao što su:

• tipografsko pismo kao na primer Times New Roman, Arial i Courier

• veličina izražena u tačkama (engl. point)

• polucrni i/ili kurzivni lik

• boja

• podvlačenje

• specijalni efekti - precrtavanje (engl. strikethrough), stepenovanje (engl. snper-script) ili indeksiranje (engl. subscript)

Excel je pojednostavio stvari u gotovo svakom poslovnom okruženju sa svoje tri značajne nove mogućnosti formatiranja fontova:

• Korisnici koji se bave računovodstvom dobili su mogućnost podvlačenja koja je u skladu sa inače krutim računovodstvenim standardima.

• Naučnike i inženjere će obradovati mogućnost pisanja stepena i indeksa kao opšte opcije za font.

• Svi će biti zadovoljni što fontovi mogu da se primene i na pojedinačne znakove unutar ćelije.

1.5.2 Primena formata fontova

Primena formatiranja fonta je jednostavna. Kao i pri formatiranju ćelija, prvi korak je da se označi područje koje će da se formatira. [zaberite komandu Format»- Cells da dobijete dijalog Format Cells, zatim karticu Font. Izaberite one odlike fonta koje želite da primenite i pritisnite OK. Pogledaćemo koje su opcije na raspolaganju.

Font: Raspoloživi fontovi nisu spedjalitet Excela - lista sadrži sve fontove koji postoje u Windowsu ili su instalirani kasnije.

savet: Ako pokažete na označeno područje i pritisnete desni taster miša otvoriće se priručni meni sa komandom Format / Cells.

• Fontovi TrueType označeni su simbolom TT pored imena pisma - TrueType je tehnologija prilagodljivih fontova ugradena u Windows.

• Fontovi koji se mogu upotrebiti za trenutno izabran štampač označeni su simbolom štampača pored imena pisma.

Font Style (Stil fonta): Omogućava primenu kurziva i polucrnog slovnog lika. 

Size (Veličina): Veličina fonta se meri u tačkama. Jedan inč sadrži 72 tačke (meri se od najviše tačke slova b do najniže tačke slova p), tako da font od 12 tačaka iznosi 1/6 inča, posmatrano od najviše do najniže tačke. Kada povećate font automatski se poveća i visina reda tako da se znaci pravilno prikažu. 

Underline (Podvlačenje): nekoliko mogućnosti podvlačenja 

• Single (jednostruko) i Double (dvostruko) podvlačenje može da se primeni na sve znakove.

• Single Accounting (jednostruko računovodstveno) i DoubleAccounting (dvostruko računovodstveno) podvlači celu ćeliju kada se radi o tekstu, ili samo znakove kada je reč o brojevima. Stilovi računovodstvenog podvlačenja primenjeni na formatiranje valute, podvlače samo cifre a ne i valutnu oznaku (za razliku od običnog stila podvlačenja koji podvlači sve).

Color (Boja): Padajuća lista Color prikazuje paletu boja koje se mogu primeniti na sadržaj ćelije.

Effects (Efekti): Opcija Strikethrough izaziva precrtavanje znakova linijom po sredini. Ostale dve opcije, Superscript i Subscript, koriste se za pisanje stepena i indeksa u naučnim podacima.

Nornial Font (Normalm font): Potvrdivanjem ove opcije sve vrednosti u vezi sa

fontovima vraćaju se na podrazumevane.

Previevv (Prikaz za pregled): Prozor koji prikazuje kako će formatirani znakovi

izgledati kada pritisnete OK.

1.5.2.1 Promena standardnog fonta radne sveske

Da promenite standardan font radne sveske izaberite komandu Tools > Options, zatim karticu General. Parametri Standard font i Size određuju font koji se podrazumeva. Ovi parametri se primenjuju uvek kada otvarate novu radnu svesku. (Excel mora da se ponovo pokrene da bi promene ovih parametara bile primenjene.)

1.5.3 Dodavanje okvira ćelijama

Okviri ćelija doprinose preglednosti i rasporedu radnog lista i kada se pažljivo koriste jedna su od najkorisnijih opcija formatiranja. 

Da uokvirite ćelije, izaberite komandu Format / Cells / karticu Border.

Opcije kartice Border
U sledećoj listi opisane su sve opcije kartice Border iz dijaloga Format Cells:

Style (Stil): Kontroliše stil linije izabrane za okvir ili deo okvira, uključujući različitu debljinu linija, punu ili isprekidanu i jednostruku ili dvostruku.

Color (Boja): Kontroliše boju izabranog okvira ili dela okvira.

Border (Okvir): Prikazuje izgled i kontroliše kakav se okvir primenjuje na određenu ćeliju. Dugmad ispod i levo od prozorčića za prikaz koriste se za primenjivanje ili uklanjanje izabranih ivičnih linija. Ivlcu okvlra možete da dodate ili  uklonite i pomoću miša ako je pritisnete u prozoru za prikaz. U istom prozoru prikazuju se i stil i boja izabrane ivice okvira.

Presets (Podešeni okvin); Pritisnite dugme Outline da potpuno uokvirite ćeliju, ili dugme None da uklonite okvir . Kada je izabrano više ćelija tu je i dodatno dugme Inside za postavljanje ivica između ćelija.

napomena: Ponekad se okvir i daije vidi u ćeliji iako ste ga uklonili. To se dešava zato što su u 1 mreži prisutna dva okvira i oba morate da uklonite (odnosno, leva linija okvira jedne ćelije ne predstavlja desnu liniju okvira susedne).

1.5.3.1 Linije mreže nisu isto što i linije okvira

Linije mreže nisu isto što i okviri ćelija. Linije mreže su opšteprisutne u radnom listu i umanjuju učinak linija okvira. Linije mreže možete da uklonite ako izaberete komandu Tools „ Options, zatim karticu View i uklonite potvrdu opcije Gridlines.

savet: Svetlosivi okviri ili tanki okviri odnosno pojedine okvirne linije su vizuelno prihvatljiviji i daju profesionalniji izgled. Njihov izgled zavisi od rezolucije monitora i štampača.

1.5.4 Alat za uokvirivanje

Alatka Border prikazuje paletu različitih stilova okvira. 

bez okvira (uklanja postojeće okvire) 

Donja linija 

Leva linija 

Desna linija

Dvostruka donja linija 

Pojacana donja linija 

Gornja i donja linija 

Gornja i dvostruka donja 

Gornja i pojačana donja 

Okvir (svaka ćelija u selekciji) 

Okvir (oko selekcije) 

Pojaćani okvir (oko selekcije)

1.5.5 Primena šrafura i boja

Šrafure i boje mogu da poboljšaju izgled radnog lista ili da istaknu određene informacije. Na primer, ako pravite tabelu kojom pratite prodaju možete da koristite šraflranu pozadinu kojom ističete prodaju koja je premašila neku vrednost i tako skrenete pažnju na velike brojke. Ili, poboljšajte čitljivost široke tabele tako što ćete osenčiti svaki drugi red svetlom bojom ili sivom kao na slici koja sledi.

Da biste primenili boje i šrafure na izabrane ćelije, izaberite Format > Cells, zatim karticu Patterns.

savet: Zive boje mogu da se priguše mešanjem sa belim uzorkom, ili upotrebom uzorka jarke boje na beloj pozadini.

1.5.6 Alatke za bojenje i šrafiranje

Alatke Fill Color i Font Color nalaze se na paleti sa alatkama za formatiranje (Formatting). Kada se izaberu, prikazuje se paleta boja koja se može skinuti sa palete sa alatkama i koristiti za formatiranje boje teksta i pozadine izabranih ćelija.

1.5.7 Poravnavanje stavki u celijama

Poravnanje se odnosi na položaj znakova u ćeliji. Podrazumeva se da se tekst poravnava ulevo a brojevi udesno. Da biste izmenili poravnavanje, izaberite komandu Format > Cells, zatim karticu Alignment da prikažete dijalog sa slike 5.3. Horizon-talno i vertikalno poravnavanje teksta u izabranim ćelijama kontroliše se odgovarajućim padajućim listama.

1.5.7.1 Kontrola horizontalnog poravnavanja

Opcije padajuće liste Horizontal za horizontalno poravnavanje teksta su:

General: poravnava tekst ulevo, brojeve udesno.

Left (Indent): poravnava sadržaj ćelije ulevo.

Center: centrira znakove u ćeliji.

Right: poravnava sadržaj ćelije udesno.

Fill: ujednačeno popunjava odabranu ćeUju jednim znakom.

Justify: poravnava tekst desno i levo u ćeliji. Rezultati su vidljivi jedino ukoliko postoji vise redova teksta.

Center Across Selection: centrira tekst preko izabranih kolona.

Opcijom Indent kontrolišu se promene levog poravnavanja teksta u izabranim celijama slično tabulatorima.

1.5.8 Popunjavanje čelije jednim istim znakom

Pretpostavimo da pravite obrazac u kome će neke ćelije biti   popunjene   odredepim znakom, možda -----ili #####m# ili $$$$!$$. Opcija Fill iz kartice Alignment okvira za dija-log Format >• Cells popuniće izabranu ćeliju ili c'elije samo jednim znakom. Ćelije možete popuniti nizom znakova, na primer, obc (čelija će se popuniti abcabcabć). Možda mislite da je jednostavno popuniti ćeliju upisivanjem zna-kova dok se ćelija ne popuni, ali šta će se dogoditi kada promenite širinu te kolone? Ako ste upisali recimo devet znakova, ćelija će sadržati devet znakova, pri čemu sirina kolone nema značaja. Međutim, ako popunite ćeliju opcijom Fill, ćeiija c'e biti popunjena znakom bez obzira na sirinu kolone.

Opcija Fill se može koristiti i za popunu nekoliko ćelija (ili celog reda) jednim znakom, a red znakova izgledace neprekinuto. Da ste upisivali znakove u svaku ćeliju, videli biste pojedinačne grupe znakova, sa razmakom između ćelija ostavljenim za linije koordinatne mreže.

1.5.8.1 Centriranje preko selekcije

Opcija Centeracross selection (centriranje preko selekcije) veoma je korisna za naslove, pošto centrira tekst preko izabranih ćelija bez obzira na različitu širinu kolona. Na primer, pretpostavimo da želite da centrirate naslov Prihodi po kvartalima u 1998. preko kolona A do F (u drugom redu).

1. Unesite tekst u ćeliju A2.

2. Izaberite ćelije A2:F2.

3. Izaberite Format s- Cells pa karticu Alignment.

4. Izaberite Center Across Selection iz liste Horizontal i pritisnite OK.

1.5.8.2 Centriranje i spajanje

Staro dugme Center Across Columns na paleti za formatiranje sada se zove Merge and Center - spajanje i centriranje. Do promene je došlo zato što je dugmetu dodata nova funkcija za spajanje ćelija. Sada se ovom alatkom horizontalno centrira sadržaj izab-ranih ćelija i istovremeno spajaju ćelije.

Spojene ćelije ponašaju se kao jedna velika ćelija i ne utiču na formatiranje mlillj okolnih ćelija. Naročito su pogodne za označavanje skupova ćelija. Da biste razdvojili spojene ćelije najpre ih izaberite pa zadajte komandu Format> Cells, izaberite karticu Alignment i uklonite potvrdu sa opcije Merge cells.

1.5.8.3 Kontrola vertikalnog poravnavanja

Parametri za vertikalno poravnavanje kontrolišu poravnavanje između vrha i dna ćelije. U listi Vertical nalaze se sledeće opcije:

Top: postavlja sadržaj na vrh ćelije. Center: centrira vertikalno sadržaj u ćeliji. Bottom: postavlja sadržaj na dno ćelije.

Justifv: obostrano vertikalno poravnava redove teksta, od vrha do dna ćelije i automatski preiama tekst.

Uradite sledeću vežbu vertikalriog poravnavanja:

1. Unesite neki tekst u ćeliju B2.

2. Povećajte visinu reda 2, npr. na 50 ili vise.

3. Promenite vertikalno poravnavanje u ćeliji B2 na Top.
Vertikalno poravnavanje u ćeliji nije uočljivo ukoliko red ne promeni visinu.

1.5.8.4 Ponovljeno centriranje preko više ćelija

Pretpostavimo da ste neki naslov centrirali preko šest c'elija koristeći format Center Across Cells, a sada vam treba centriranje preko pet ćelija. Najčešća greška koju korisnici čine u ovom slučaju je što izaberu pet ćelija i pri-mene ovaj format. Međutim, time se ne resava problem jer kada se tekst centrira preko vise ćelija ovaj format se primenjuje na svakućeliju pojedinačno pa će ga šesta ćelija zadržati i dalje sve dok ga eksplicitno ne uklo-nite.

Najjednostavniji način da promenite cen-triranje je da izaberete šestu ćeliju i uklonite iz nje ovaj format (pritisnite ponovo alatku Cen-ter Across Cells). Kada hoćete da prosirite cen-triranje na još jednu čeliju sa desne strane izaberite je i samo na nju primenite formati-ranje Center Across Cells.

1.5.9 Promena izgleda teksta opcijama Text control

Grupom opcija Text control kartice Alignment menja se nekoliko aspekata prikaza teksta unutar jedne ili više ćelija i na radnom listu. Opcije su sledeće:

1.5.9.1 Wrap Text 

Prelamanje teksta): Ova opdja razbija dugačak red teksta na onoliko redova koliko je potrebno da bi se tekst smestio u ćeliju. Excel prelama redove da bi se tekst uklopio u širinu kolone, a tekst možete da prelomite i po želji prečicom Alt+Enter. Redovi tabele automatski postaju viši da bi mogli da prihvate više redova teksta.

1.5.9.2 Shrink to fit 

Podesi da stane: Ovom opcijom umesto visine reda menja se veličina fonta tako da tekst stane u ćeliju. Ovo je zgodna mogućnost kada je tekst samo neznatno veći da bi stao u izabranu ćeliju, kao u gornjem primeru. Ukoliko pokušate da sabijete previše teksta ne menjajud dimenzije ćelije, tekst će postati previše sitan da bi se čitao bez uvećanja.

1.5.9.3 Merge cells 

Spoji ćelije: Opcija Merge cells je izuzetno korisna nova mogućnost. Omogućava spajanje nekoliko ćelija tako da se one ponašaju kao jedna, ne menja-jući visine redova i širine kolona. Spajanjem ćelija možete na radni list postaviti adrese, natpise ili tekst sa objašnjenjem a pritorn sačuvati formatiranje odgovara-jućih podataka. Ovo je naročito korisno kada se prave dokumenti kao što su šabloni faktura. Na donjoj slici ćelije B3:D6 su spojene da bi se dobio prostor za adresu firme ali su širine odgovarajućih kolona sa podadma ostale netaknute.

1.5.10 Orijentacija teksta u ćeliji

Parametri sa kartice Alignment kontrolišu orijentaciju teksta u ćeliji. Kako će tekst izgledati vidi se u dijalogu.

Ugao pod kojim će tekst unutar ćelije biti iskošen može se izabrati u rasponu od -90 stepeni do +90 stepeni. Dovoljno je pritisnuti ili povući indikator orijentacije ili zadati ugao pomoću brojača stepeni (Degrees) ispod polukružne skale. Na donjoj slici godine u ćelijama B2:G2 okrenute su za 90 stepeni a imena u ćelijama B5:G5 za 55 stepeni.

napomena: Visina reda se automatski podesava kada je ćelija orijentisana vertikalno, postrance ili pod uglom. Na primer, ako formatirate ćeliju da bude vertikalno orijentisana, visina reda će se prilagoditi sadržaju koji treba da primi (povećati ako je potrebno).

1.5.10.1 Rad sa alatkama za poravnavanje

Tabela 5.3 sadrži i opisuje Excelove alatke za poravnavanje. Obratite pažnju da se alatke označene zvezdicom (*) ne pojavljuju u ugrađenoj paleti sa alatkama. Posto-jećim ili namenski napravljenim paletama mogu se dodati brojne druge alatke za for matiranje. 

Alatka       Funkcija

· Levo poravnavanje 

· Centralno poravnavanje 

· Desno poravnavanje

· Obostrano poravnavanje* 

· Centriranje preko selekcije 

· Vertikalna orijentacija* 

· Postavljanje pod uglom navise 

· Postavljanje pod uglom naniže 

· Postrance (čitanje odozdo nagore)* 

· Postrance (čitanje odozgo nadole)*

1.5.11 Formatiranje brojeva

Formati za brojeve kontrolišu kako se prikazuju brojevi, uključujući datum i vreme. Excel omogućava da se brojevi prikažu velikim brojem tbrmata. Na raspolaganju su tormati za razlomke, vremenske podatke, valute, računovodstvene podatke^ brojeve u običnom i naučnom obliku kao i opšti i podrazumevani formati.

1.5.11.1 Korišćenje formata brojeva

Postoji širok izbor ugradenih formata koji su grupisani u kategorije od kojih se svaka odnosi na odgovarajuća polja ili oblast primene. Da biste primenili formatiranje brojeva u jednoj ili više ćelija radnog lista, uradite sledeće:

1. Izaberite Format > Cells da dobijete dijalog Format Cells a zatim izaberite karticu Number .

2. Izaberite kategoriju formata (Categorv), da suzite izbor pri traganju za tipom formata.

3. Izaberite tip formata. (Okvir Sample prikazuje izabran format primenjen na podatke u aktivnoj ćeliji.)

4. Pritisnite OK.

savet: Kada unesete formulu koja se poziva na druge ćelije, ćelija nasleđuje formatiranje od prve ćelije navedene u formuli (ukoliko prethodno niste zadali format ćelije u koju unosite formulu).

1.5.12 Simboli formata

Excelovi formati brojeva kontrolišu se naročitim simbolima. Te simbole možete kombinovati da biste zadavali izgled, dužinu i poravnatost brojeva pa čak dodali i tekstualni opis broja.

napomena: Excelovi simboli namenjeni formatiranju brojeva, datuma i vremena navedeni su u 

1.5.13 Simboli za formatiranje datuma i vremena

Kada se unesu datum i vreme, Excel ih prepoznaje i prikazuje u formatu datuma i vremena. Ponekad je neophodno prikazati drugačiji format. Vodite računa da se datum ne može koristiti u izračunavanjima ako je unesen kao tekst.

savet: Kada unosite razlomke, na primer 1/2, Excel vaš unos tumači kao datum i prikazuje 2-Jan. Da biste dobili razlomak, unesite ga kao mešovit razlomak: 0 1/2. Ako pokušate da izbegnete prikazivanje razlomka kao datuma ubacivanjem razmaka ili apostrofa ispred broja, razlomak će biti unesen kao tekst. Da li je razlomak unesen kao tekst ili kao broj proverite po poravnanju. Podrazumeva se da Excel tekst poravnava duž leve margine a brojeve duž desne.

1.5.13.1 Formati brojeva prilagođeni korisniku

Pored gotovih formata kojima raspolaže, Excel vam nudi još jednu mogućnost. Pomoću simbola formata iz dodatka C možete da definišete sopstvene formate brojeva.

1.5.13.2 Definisanje novih formata brojeva

Pretpostavimo da imate radni list sa velikim brojevima pa želite da prikažete brojeve u hiljadama, bez promene vrednosti. Posao će obaviti namenski definisan format:

1. Izaberite ćeliju Al i unesite 1234567.
2. Izaberite Format - Cells, zatim karticu Number.

3. Izaberite kategoriju Custom i unesite #,###, u polje Type (nemojte propustiti da upišete oba zareza).

4. Pritisnite OK. Broj će biti prikazan kao 1,235.

1.5.13.3 Namensko formatiranje brojeva za proteklo vreme

Pretpostavimo da dnevno pratite koliko sati radite tako što beležite vreme početka rada i vreme kada završite. Svako jutro i veče kucate Ctrl+Shift+: (dve tacke) da biste uneli tačno vreme u radni list sa radnim vremenom, zatim oduzimate vreme početka od vremena zavr-šetka rada i računate efektivno radno vreme, a rezultat formatirate u satima. Dobijate 8 ili 9 sati rada dnevno (ili 10 ili 12) - nema problema.

Sada sabirate dnevne sate rada da biste dobili zbir radnih sati nedeljno - rezultat je 16 sati, a očekivali ste 40! Rezultat je takav jer Excelovo standardno formatiranje vremena dozvoljava ukupno 24 sata (i 60 minuta, i 60 sekundi). Ne očajavajte, formatiranje se tako podešava na prikazivanje ukupnog proteklog vremena u satima (minutama ili sekundama).

Da bi se prikazala vrednost proteklog vre-mena koja iznosi više od 24 sata, ili 60 minuta, ili 60 sekundi. Ograničenje se uklanja upi-sivanjem zagrada oko koda vremena. Na primer, namenski kčd formata [h]:mm prika-zuje četrdesetčasovnu radnu nedelju kao 40 sati (i sate kao razlomak za minute). Namenski kod [mm] prikazuje četrdesetcasovnu radnu nedelju kao 960 minuta, a [ss] je prikazuje kao 57600 sekundi.

1.5.13.4 Primena novih formata brojeva

Kada se definiše nov format brojeva, on se čuva u radnoj svesci i može da se priinenjuje kao ugradeni format. Novi formati biće prikazivani u kartici Number dijaloga Format Cells  kao poslednji u kategoriji Custom.

1.5.13.5 Brisanje novih formata brojeva

Novi formati brojeva čuvaju se u radnoj svesci u kojoj su definisani. Da ih obrišete, aktivirajte radnu svesku, zatim postupite na sledeći način:

1. Izaberite Format / Cells / karticu Number.

2. Izaberite kategoriju Custom.

3. Izaberite nov format koji želite da obrišete, zatim pritisnite dugme Delete.

1.5.13.6 Uslovno formatiranje

Brojevi mogu da se formatiraju različito koristeći nove malopre opisane metode formatiranja. Na primer, ćelija može da se formatira tako da se u njoj negativni brojevi prikazuju u civenoj boji. Medutim, boja fonta možda neće istaći

1.5.13.7 Tri načina za skrivanje nula na radnom listu

Pretpostavimo da ste napravili radni list koji sadrži mnogo nula. Radni list pretrpan nulama se teško čita jer je suviše informacija na njemu. Kako biste mogli da skrijete nule i dobijete pregledan radni list? Postoje tri mogućnosti; metod koji izaberete zavisi od konkretnih okol-nosti u kojima želite da skrijete nule.

• Ako želite da ih sakrijete u celom radnom listu, izaberite Tools / Options / karticu View, a zatim uklonite potvrdu sa polja Zero values. Nule se mogu ponovo prika-zati potvrđivanjem polja za potvrdu.

• Ako želite da sakrijete samo nule u određenoj ćeliji, formatirajte ćelije da sakriju nule dodavanjem tačke i zareza na kraju koda za format. Izaberite Format / Cells / karticu Number, a zatim prilagodite kod formata u polju za tekst Code. Evo primera koda za skrivanje nula:

#,##0_);(#,##0);

#,##0.00_);(#,##0.00);

$#,##0_);($#,##0);

Ako želite da sakrijete nule koje su rezultat formule, upotrebite funkciju IF. Na primer, pretpostavimo da formula glasi =A1-B1; ne želite da se prikaže rezultat koji glasi nula. Ugnezdite formulu u funkciju IF da bi rezultat nula bio skriven. Evo, ovako: IF(A1-B1=0,"", A1-B1). Ta formula u stvari znači; ,,ako je A1-B1 jednako nula, prika-zati tekst null, u suprotnom prikazati rezultat oduzimanja A1 -B1".ili predstavljati podatke na način koji želite. Zahvaljujući uslovnom formatiranju brojevi, tekst, pozadina ćelije i ivice okvira mogu se prikazati različito u zavisnosti od vrednosti sadržane u ćeliji. Uslovno formatiranje može da zavisi od vrednosti u iza-branim ćelijama ili vrednosti u drugim ćelijama. Uslovno formatiranje je takode i dinamičko; formati se menjanju kako se menjaju vrednosti. Uslovnim formatiranjem možete napraviti da se podaci prikazuju u maniru semafora - povoljni podaci zeleno, negativni crveno, a problematični žuto. Na primer, prodaja u nekom periodu može da blista, opadne ispod planirane ili prati plan. Semaforski prikaz daleko primerenije pokazuje stanje prodaje i upozorava na promene. Evo kako se primenjuje uslovno formatiranje:

1. Izaberite ćelije koje treba formatirati.

3. Izaberite Format / Conditional Formatting da biste prikazali dijalog Conditional Formatting.

Vežba uslovnog formatiranja:

1. Unesite sledeće podatke u radni list.
2. Izaberite ćeliju C3.

3. Izaberite Format :- Conditional Formatting.

4. U dijalogu Conditional Formatting izaberite Cell Value Is (vrednost ćelije je) u prvoj listi područja Condition 1, equal to (jednaka) u drugoj, a u krajnje desno polje upišite =D3 za planiranu vrednost (koristite relativne reference), pa pritisnite dugme Format.

savet: Koristeći funkciju between (izmedu) u drugom polju, možete upisati i gornju i donju granicu vrednosti u zadnja dva polja.

5. Izaberite karticu Patterns dijaloga Format Cells i žutu boju iz palete boja pa pritisnite OK.

6. Pritisnite dugme Add dijaloga Conditional Formatting.

7. Promenite kriterijum u drugom polju liste područja Condition 1 tako da glasi greater than (veće od) pa ponovo unesite =D3, tbrmatirajte sadržaj ćelije u zeleno i pritisnite Add.

8. Dodajte sada i treći kriterijum šeme formatiranja, less than (manje od), ponovo unesite =D3, izaberite crvenu boju i pritisnite OK.

9. Kopirajte ćeliju C3, izaberite ćelije C4 do C6 pa izdajte komandu Edit> Paste Special. Izaberite opciju Paste Formats pa pritisnite OK.

Format ćelija C3:C6 sada će se menjati automatski kako budete menjali vrednosti u ćelijama. napomena: Korišćenjem relativne reference D3 vi Excelu ustvari kažete: ,,Formatiraj izabranu c'eliju (C3) na osnovu vrednosti u ćeliji sa desne strane". Na ovaj naćin kada kopirate i prenosite format u ćelije C4:C6, njihovi formati biće uslovljeni odgovarajućim vrednostima u koloni 0, a ne u ćeliji D3. Ako pokažete pa pritisnete ćelijsku referencu Excel će koristiti apsolutne reference.

1.5.14 Korišćenje alatke format Painter

Velika pogodnost u Excelu je alatka Format Painter koji se nalazi na standardnoj paleti sa alatkama. Format Painter kopira i prenosi (eng/.paste) formate tako što ih ,,ucrtava" u ćelije. To ume da donese značajne uštede vremena - ako želite da primenite isti for-mat na različite ćelije ne morate iznova da prolazite kroz sve korake kojima ćete to postići. Dovoljno je da se poslužite alatkom Format Painter. Format Painter možete da koristite na sledeći način:

1. Izaberite ćeliju koja sadrži formatiranje koje želite da kopirate.

2. Izaberite alatku Format Painter.

3. Povlačenjem odabirajte one ćelije na koje želite da primenite tbrmatiranje.

Kopiranje formata možete da ponavljate ne birajući alatku svaki put, ako postavite pokazivač na dugme Format Painter i dvaput pritisnete taster miša. Kursor alatke Format Painter tada ostaje aktivan sve dok je ponovo ne izaberete.

savet: Pomoću alatke Format Painter možete brzo i da obrišete formate. Izaberite neku neformatiranu ćeliju, zatim Format Painter, pa povucite pokazivač preko ćelija čiji format treba da se obriše.

1.5.15 Prednosti automatskog formatiranja

Opcija AutoFormat sadrži formate koji mogu brzo da se primene na grupu ćelija. Sadrži formate za brojeve, poravnavanje, fontove, okvire, šrafuru, boju, visinu reda i širinu kolone.

1.5.15.1 Primena opcije AutoFormat

Da biste primenili AutoFormat na grupu ćelija, postupite na sledeći način:

1. Izaberite grupu ćelija (skup susednih ćelija ili jednu ćeliju iz grupe).

2. Izaberite Format > AutoFormat. Pojavljuje se dijalog AutoFormat .

3. Izaberite AutoFormat iz liste Table format

4. Pritisnite OK.
Selektivna primena AutoFormata

Opcija AutoFormat sadrži šest atributa, ali možete da se opredelite da sadrži samo odredene, izabrane atribute, da tokom primene ne bi došlo do brisanja prethodno primenjenog tbrmata. Pretpostavimo da želite da primenite AutoFormat bez izmene dimenzija trenutnih redova i kolona u radnom listu:

1. Izaberite grupu podataka, zatim Format / AutoFormat.

2. Izaberite AutoFormat iz liste Table formats, zatim pritisnite dugme Options. Dijalog AutoFormat se proširuje pokazujući dodatno područje sa novim tbnna-tima koji se mogu primeniti (Formats to apply).

3. Poništite opciju Width/Height iz područja Formats to apply.

4. Pritisnite OK. AutoFormat će biti primenjen bez ikakvih atributa širine kolone ili visine reda.

savet: Opcijom Format Painter prenosi se AutoFormat iz jedne tabele u drugu (ali bez usaglašavanja dimenzija redova i kolona tabela). Izaberite celu autoformatiranu grupu i Format Painter, zatim prevucite pokazivačem preko cele grupe u drugoj tabeli koja treba da bude formatirana na isti način.

Zamislite radni list koji sadrži desetine podnaslova, od kojih svaki treba da ima format Times New Roman, veličine 12 tačaka, Bold, sa donjom linijom okvira. Bilo bi potrebno puno vremena primeniti te tbrmate na desetine podnaslova a još zamornije promeniti kasnije te podnaslove na veličinu 14.AH, možete da definišete stit, u stvari kombinaciju formata kojoj cete dati neko ime, pa ga zatim više puta primeniti na ćelije. Kada promenite stil, promena će automatski biti izvršena u svim ćelijama u kojima je bio upotrebljen taj stil.

Stilovi su od vitalnog značaja za jednostavnije formatiranje lista. Zato se na duži rok isplati da malo vremena posvetite proučavanju stilova. Stilovi su korisni zato što:

• brže razvijate radni list

• lakše menjate formate

• uspostavljate standarde za formatiranje

1.5.15.2 Formiranje stilova prema primeru

Kada formirate stilove prema primeru, prvo formatirajte ćeliju, a potom definisite stil koristeći taj format. (Ovo je najbrži način da definišete nov stil.)

1. Formatirajte ćeliju pomoću komandi za formatiranje i ostavite da bude istaknuta.

2. Izaberite komandu Fonnat / Style. Pojaviće se dijalog Style .

3. Upišite ime novog stila u polje Style name.

4. Pritisnite OK.

Novi stil sadržaće sve odlike formata izabrane ćelije.

savet: Nov stil možete da formirate i upisivanjem imena direktno u alatku za stil, umesto preko dijaloga Style. Da biste mogli da koristite alatku Style, dodajte je paleti sa alatkama .

1.5.15.3 Učinite da ćelije izgledaju trodimenzionalno

Kreativnom upotrebom okvira ćelije može se napraviti trodimenzionalni efekat koji ćini da radni list na ekranu izgleda profesionalnije. (Zavisno od mogućnosti vaseg stampača, isti efekat je moguc'e postići i na stampanom dokumentu.) Treba zapaziti da neki od Excelovih automatskih formata za tabele takođe koriste 3-D efekte. Ovde c'emo pokazati kako se selektivno postiže taj efekat. Tehnika se tiče kreativne upotrebe okvira ćelija. Sledeći postupak pokazuje kako se može učiniti da ćelija bude uzdignuta i uočljivija;

1. Formatirajte skup ćelija (neka bude skup od barem 3x3) tamno sivo. (Upotrebite sivo iz drugog reda i poslednje kolone palete boja iz kartice Patterns.)

2. Izaberite ćeliju unutar sivog skupa, a zatim Format / Cells, pa mišem izaberite karticu Border.

3. Primenite svetlosivo za levi i gornji deo okvira. (Upotrebite sivo iz drugog reda i sedme kolone palete boja.)

4. Primenite crno za desni i donji deo okvira.

Celija sada izgleda uzdignuto. Ako hoćete da izgleda uvuceno, zamenite delove okvira; levi i gornji deo neka budu crni, a desni i donji svetlo sivi. Ne morate da koristite tamno sivu pozadinu da biste postigli ovaj efekat. Samo delovi okvira c'elije moraju da budu za nijansu svetliji i za nijansu tamniji od pozadine.

Na prvi pogled, praktične koristi od ovakve tehnike izgledaju ograničeno, ali, u stvari, postoji jedna važna korist - 3-D efekti omogućuju isticanje ćelija bez upotrebe boja. Korisnici za koje je grafičko okruženje novost često preteruju sa upotrebom boja; ne umeju da ih koriste umereno.

1.5.15.4 Eksplicitno formiranje stilova

Naučili ste kako da formirate stilove prema primeru. Sledeći postupak omogućava da stil definišete eksplicitno, pomoću opcija iz dijaloga Stvle.

1. Izaberite komandu Format > Style.

2. Upišite ime novog stila u polje Style name.

3. Pritisnite Modify. Pojaviće se dijalog Format Cells.

4. Zadajte opcije za formatiranje iz kartice dijaloga, zatim pritisnite OK.

5. Pojaviće se ponovo dijalog Style:

• Ako želite da primenite nov stil, pritisnite OK.

• Ako želite samo da definišete stil (bez primene), pritisnite Add, zatim Close.

Dijalog Style prikazuje spisak od šest atributa koje može da sadrži novoformirani stil (pogledajte područje Style includes sa slike 5.7) i parametre za svaki atribut. Ispred svih atributa koje ne želite da koristite možete da uklonite znak za potvrdu. Na primer, možete da definišete stil koji ne sadrži okvir (border) ili atribut šrafure (pattem), tako da se postojeći okviri ili srafure ne menjaju kada se stil primeni.

napomena: Visina reda i širina kolone nisu deo definicije stila.

1.5.15.5 Promena definicije stila

Postupci za promenu stila slični su postupcima za njihovo formiranje.

1. Izaberite Format 2- Style.

2. Izaberite ili upišite naziv stila koji želite da promenite.

• Ako ime izaberete, postojeći formati stila biće polazna osnova za izmene.

• Ako ime upišete, polazna osnova za izmene biće aktivna ćelija.

3. Pritisnite Modify i promenite formate pomoću kartica Format Cells,

4. Pritisnite OK. Ponovo se prikazuje dijalog Style.

5. Pritisnite OK da primenite novi stil, ili Add da dijalog Stvle ostane otvoren (da biste formirali ili promenili druge stilove).

1.5.15.6 Primena stila
Naučili ste kako da definišete stilove. Postupak iaprimenu stila na jednu ili više ćelija je sledeći:

1. Izaberite ćeliju ili ćelije na koje želite da primenite stil.

2. Primenite stil upotrebom jednog od dva načina:

• Izaberite Format > Style, zatim stil iz liste Style Name i OK.

• Izaberite stil iz alatke za stil (u poglavlju 27 objašnjeno je kako se ova alatka dodaje paleti sa alatkama).

savet: Stilove koristite u kombinaciji sa šablonima da biste stvorili standardizovan format radnih listova.

1.5.15.7 Brisanje stila

Stilovi se čuvaju u radnoj svesci u kojoj su nastali, a možete da ih obrišete na sledeći način:

1. Aktivirajte radnu svesku koja sadrži stil.

2. Izaberite Format / Style.

3. Iz liste Style name izaberite stil koji treba da se obriše.

4. Pritisnite Delete, zatim OK.

Sve ćelije koje su bile definisane obrisanim stilom preuzeće stil Normal.

Napomena: Stil Normal ne može da se obriše, ali mogu da se promene njegova svojstva.

1.5.16 Kombinovanje stilova različitih radnih svezaka

Pretpostavimo da ste definisali neke stilove u radnoj svesci i da želite da ih upotrebite u drugim radnim sveskama bez ponovnog definisanja. Postupak kombinovanja stilova je sledeći:

1. Otvorite izvornu radnu svesku sa stilovima koje treba kopirati i ciljnu radnu svesku na koju treba da se primene.

2. Aktivirajte ciljnu radnu svesku.

3. Izaberite komandu Format / Style.

4. Pritisnite Merge. Pojaviće se dijalog Merge Styles:

5. Izaberite izvornu radnu svesku iz liste Merge styles from.

6. Pritisnite OK da prekopirate stilove u ciljnu radnu svesku - svi stilovi iz izvorne radne sveske biće preneti.

7. Pritisnite OK da zatvorite dijalog Style.

savet: Ako obe radne sveske imaju stil istog imena Excel će prikazati poruku ,,Merge styles that V have same names?" kojom predlaže da spoji stilove istih imena u jedan. Ako izaberete Yes, stil iz izvorne radne sveske zameniće stil u ciljnoj radnoj svesci.

1.5.16.1 Kopiranje formata i stilova u drugu radnu svesku

Kada kopirate ćeliju iz jedne radne sveske u drugu, kopirate i formatiranje. Ovo je pogodno za formate brojeva i stilova koje ste sami forrrnrali, jer ponovno formatiranje može da oduzme mnogo vremena.

Ako želite da kopirate svoj format brojeva ili stilova u drugu radnu svesku, izaberite ćeliju koja sadrži taj format ili stil i kopirajte je u novu radnu svesku. Vaši formati brojeva i stilova biće dodati listama u novoj radnoj svesci.

1.5.17 Formatiranje pozadine radnih listova

Excelova komanda Format / Sheet  /  Background pruža vam mogućnost da iz dijaloga Sheet Background izaberete neku od mnoštva grafika i slika koje će poslužiti kao pozadina radnog lista. Da bi vaši listovi izgledali privlačnije možete izabrati i pozadinu sačinjenu od gotovih sličica sa motivom kao što je ovaj prikazan na slid dole, staviti logotip firme na ,,naslovni" list ili dodati JPEG sliku kućnog Ijubimca.

1.5.18 Izmena ugrađenih stilova

Excel ima dosta ugrađenih stilova. Stil Normal je jedan od njih - Normal je podrazumevani stil za sve ćelije iz nove radne sveske, i kome se ćelije vraćaju kada se obriše njihovo formatiranje. Šta ako stil Normal ne zadovoljava vase potrebe? Na primer, možda želite da u rad-nom listu koristite Times Nevv Roman 12 umesto Ariala 10.

Definicija stila Normal se može izmeniti u aktivnoj radnoj svesci na isti način na koji se menja definidja bilo kog stila. Izaberite For. mat > Style, zatim Normal iz liste imena stilova (Style names), pa pritisnite dugme Modify. Izmene unesite u okviru za dijalog

Format Cells, zatim ga zatvorite pritiskom na dugme OK. Pritisnite još jednom OK da biste zatvorili i okvir za dijalog Style.

Sada ste izmenili stil Nocmal za jednu radnu svesku. Šta ako želite da novodefinisani stil Normal koristite u svim radnim sveskama? Stil Normal možete predefinisati u svakoj novoj radnoj svesci koju stvorite, ali je to neefi-kasno. Stil Normal za sve nove radne sveske menja se njegovim predefinisanjem u global-nom šablonu za radne sveske. Nazovite šablon V/ORKBOOK i snimite ga u omotnici XLStart (više o šablonima u poglavlju 1D). Sve nove radne sveske bic'e stvorene iz tog šablona i imace stil Normal koji ste sami definisali.

1.5.19 Saveti o dizajniranju radnih listova

Evo nekoliko ,'ednostavnih saveta za izradu radnih listova koji su pregledni i lepo izgle-daju:

• Neka budu jednostavni! Nemojte koristiti previše fontova i boja. Ograničite radni list na jednu ili dve vrste slova, sa varijacijama u velićini i liku (polucrni, kurziv).

• Koristite fontove koji mogu da se podešavaju po veličini, kao sto su True-Type, da bi cifre na ekranu izgledale izoštreno i jasno.

• Boju koristite svrsishodno, da istaknete infonnaciju ili vežete pažnju posmatrača. Za pozadinu koristite zagasite boje, npr. sivu.

• iskljucite koordinatnu mrezu i koristite okvire.

• Treba da bude dosta belina jer suviše zbijeno prikazivanje podataka nije pregledno.

• Unesite graflcke elemente (dijagrame, logotipe itd.) da učinite radni list privlačnim za oko. 

1. Otvorite nov radni list i unesite sledeće:

Celija     Unos
B2 

Fabrika sportske opreme
B3 

Promet po kvartalima i po proizvodu
B6 

Patike
C7 

Ikv.
D7 

IIkv.
E7 

III kv.
F7 

IV kv.
B8 

trčanje
B9 

tenis
BIO 
kosarka
Bll 

meduzbir
Cll 
=SUBTOTAL(9,C8:C10)
Dl1:Fll
(kopirajte formulu iz Cll)

2. Primenite sledeće formatiranje:

Ćelija      Formatiranje
B2          polucrni, kurziv, 16 tačaka 

B3          polucmi, kurziv, 12 tačaka

Ćelija      Formatiranje
B2:B3       centrirajte preko celog radnog lista (izaberite B2:F3; izaberite Format > Cells, karticu      Alignment, parametar Center Across Selection) 

B6          polucrni, kurziv, 11 tačaka 

B8:B10      desno poravnavanje 

B11:F11     polucrni

C7:F7       polucrni, centralno poravnavanje 

C8:F10      tanke, sive gornje, donje, leve i desne linije okvira 

C11:F11     sive dvostruke gornje linije okvira; ugraden format za broj #.##0 

C8:F10     novi format broja  [Red][<300]#.##0;[Blue][>600]#.##0;#.##0
3. Isključite mrežu.

4. Definišite stil za ćelije koje sadrže naslov izveštaja:

• Izaberite ćeliju B6.

• Izaberite Format / Style, upišite Naslov u polje Style name, zatim pritisnite OK.

Napomena: Ako promenite odlike stila, on će biti izmenjen u svim c'elijama gde je primenjen. To nema velikog značaja kada je reć samo o nekoliko naslova, ali zamislite radni list sa stotinama naslova. Ukoliko ste formatirali naslove koristeći neki stil, i najmanja izmena stila automatski će izazvati promene formata svih naslova.

5. Obrazujte drugi deo kopiranjem prvog:

• IzaberitećelijeB6:Fll.

• Kopirajte i unesite (paste) u ćeliju B13.

6. I'romenite sledeće parametre u drugom delu:

• Unesite Majice u ćeliju B13.

• Unesite T, polo i atletske u celije B15:B17.

7. Upotrebite sledeću funkciju da unesete slučajne brojeve koje ona generiše:

• Izaberite ćelije C8:F10 i C15:F17 (držite Ctrl da izaberete oba skupa).

• Upišite =INT(RAND( )*1000) i pritisnite Ctrl+Enter.

8. ,,Zamrznite" podatke:

• Izaberite C8:F10, Edit > Copv, zatim Edit > Paste Special, Values i OK.

• Postupak ponovite za ćelije C15:F17.

9. Obrazujte red za ukupan zbir:

• Unesite Ukupno (desno poravnavanje i polucrni) u ćeliju B19.

• Unesite formulu =SUBTOTAL(9,C8:C10,C15:C17)u ćeliju C19, zatim kopi-rajte formulu u ćelije D19:F19 (u poglavlju 9 više o funkciji SUBTOTAL).

10. Primenite siv dvostruki okvir za gornje linije ćelija sa ukupnim zbirom.

11. Vizuelno razdvojte zbirove od ostalih podataka:

• Izaberite redove 11, 18 i 19.

• Izaberite Format > Row > Height i unesite 19 za visinu reda.

1.6 Stampanje radnih listova

Uprkos tendenciji ka kancelariji bez papira, štainpani poslovni izveštaji neće biti izbaćeni iz upotrebe u doglednoj budućnosti. Srećom Excel nudi sve moguće opcije za pripremu radnih listova kako biste odštampali vaše podatke. Možete podešavati margine i birati fontove; umetati zaglavlja, podnožja i naslove; štampati vise kopija jednog istog lista ili samo nekih strana. Pre nego što počnete da trošite papir (i vreme), prethodno pregledajte radne listove da biste videli kako će izgledati kada ih odštampate.

1.6.1 Priprema radnih listova za štampanje

Pre nego sto stvarno odštampate vaše radne listove, potrebno je da podesite strane koje ćete štampati. Komanda File > Page Setup prikazuje dijalog sa karticama koje omogućavaju pristup većini parametara vezanih za štampanje. Kartica ima četiri:

Page, Margins, Header/Footer i Sheet.

1.6.2 Definisanje izgleda štampanih strana

Opcije za kontrolu osnovnog rasporeda sadržaja štampanih strana nalaze se na kartici Page dijaloga Page Setup.

Opcije koje nudi kartica Page opisujemo ovde:

Orientation (Orijentacija): Izaberite Portrait (uspravni list) ili Landscape (položeni list).

Scaling - Adjust to (Razmera - podesite na): Povećava ili smanjuje razmeru radnog lista ne menjajući veličinu prikaza na ekranu. Veličinu štampanog radnog lista možete smanjiti na svega 10%, da bi ih više stalo na stranu, ili povećati do 400%, da istaknete detalje.

Scaling - Fit to IRazmera - uklopite u): Podešava razmeru radi uklapanja na koliki broj strana po širini i visini radni list treba da bude odštampan. Zadržavaju se relativne dimenzije radnog lista.

napomena: Ako izaberete opciju Fit To, Excel će ignorisati sve prelome strana koje ste postavili i uklopiti ceo radni list ili površine sa njega u navedeni broj strana.

Paper size (Veličina papira): Izaberite format papira iz padajuće liste. Print quality (Kvalitet štampe): Izaberite rezoluciju (dpi) sa liste.

First page nuinber (Broj prve strane): Počinje upisivanje brojeva strana od zadatog broja.

napomena: Na svakoj od ćetiri kartice u dijalogu Page Setup postoji i dugme Options. To  dugme prikazuje dijalog Printer Setup izabranog štampaca. Sve promene u poljima dijaloga Page Setup koje utiću na podešavanja štampača (na primer promena velićine papira) automatski će se sprovesti i u dijalogu Printer Setup.

1.6.2.1 Podešavanje margina

Margine možete podešavati opcijama iz kartice Margins dijaloga Page Setup da biste odredili položaj zaglavlja (engl. header) i podnožja (engl. footer) odnosno gornjih i donjih straničnih oznaka i površina za štampanje .

Na kartici je vizuelna ilustracija položaja margina. (Izaberite marginu i odgovarajuća linija na ilustraciji postaje istaknuta.) Ostale opcije na ovoj kartici su sledeće:

Top, Bottom, Left, Right: Postavlja margine (u inčima ili centrimetrima), od gornje, donje, leve i desne ivice, redom.

Header/Footer (Zaslavlje/Podnožje): Postavlja zaglavlje/podnožje na zadatom ras-tojanju (u odgovarajućim jedinicama) od ivice. Rastojanje treba da bude manje od gornje/donje margine.

Center on page (Centrirano na strani): Potvrditi za vertikalno/horizontalno cen-triranje u okviru argina.

1.6.3 Zaglavlja i podnožja

Kartica Header/Footer  služi za definisanje i formatiranje gornjih i donjih straničnih oznaka zvanih zaglavlje i podnožje, redom.

Zaglavlja se štampaju pri vrhu svake strane a podnožja pri dnu. U zaglavlje se obično stavlja ime firme i naslov izveštaja (podrazumevani sadržaj zaglavlja je in-ie datoteke); podnožja najčešće sadrže broj strane i datum štampanja.

Zaglavlja i podnožja ustvari nisu deo radnog lista - ona su deo štampane strane i namenjen im je poseban prostor na stampanoj strani. Koliko će prostora imati na raspolaganju kontroliše se opcijama kartice Margins (zaglavlje zauzima prostor između margine zaglavlja i gornje margine; za podnožje je rezervisan prostor između donje margine i margine podnožja).

Zaglavlje i podnožje definišu se na isti nacin. Možete da izaberete gotova ili da definišete svoja zaglavlja i podnožja.

1.6.3.1 Upotreba gotovih zaglavlja i podnožja

Gotova zaglavli'a i podnožja koja odgovaraju potrebi možete da izaberete iz dve pada-juce liste kartice Header/Footer. Liste sadrže nekoliko naićešće korišćenih oblika zae-lavlja i podnožja (na engleskom).

1.6.3.2 Izrada novih zaglavlja i podnožja

Pritisnite dugme Custom Header odnosno Custom Footer da biste napravili sopstvena zaglavlja i podnožja. Pojavljuje se dijalog sa tri polja - Left section, Center section i Right section. Ova polja omogućavaju vam da poravnate tekst zaglavlja i podnožja duž odgovarajućeg dela strane.

Da biste definisali zaglavlje/podnožje, najpre mišem izaberite jedno od polja sa gornje slike. Upišite tekst u bilo koje od ova tri polja. (Pritisnite Alt+Enter za novi red.) Dugmad u centru dijaloga koriste se za formatiranje teksta kao i za unošenje posebnih vrednosti u zaglavlje/podnožje. Te posebne vrednosti su sledeće:

• format fonta (izaberite tekst, pritisnite dugme, potoin izaberite opcije za formatiranje)

• broj strane (Page number)

• ukupan broj strana (Number of pages)

• tekući datum (Current date)

• tekuće vreme (Current time)

• ime radne sveske (Workbook name)

• ime radnog lista (Worksheet name)

Zaglavlje se najčešće sastoji od vrednosti (broj strane) od (ukupnog broja strana) (na primer 1 od 12) koje se formiraju kombinovanjem teksta i kodova zaglavlja/podnožja:

1. Izaberite File »- Page Setup pa karticu Header/Footer.

2. Pritisnite dugme Custom Footer (slika 6.3) pa izaberite centralno polje dijaloga Footer.

3. Pritisnite dugme Page Number upisite od, zatim pritisnite dugme Number of Pages.

4. Pritisnite OK da zatvorite dijalog Footer.

Prethodni koraci umetnuće kod &[Page] od &[Pages] u centralno polje dijaloga Footer a u kartici Header/Footer pojaviće se prikaz podnožja. Kod će biti dodat u pada-juću listu podnožja radne sveske.

napomena: Znak ampersand (&) je kodni simbol za zaglavlja i podnožja koji se inače ne štampa. Ako je potrebno odštampati baš taj znak u zaglavlju, treba kucati dva ampersanda za redom.

1.6.3.3 Promena opcija kartice Sheet

Kartica Sheet  omogućava da zadate deo koji treba da se štampa, naslov i nekoliko drugih parametara koji se odnose na izgled štampanog dokumenta. Sledi spisak opcija koje se nalaze na ovoj kartici:

· Print area (Povrsina za sta}npanje): Izaberite deo radnog lista koji treba da se štampa.

· Print titles (Šti.iinpanji: naslovn): Izaberite ili upišite redove/kolone koje treba stampati na svakoj strani.

· Gridlines (Linije inreže): Uključivanje/isključivanje linija mreže (utiče samo na stampane strane).

· Black and vvhite (Crno i belo): Sve strane se štampaju u crnoj i beloj boji, bez sivih nijansi.

· Comments (Komentari): Omogućava štampanje beleški i komentara upisanih u ćelije ili u samim ćelijama ili na kraju lista.

· Draft quality (Nizak kvalitet štampe): Manje grafičkih objekata, bez linija mreže:skraćuje vreme štampanja.

· Row aiid column headings (Zaglavlja reciova i kolona): Zaglavlja redova i kolona uvršćuju se u štampanu stranu.

· Page order (Redosled strana): Izaberite redosled strana kod višestraničnih radnih svezaka .

• savet: Isključivanjem linija mreže (izaberite Tools / Options pa karticu View) automatski se isključuje i njihovo štampanje (kartica Sheet dijaloga Page Setup) i obrnuto. Linije mreže mogu se štampati i kad nisu prikazane na ekranu ako prvo isključite opciju Gridlines na kartici View a zatim potvrdite opciju Gridlines na kartici Sheet.

1.6.3.4 Zadavanje površine za štampanje

Kada treba odštampati samo delove radnog lista treba definisati koji su to delovi koristeći karticu Sheet dijaloga Page Setup. Da biste zadali površinu za štampanje, mišem izaberite polje Print area, zatim skup ćelija (takođe mišem ili upisivanjem referenci skupa ćelija).

Dugme za umanjivanje dijaloga koje se nalazi u polju Print area smanjiće dijalog dok definišete selekciju. 

 Površinu za štampanje možete zadati nekim od sledećih metoda:

• Izaberite površinu za štampanje pa izdajte komandu File / Print Area / Set PrintArea.

• Izaberite skup ćelija za štampanje i mišem izaberite alatku Set Print Area. Ova alatka se ne nalazi na ugradenoj paleti sa alatkama 

Radni list može da ima samo jednu površinu za štampanje u jednom trenutku, ali nema potrebe da brišete staru površinu za štampanje da biste zadali novu.

savet: Nije neophodno da definišete površinu za štampanje da biste štampali odredeni skup ćelija. Istaknite ćelije koje želite da stampate, a potom izaberite File / Print i Selection iz opcija Print what.

1.6.3.5 Postavljanje više prostora za štampanje na istoj strani

Pretpostavimo da imate radni list sa nekoliko tabela, i svaku tabelu želite da štampate na posebnoj strani. Po radnom listu možete da postavite gomilu znakova za prelom strane, medutim šta ako su velićine tabela različite i ne mogu lepo da se uklope između znakova za prelom strane? Strane koje definisete znakovima za prelom strane štampaće se redosledom definisanim u kartici Sheet okvira za dijalog Page Setup (ili popreko pa nadole, ili nadole pa popreko ). Možda tabele želite da štampate nekim drugim redosledom? U Excelu je moguće postaviti vise prostora za stampanje na istom radnom listu, a moguće je zadati i redosled stampanja.

Da biste zadali vise prostora za štampanje i redosled kojim treba štampati, uradite sle-dec'e:

1. Izaberite File > Page Setup, zatim karticu Sheet. (Nemojte koristiti alatku Print'Area, pošto ona može da postavi na radnom listu samo jedan prostor za štampanje.)

2. Izaberite polje Print area, zatim izaberite prvi prostor povlačenjem na radni list. Pritisnite i držite taster Ctrl da biste izabrali sledeći prostor.

Da biste zadavali dalje prostore za štam-panje, upišite zarez posle prvog prostora za štampanje u polju Print area, zatim izaberite sledeći prostor. Možete zadati onoliko pros-tora koliko želite i redosledom koji želite raz-dvajanjem referenci prostora za štampanje zarezom. Prostor koji prvi zadate štampaće se na prvoj strani, drugi na drugoj strani itd.

1.6.3.6 Postavljanje naslova za štampanje

Pri štampanju dokumenta od više strana, ponekad je potrebno da neki redovi ili kolone budu štampani na svakoj strani. Pretpostavimo da imate radni list sa naučnim podacima o kvalitetu vazduha, očitavanih dnevno tokom cele godine na 150 lokacija. Radni list je dugačak 365 redova (datumi), a širok 150 kolona (lokacije) i pri štam-panju staje na nekoliko strana. Svaki podatak mora da bude praćen datumom (leva kolona) i lokacijom (gornji red). Strana koja pokriva, na primer, datume junskih očitavanja na lokacijama od 99 do 105, mora da ima odgovarajuće datume i lokacije upisane duž leve i gornje ivice tabele.

Prikazana strana samo je jedna od 144 strane (radni list je 12 strana visok i 12 strana širok). Označite kolonu Datum (kolona A) i red Site# (lokacija) (red 1) kao Print Titles da biste mogli da štampate bilo koji skup ćelija iz radnog lista, bez dodavanja datuma i lokacija radi identit'ikacije podataka (bez obzira koji deo radnog lista štam-pali, automatski će biti štampani i odgovarajući datum i lokacija).

napomena: Naslovi za štampanje nisu isto što i gornje stranične oznake, mada se mogu

upotrebiti za sličnu svrhu. Parametri strane mogu biti postavljeni tako da se stampaju i naslovi i gocnje stranične oznake.

Parametar Print titles postavlja se na sledeći način:

1. Izaberite komandu File >- Page Setup, a zatim karticu Sheet.

2. Pritisnite dugme za smanjivanje dijaloga polja Rows to repeat at top.

3. U radnom listu istaknite redove koje treba ponoviti, ili upišite referencu ćelije, pa ponovo pritisnite dugme za smanjivanje dijaloga.

4. Pritisnite dugme za smanjivanje dijaloga polja Columns to repeat at left.

5. U radnom listu istaknite kolone koje treba ponoviti, ili upišite referencu ćelije, pa ponovo pritisnite dugme za smanjivanje dijaloga.

6. Pritisnite OK.

1.6.3.7 Brisanje površine za štampanje ili naslova za štampanje

Ako ste već definisali deo radnog lista za štampanje, a želite da štampate ceo radni list, morate prvo da obrišete definisanu površinu.

Da biste je obrisali, izaberite komandu File / Print Area  / Clear Print Area, ili komandu File / Page Setup, zatim karticu Sheet i obrišite sadržaj polja Print area. Da biste obrisali naslove za stampanje, morate ručno da obrišete sadržaj iz polja Rows to repeat at top i/ili Columns to repeat at left u okviru za dijalog Page Setup.

Kada odredite površinu ili naslove za štampanje, imena skupova ćelija obuhva-ćenih površinom i naslovima automatski se definišu na radnom listu. Odredivanjem površine za štampanje definiše se ime za Print_Area. Određivanjem naslova za štam-panje definise se ime za Print_Titles. Ako želite da vidite bilo koji od ovih skupova, izaberite ih iz polja za ime. Pošto su to skupovi sa imenom, mogu se obrisati koman-dom Insert > Name s- Define. 

napomena: Imenovana područja se automatski uklanjaju kada brišete područja.

1.6.4 Pregled radnog lista na ekranu pre štampanja

Izaberite komandu File > Print Preview da vidite kako će štampana strana izgledati. Postoji nekoliko parametara koji mogu da se kontrolišu dok pregledate strane 

1.6.4.1 Zumiranje prikaza pre štampanja

U toku pregleda strane, pokazivač miša postaje lupa. Izaberite mišem deo radnog lista koji želite da uvećate. List će biti uvećan, a kursor će postati strelica. Ponovo mišem izaberite radni list da biste smanjili uvećanje. (Druga mogućnost je upotreba dugmeta Zoom iz gornjeg dela prozora.)

1.6.4.2 Dugmad za pregled pre štampanja

Sledeća lista objašnjava dugmad koja su prikazana duž gornje ivice radne povrsine tokom pregleda strane za štampanje :

Next: Prikazuje sledeću stranu (ovo dugme je bledo kada sledeća strana ne postoji).

Previous: Prikazuje prethodnu stranu (ovo dugme je bledo kada prethodna strana ne postoji).

Zoom: Prelaz sa prikazivanja zumirane na prikazivanje cele strane (i obrnuto). Print: Otvara dijalog Print. Sctup: Otvara dijalog Page Setup.

Margins: Uključuje/isključuje linije koje obeležavaju margine strana, margine straničnih oznaka i širinu kolona (linije mogu da se premeštaju povlačenjem).

Pagc Break Previevv: Prikazuje radni list na kome se vide prelomi strana i omogućava njihovu promenu. Pritisnite dugme Print Preview da biste se vratili u uobičajeni prikaz pre štampanja, ili izaberite View >- Normal i vratite se u nor-malni prikaz.

Close: Zatvara prozor za pregled pre štampanja i vraća u radni list

Dugme Margins kojim se prikazuju linije margina i kolona izuzetno je korisno. Kada je dugme aktivno, linije margina i kolona se vide i možete da ih povučete mišem na novo mesto. Da biste promenili mesto linije, postavite pokazivač miša na liniju margine, liniju kolone ili ručicu na ivici strane. Povucite liniju dvosmernom strelicom (slika 6.6). Dok povlačite liniju u statusnoj liniji se vide podaci o rastojanju ili širini izraženi odgovarajućim jedinicama. Ponekad je lakše povlačiti linije ako se poveća uveličanje.

Unutrašnje horizontalne margine su margine teksta; spoljašnje horizontalne mar-gine su margine straničnih oznaka. Dodatne ručice duž gornje ivice strane odgovaraju linijama kolona.

1.6.5 Podešavanje preloma strane

Pri štampanju, Excel automatski pravi prelom strane gde je potrebno. Ako automatski prelom strane preseca radni list na nepogodnom mestu, možete ručno da prelomite stranu.

1.6.5.1 Automatski prelom strane

Podrazumeva se da se automatski prelom strane ne vidi na radnom listu dok se strana prvi put ne odstampa (ili pregleda). Da biste videli prelom strane, izaberite Toolss-Options, potom karticu View i potvrdite opciju Page breaks. Automatski prelom strane biće prikazan kao isprekidana linija duž linija mreže.

1.6.5.2 Ručni prelom strane

Pretpostavimo da imate radni list od više strana sa tabelom brojeva a strana je automatski prelomljena po sredini tabele zbog čega se tabela štampa na stranama 2 i 3. Ako tabela nije previše dugačka, ručnim prelamanjem strane neposredno ispred tabele ona će cela biti štampana na jednoj strani. Ovo možete postići koristeći prikaz Page Break Preview koji uveličano prikazuje radni list sa jasno istaknutim lini-jama preloma strana. Te linije možete povlačiti mišem .Mada je Page Break Previevv samo jedan vid prikaza i značajna alatka za formatiranje, koristan je pri stampanju ili podesavanju površina koje se štampaju. Ovaj prikaz se dobija na jedan od sledećih načina:

• Izaberite View > Page Break Preview.

• Pritisnite dugme Page Break Preview dijaloga Print Preview .

Prelome strana možete ubaciti direktno sa radnog lista ili u prikazu Page Break Preview biranjem zaglavlja redova i kolona. Postoje tri vrste preloma strana - vertikalni, horizontalni i kombinacija ta dva:

Umetnite



Postupak
· Vertikalni prelom strane- Istaknite kolonu desno od preloma, potom izaberite Insert >- Page Break.

· Horizontalni prelom strane- Istaknite red ispod preloma a zatim izaberite Insert > Page Break.

· Vertikalni i horizon-talni prelom strane- Istaknite jednu ćeliju a zatim izaberite Insert>- Page Break (unosi prelome duž leve i gornje ivice istaknute ćelije).

Ručni prelom strane prikazuje se kao nešto deblja isprekidana linija u odnosu na isprekidanu liniju koja označava automatski prelom strane. Automatski prelom strane automatski se prilagodava ručnom prelomu.

napomena: Ako pokušate da odštampate radni list i otkrijete da su ignorisani prelomi strana,

verovatno ste izabrali opciju Scaling - Fit to. 

Izaberite File / Page Setup, zatim karticu Page, pa potvrdite opciju Scaling - Adjust to.

1.6.5.3 Uklanjanje ručnog preloma strane

Istaknite ćeliju desno od vertikalnog preloma ili odmah ispod horizontalnog preloma. 

Izaberite Insert > Remove Page Break. (Ako meni Insert ne prikaže komandu Remove Page Break, ručni prelom strane kod istaknute ćelije ne postoji.)Opcije za štampanje radnih listova

Komanda File > Print prikazuje okvir za dijalog koji nudi opcije za štampanje istak-nutih ćelija, izabranih listova ili strana, ili cele radne sveske . Dijalog Print je zajednički za sve aplikacije paketa Microsoft Office pa ukoliko ste štampali Wordove dokumente videćete da i Excel nudi iste mogućnosti.

Dugme Print na paleti Standard počeće da štampa odmah, bez otvaranja dijaloga, i koristiće se podrazumevane vrednosti. Opisaćemo ukratko opcije dijaloga Print:

Printer: Prikazuje štarnpać koji je izabran iz padajuće liste, status štainpača, model (Type) i oznaku priključka na koji je povezan (Where).

Print to file: Opcija koja omogućava na snimite na disk datoteku pripremljenu za štampanje na izabranom štampaču.

Page range - All: Štampa sve strane radnog lista.

Page range - From/To: Štampa navedene strane (Od/Do).

Selection: Štampa izabrane ćelije.

Active sheet(s): Štampa samo izabrani radni list.

Entire workbook: Štampa celu radnu svesku.

Number of copies: Štampa navedeni broj kopija izabranih strana.

Collate: Opcija koja omogućava redosled štampanja kopija kao na sličici levo.

Previevv: Pritiskom na ovo dugme dobijate prikaz dokumenta kakav će izgledati kada se odštampa.

Properties: Dugme kojim se aktivira dijalog sa karticama koje sadrže sledeće opcije:

napomena: Da biste radni list u koloru odštampali crno belo (bez sivih nijansi), izaberite File > Page Setup pa na kartici Sheet potvrdite opciju Black and white.

1.6.5.4 Biranje stampača

Ako radite u poslovnom okruženju vaš računar može biti povezan na više štampača. U tom slučaju možete birati štampač i odlučiti se za onaj koji je slobodan. Postupite ovako:
1. Izaberite File > Print.
2. Izaberite štampač sa liste Printer.
3. Pritisnite OK.
Dijalog Print prikazuje stanje reda čekanja na štampanje, vrstu priključka koji se koristi i da li je štampač zauzet ili slobodan.
1.6.5.5 Štampanje delova radnog lista

Često nije potrebno da štampate ceo radni list. Na primer, ukoliko se podaci za celu godinu nalaze na jednom radnom listu, a želite da štampate samo podatke za jedan mesec; ili želite da štampate sve, ali kao manje celine. Da biste odštampali samo deo radnog lista istaknite skup ćelija za štampanje i izaberite File > Print. Zatim iz oblasti Print vvhat izaberite opciju Selection. Excel zanemaruje svaku zadatu površinu za štampanje i štampa istaknuti skup.

Za štampanje više radnih listova jednom komandom izaberite sve listove koje želite da štampate, potom komandu File 2- Print Selected Sheet(s) (radni listovi moraju biti unutar iste radne sveske). 

1.6.5.6 Štampanje nekoliko strana

Excel standardno štampa sve listove radne sveske. Ponekad medutim biće vam potrebno da štampate samo izabrane strane. Da biste štampali samo izabrane strane iz skupa strana, postupite na sledeći način (štampaćete samo strane broj dva i tri):

1. Izaberite File / Print.

2. Iz Page Range izaberite Page(s).

3. Upišite 2 u polju From i 3 u polju To.

napomena: Ako želite da odštampate samo jednu stranu, upišite broj strane i u polje From i u  polje To. Na primer, ako hoćete da odštampate samo stranu 3 i unesete broj 3 u polje From a polje To ostavite prazno, Excel će odštampati sve, od strane 3 do kraja dokumenta..

1.6.5.7 Štampanje formula

Podrazumeva se da se radni list štampa onakav kakav je prikazan na ekranu. Mada se u radnom prostoru prikazuju formatirane vrednosti umesto formula koje su u njiho-voj osnovi, formule se takođe mogu štampati (za potrebe dokumentovanja unutrašnje logike radnog lista ili za proveru). Evo kako možete da štampate formule umesto vrednosti:

1. Prikažite formule birajući Tools / Options / izaberite karticu View i potvrdite Formulas (ili pritisnite Ctrl+').

2. Štampajte radni list.

savet: Štampanje formula je korisnije kada se štampaju i zaglavlja redova i kolona. 

Izaberite File > Page Setup a zatim karticu Sheet i potvrdite opciju Row and column headings.

U ovom poglavlju upoznali ste Excelove mogućnosti štampanja. Mnoge opcije koje su u tom smislu na raspolaganju omogućavaju da istaknete značajne podatke i napravite impresivne dokumente u širokom spektru formata.

1.6.5.8 Štampanje skupova iz raznih radnih listova na istoj strani

Pretpostavimo da imate četii-i radna lista od kojih svaki ima malu tabelu koju želite da štampate. Umesto da štampate četiri odvo-jene strane sa po jednom malom tabelom, prevarite Excel da štampa sve tabele na jednoj strani. Trik j'e u tome da stavite slike sve četiri tabele u jedan radni list:

1. Izaberite prvu tabelu, a zatim izaberite Edit >- Copy.
2. Aktivirajte radni list u koji prenosite tabele, pa izaberite ćeliju gde želite da prenesete sliku. Pritisnite i držite taster Shift, i izaberite Edit  / Paste Picture Link. Time prenosite kopirane ćelije kao objekat na radni list.
3. Ponovite korake 1 i 2 za sve tabele.
4. Pomoc'u koordinatne mreze radnog lista poravnajte slike međusobno - držite taster Alt dok povlačite da biste svaku sliku pre-cizno postavili na mreži.
5. Izaberite File > Print Preview da biste proverili izgled radnog lista pre štampanja.
Podrazumeva se da su slike povezane sa izvornim ćelijama. Kada izaberete povezanu sliku, referenca izvorne c'elije prikazuje se u liniji za formule. U liniji za formule možete izmeniti izvornu referencu, ili je sasvim ukloniti. Kada je uklonite, slika postaje statična.

Povećanje produktivnosti

1.6.6 Ispravljanje grešaka poništavanjem izdatih komandi

Mnoge stvari koje uradite u Excelu možete da vratite u prethodno stanje ukoliko upotrebite komandu 

Edit > Undo. Excel 8 je proširio mogućnosti na ovom planu tako da sada podržava vraćanje 16 koraka unazad. Izuzev u par slučajeva to znači da možete opozvati poslednjih 16 aktivnosti. Na taj način možete da popravite greške pri upisivanju, uređivanju, umetanju, brisanju i mnogim drugim slučajevima gde se one najčešće prave. Poništavanje ne morate izvoditi redom (ponovljenim pritiskanjem tastera Undo); Excel 8 nudi padajuću listu za obe komande namenjene ispravljanju gresaka, Undo i Redo, omogućavajući vam da izaberete nekoliko (uzastopnih) aktivnosti i poništite ih jednim pritiskom tastera miša.

Međutim, ima stvari koje se ne mogu popraviti bilo zbog same svoje prirode bilo zbog ograničenja koje nameće memorija. Na primer, ne možete poništiti komandu File > Save ili File > Close, opozvati brisanje ili umetanje radnog lista, brisanje imena ili postavljanje preloma strane.

napomena: Ako ozbiljnu grešku uočite prekasno, možete da zatvorite datoteku bez snimanja, a zatim da je ponovo otvorite.

1.6.6.1 Ponavljanje poslednje komande pomoću Edit > Repeat
Komanda Edit > Repeat koristi se za (brzo) ponavljanje poslednje komande koju ste upotrebili. Na primer, formatirate ćeliju sa nekoliko kombinacija tastera. Ponovite isti proces na drugim ćelijama pomoću Edit 2- Repeat.

1.6.6.2 Transponovanje redova i kolona
Pretpostavimo da podatke uredene po redovima želite da upišete u kolone. Pogledajte primer:

Pošto unesete konstante u prazan radni list postupite na sledeći način da ih transponujete:

1. Istaknite ćelije B2:E3.

2. Izaberite komandu Edit >- Copv.

3. Istaknite ćeliju B5.

4. Izaberite Edit / Paste Special. Pojavljuje se okvir za dijalog Paste Special.

5. Potvrdite opciju Transpose i pritisnite OK. Podaci se transponuju iz redova u kolone.

1.6.6.3 Unošenje kopirane ćelije sa Enter
Kopirane ćelije mogu da se unesu pritiskom na Enter  umesto komandom Paste:

1. Kopirajte ćelije.

2. Izaberite ćeliju u koju treba da unesete kopiju.

3, Pritisnite Enter.                                                 

Taster Enter možete da upotrebite i za popunjavanje skupa ćelija.

1. Kopirajte ćeliju.

2. Izaberite skup koji treba da se popuni.

3. Pritisnite Enter.

1.6.6.4 Izračunavanje vrednosti izraza sadržanih u formuli
Forrnula se često odnosi na ćelije koje se ne vide. Kada unosite, menjate ili otklanjate greške u takvoj formuli, možete da potrošite puno vremena na pomeranje lista da biste proverili vrednosti ćelija na koje se formula odnosi.

Umesto toga možete da istaknete referencu ćelije u liniji za formule (ili unutar ćelije) i pritisnete F9. Referenca ćelije se zamenjuje vrednošću ćelije. Ova tehnika se ne odnosi samo na referencu ćelije; možete da istaknete i bilo koji izraz, na primer (A1*B1)/C1; kada pritisnete F9 ceo izraz se zamenjuje izračunatom vrednošću.

Posle provere vrednosti izraza, ne smete da zaboravite da poništite zamenu (pritiskom na Esc). U suprotnom, ako pritisnete Enter, ceo izraz će biti zamenjen izračunatom vrednošću.

1.6.6.5 Unošenje iste formule u više ćelija
Kada pravite ili formatirate nove radne listove često vam je potrebno da jednu istu formulu unesete u više različitih ćelija. Sledeći postupak omogućava da unesete istu formulu (ili konstantu) u nekoliko ćelija:

1. Izaberite ćelije (selekciju mogu da čine i nesusedne ćelije).

2. Upišite formulu.

3. Pritisnite Ctrl+Enter, umesto samo Enter.

1.6.6.6 Prikazivanje više redova u ćeliji

Pretpostavimo da se u ćeliji nalazi nekoliko reči koje želite da prikažete u više redova. Problem možete rešiti na dva načina. Prvi je korišćenje formatiranja. 

Izaberite Format > Cells > Alignment i potvrdite opciju Wrap text. Međutim, opcija Wrap text ne omogućava kontrolu mesta na kome će se desiti prelom.

Evo drugog načina: pritisnite Alt+Enter na mestu gde hoćete prelom reda.

1.6.6.7 Kako da brzo napravite tabelu sa brojevima

Kada pravite prototip radnog lista, bio on jednostavan ili složen, moraćete periodično da ga testirate tokom izrade. Ponekad ne raspolažete pravim podacima već koristite proizvoljne nasumično odabrane podatke. Podaci za testiranje mogu se uneti brže od stvarnih podataka, što vam može uštedeti vreme tokom testiranja. Pogledajte tehniku kojom možete brzo da unesete skup slučajnih brojeva u radni list:

1. Izaberite skup čelija.

2. Unesite formulu =RAND(), zatim pritisnite Ctrl+J. Time smeštate funkciju za generisanje slučajnih brojeva u taj skup ćelija.

Da biste funkciju RAND() sprečili da popunjava tabelu novim slučajnim brojevima svaki put kada se radni list preračunava, postupite ovako:

1. Izaberite skup ćelija pa izdajte komandu Edit / Copy da ih kopirate.

2. Izaberite Edit / Paste Special, zatim Values, pa pritisnite OK.

Ova procedura kopira vrednosti ćelija i zamenjuje formulu u svakoj ćeliji odgo-varajućom vrednosću.

Funkcija RAND generiše brojeve iz intervala 0 do 1. Pogledajte dva nacina za generisanje brojeva sličnijih podacima koje simulirate:

-RAND(  )*1000         Generiše slučajne brojeve u rasponu 1 do 1000. 

-INTiRANDt )*1000)     Generiše slučajne cele brojeve u rasponu 1 do 1000.

1.6.6.8 Unošenje brojeva sa automatskim odvajanjem decimalnih mesta

Za računovodstvo je karakteristično da se unose brojevi sa dva decimalna mesta. Excel može da se konfiguriše za unos ovog tipa podataka:

1. Izaberite Tools / Options /  karticu Edit. Potvrdite Fixed decimal.

2. Unesite broj decimalnih mesta.

1.6.6.9 Automatsko pomeranje aktivne ćelije posle pritiska na Enter

Podrazumeva se da se izbor aktivne ćelije pomera na donju ćeliju posle pritiska naJ. U nekim situacijama (unošenje kolone brojeva, na primer) ovakvo ponašanje je poželjno. U drugim slučajevima bilo bi korisnije kada bi se aktivna ćelija pomerala na gore, ulevo ili udesno, ili kada se uopšte ne bi pomerala posle pritiska na Enter. Ovakvo ponašanje kontroliše se na sledeći način:
1. Izaberite komandu Tools / Options i karticu Edit .
2. Potvrdite opciju Move selection after Enter pa iz padajuće liste Direction izaberite smer pomeranja.
1.6.6.10 Uređivanje više radnih listova u isto vreme

Radne sveske često sadrze radne listove sa dosta sličnih podataka. Uštedećete znatno vreme ukoliko uređujete i formatirate slične radne listove istovremeno. Kada uređujete više radnih listova, osnovni raspored svakog lista treba da je identičan; ako, na primer, promenite vrednost u ćeliji B5, ona će biti promenjena i u svim ćelijama B5 izabranih radnih listova. Izaberite grupu radnih listova koje hoćete da uredujete. Sve sto unosite, uredujete i formatirate biće primenjeno na svaki radni list iz grupe.

Jedan od načina da izaberete vise radnih listova u isto vreme jeste da držite taster Ctrl dok mišem birate jezičke radnih listova 

1.6.6.11 Unošenje brojeva i datuma

Excel raspolaže mnoštvom formata za brojeve i datume a omogućava i definisanje novih. Ponekad će pokušati i da nametne neki format. Na primer, ako u neku ćeliju upišete broj 9-2 (ili razlomak 9/2) Excel će misliti da hoćete da upišete datum 2. septembar pa će primeniti format za datum (u prethodno podešenom formatu) umesto za broj. Da biste nadjačali ovu njegovu tendenciju dovoljno je da ispred broja stavite jedan razmak. Evo još nekoliko prečica za formatiranje ćelija:

1.6.6.12 Unošenje broja koji će biti tretiran kao tekst  

Ponekad je potrebno da se broj unese kao tekst (na primer, poštanski broj 07384 bi izgubio 0 kada bi bio unesen kao broj). Da unesete broj kao tekst, upišite apostrof ispred broja: '07384.

1.6.6.13 Formatiranje broja sa zadržanom nulom na prvom mestu 

Ponekad je potrebno da upišete broj ali tako da ne izgubi 0 kao prvu cifru. Pretpostavimo da vam treba popis svih delova u skladištu, a svaki deo ima petocifreni inventarski broj(na primer, inventarski broj nekog proizvoda može da bude 00284). Rešenje je da upotrebite format 00000, koji zadržava vodeće nule u petocifrenim brojevima. Da biste primenili namenski format na izabrane ćelije, izaberite Format> Cells, zatim karticu Number pa kategoriju Custom. Upišite format u polje Type.

1.6.6.14 Unosenje tekućeg datuma i vremena  

Sledeća kombinadja tastera smestiće tekući datum i vreme u ćeliju, ili usred formule:

Ctrl+;   (Ctrl+tačka i zarez) unosi tekući datum 

Ctrl+:   (Ctrl+dve tačke) unosi tekuće vreme

1.6.7 Radne sveske, radni listovi i prozori

Naredni odeljci omogućavaju efikasniji rad sa radnim sveskama, radnim listovima i prozorima.

1.6.7.1 Prečica za otvaranje radnog lista

Kada radna sveska sadrži mnogo listova korišćenje dugmadi za pomeranje listova u dnu Excelovog prozora može biti zametno. Možda cete morati više puta da pritisnete taster miša tražeći neki radni list. Evo zgodne prečice: pritisnite desni taster miša pokazujući na neko od dugmadi za pomeranje listova (ne pritiskajte jezičak lista) i pojaviće se spisak listova koji vam omogućava da izaberete koji ćete list da aktivirate.

1.6.7.2 Snimanje radnog prostora

Često je potrebno da istovremeno koristite nekoliko radnih svezaka, a postupak njiho-vog otvaranja i organizovanja na ekranu oduzima mnogo vremena. Kada izaberete komandu File / Save Workspace, Excel ,,pamti" imena svih otvorenih radnih svezaka kao i organizaciju prozora. Ovu informaciju upisuje u datoteku za radni prostor sa nastavkom .XLW. Kada kasnije otvorite datoteku sa prostorom za rad pomoću komande File / Open, radne sveske se automatski otvaraju i raspoređuju.

upozorenie: Radne sveske se ne snimaju fizički u datotekama prostora za rad - snimaju se samo imena radnih svezaka i organizacija prozora. Prema tome, snimanje datoteka sa prostorom za rad ne ukida potrebu za snimanjem radne sveske (pojaviće se pitanje da li želite da snimite radnu svesku pre nego što je zatvorite).

1.6.7.3 Automatska izrada rezervnih kopija

Excel možete podesiti tako da automatski pravi rezervnu kopiju datoteke pre njenog snimanja na disk. Izaberite komandu File / Save As, pritisnite dugme Options, zatim potvidite opciju Always create backup.

upozorenje: Automatski snimljene rezervne datoteke se čuvaju sa oznakom .XLK. Ukoliko u istom direktorijumu imate datoteku ANALIZA.XLS i šablon ANAI.IZA.XLT, obe podešene da snimaju rezervne datoteke, Excel neće obe rezervne datoteke sačuvati kao ANALIZA.XLK. Napraviće rezervnu kopiju samo one datoteke koja je prva snimljena.

Ovakva postavka osigurava dodatnu bezbednost. Na primer, pretpostavimo da ste pogrešili dok ste uređivali datoteku PRODAJA98, da greške ne mogu da se uklone pomoću Edit / Undo, a datoteka je postavljena za izradu rezervne kopije.Na stariju verziju datoteke možete da se vratite pomoću jedne od ove dve metode:

Ako su greške učinjene posle poslednjeg snimanja datoteke, izaberite File > Open PRODAJA98. Pojaviće se poruka: datoteka PRODAJA98 je već otvorena. Ponovno otvaranje izbrisaće sve promene koje su u njoj učinjene. Želite li da je ponovo otvorite?

Izaberite ,,Yes". Nestaće sve izmene nastale posle poslednjeg snimanja datoteke. Ako ste načinili grešku pre poslednjeg snimanja datoteke, zatvorite je tako da ne snimite izmene koje sadrže grešku. Sledeći korak je da otvorite datoteku PRODAJA98.XLK. Pošto nije mudro da nastavite rad u datoteci sa oznakom .XLK, odmah joj dodelite drugo: Automatski snimljene rezervne kopije nisu zamena ,,stvarnim" (kopijama na disketama ili magnetnoj traci) koje treba revnosno da pravite u redovnim intervalima. 

1.6.8 Ubrzavanje unosa podataka opcijom Autofill

Opcija AutoFill (objašnjena u ovom odeljku) omogućava da utrošite manje vremena za popunjavanje ćelija podacima tako što nizove brojeva, dana u nedelji, meseci itd. u datim ćelijama automatski produžavate na susedne ćelije. Na primer, upišete dan u nedelji u izabranu ćeliju a zatim ručicom za popunu popunite susedne ćelije preostalim danima.

1.6.8.1 Upotreba ručice za popunu

Ručica za popunu (engl. fill hanclle) je prečica za automatsku popunu skupa ćelija serijom vrednosti. Ručica za popunu je mali crni kvadrat koji se nalazi u donjem desnom uglu izabrane ćelije ili grupe ćelija.

napomena: Ukoliko se rućica za popunu ne pojavljuje na radnom listu, izaberite komandu Tools / Options, zatim karticu Edit pa potvrdite opciju Allovv cell drag and drop.

Da biste skup ćelija popunili imenima meseci, postupite na sledeći naćin:

1. Unesite Jan u ćeliju Al.

2. Mišem pokažite na ručicu za popunu - pokazivač miša postaje crni krstić.

3. Povucite pokazivač kroz red do ćelije Ll, zatim oslobodite taster miša. Nazivi meseci od Jan do Dec biće uneti u ćelije Al do Ll.

savet: Dok povlačite ručicu za popunu  pojaviće se obaveštenje sa sadržajem poslednje ćelije u nizu; ako treba da unesete mesece u godini počev od januara i zaključno sa Decembrom, vucite ručicu dok se ne pojavi obaveštenje Decembar - ne treba da brojite ćelije.

1.6.8.2 Uspostavljanje AutoFill trenda

U prethodnoj vežbi svaki AutoFilI bio je zasnovan na jednoj početnoj vrednosti. Ako se kao početni skup za AutoFill izaberu dve ili više vrednosti, Excel pokušava da odredi trend i prema tome automatski obavi popunu.

1. Upišite sledeće vrednosti

2. Izaberite ćelije od Al do B5.

3. Izaberite ručicu za popunu i povucite do ćelije H5. Rezultat će biti sledeći:

Svaka ćelija je popunjena u skladu sa trendom uspostavljenim u prve dve kolone.

1.6.8.3 Vežba za AutoFill

Ova vežba pokazuje neke druge tipove podataka kojima ćelije mogu da se popune automatski.

Unesite podatke u prvu kolonu praznog lista, izaberite ćelije od A1 do A7 i povucite ručicu za popunu do ćelije H7.

1.6.8.4 AutoFill zasnovan na susednim ćelijama

Skup ćelija koje su susedne skupu podataka možete automatski da popunite tako što ćete dvaput da pritisnete mišem na ručicu za popunu. Tako automatski popunjavate red ili kolonu:

1. Upišite brojeve u ćelije Bl do B4.

2.Upišite Kl u ćeliju Al.

3. Pritisnite dvaput na ručicu za popunu na ćeliji Al. Ćelije Al do A4 biće popunjene sa Kl do K4.
1.6.8.5 Upotreba namenskih Autofillova

OpcijaAutoFill omogućava brzo unošenje meseci, datuma, godina i tekstualnih vrednosti u skup ćelija. Objasnićemo definisanje namenskih lista koje AutoFill može da prepozna. Ako, na primer, radite u preduzeću koje posluje na četiri tržišta (Istok, Zapad, Sever i Jug) i često morate da upisujete nazive tržišta u radni list, primenom namenski prilagođenog AutoFilla postići ćete značajnu uštedu u vremenu potrebnom za unošenje ovih podataka.

1.6.8.6 Definisanje namenskih lista

Da biste definisali namensku listu, postupite na sledeći način:

1. Unesite listu u (neprekinut) skup ćelija, u red ili u kolonu.

2. Istaknite skup ćelija koji sadrži listu.

3. Izaberite komandu Tools > Options, zatim karticu Custom Lists .

4. Pritisnite dugme Import; lista će se prikazati u okviru Custom lists.

5. Pritisnite OK.

savet: Nije neophodno da se lista prvo unese u ćelije. Ona može da se upiše u polje List entries , ali je u principu lakse raditi sa ćelijama.

Kada se namenska lista definiše, ona je uvek i svuda dostupna.Ne čuva se u posebnoj radnoj svesci.

1.6.8.7 Primena namenskog AutoFilla

Primena AutoFilla na namenske liste ne razlikuje se od primene ove opcije na ugrađene liste:

1. U ćeliju unesite jednu ili više vrednosti iz liste.

2. Mišem uhvatite ručicu za popunu i povucite je (u bilo koni smeru).

Pretpostavimo sada da pravite listu koja se sastoji od tržišta Sever, Jug, Istok i Zapad. U ćeliju možete da unesete naziv bilo kog od ćetiri tržišta i potom primenite AutoFill.

1.6.8.8 Uređivanje i brisanje liste

Dijalog Custom Lists  može se upotrebiti i za izmenu ili brisanje namenske liste. Otvorite okvir za dijalog, izaberite listu iz okvira Custom lists, zatim:

• Pritisnite dugme Delete da obrišete listu.

• Listu izmenite izmenom sadržaja polja List entries.
savet: Namenske liste se mogu upotrebiti i za sortiranje podataka redosledom različitim od rastućeg ili opadajućeg.

1.6.8.9 3-D popune

Upotrebite Edit / Fill / Across Worksheets da više listova popunite podacima (kopirate podatke u više listova). Napravite novu radnu svesku i uradite sledeću vežbu:

1. Unesite bilo koje podatke u skup B2:C3 lista Sheetl.

2. Istaknite B2-.C3.

3. Držeći taster Ctrl izaberite radne listove koje želite da popunite; u ovom slučaju, Sheet2 i Sheet4.

4. Otpustite taster Ctrl i izaberite Edit  / Fill / Across Worksheets; pojavljuje se okvir za dijalog:Fill Across Worksheets

5. Izaberite podatke kojima se popunjava, u ovom slučaju All, i pritisnite OK. Podaci iz  Sheet1 !B2:C3 kopiraju se u isti skup na listovima Sheet2 i Sheet4.

1.6.9 Prilagođavanje komandnih paleta

Pre Excela 8 palete alatki i linije menija bile su potpuno različite životinjke. Palete alatki sastojale su se od dugmadi i drugih  ikonica. Linije menija, na primer podrazumevani meni radnog lista (sa menijima File, Edit i ostalim), sačinjavao je samo tekst. Obe vrste objekata služile su istoj nameni - obezbeđivanju interfejsa za izdavanje komandi. Sada su oni spojeni u isto živinče, najćešće poznato kao komandna paleta.. Komandna paleta može da sadrži dugmad, tekst i padajuće menije. Time se dobija ne samo fleksibilniji interfejs već to istovremeno znači da ćete manje morati da učite kada budete savladavali pravljenje komandnih paleta. Jedan skup znanja zamenjuje dva koji su bili potrebni do sada. U narednoj diskusiji termin komandna paleta koristi se da opiše i menije i palete.

Pored podrazumevane linije menija (koja je komandna paleta za sebe) u Excelu postoji i više od dvadeset različitih komandnih paleta. Kada bi sve bile na ekranu ne bi ostalo skoro nimalo mesta za prikazivanje radnih listova. Međutim, možete jednu ili vise komandnih paleta podesiti da sadrže komande koje najčešće koristite a možete da napravite i sopstvene.

1.6.9.1 Dodavanje komandi na ugrađenu komandnu paletu

Da biste namenski prilagodili komandnu paletu ona mora biti vidljiva. 

Izdajte komandu View / Toolbars (ili otvorite priručni meni pritiskom na desni taster misa pokazujući na liniju inenija) i pojaviće se spisak komandnih paleta iz kojeg možete da birate onu koja vam treba.

Drugi način da odaberete komandnu paletu koja će se videti je komanda Tools / Customize / Toolbars . Potvrdite one koje treba da se vide a uklonite potvrdu sa onih koje hoćete da sakrijete. Pretpostavimo da želite da dodate neku komandu na paletu Standard.. Pritisnite zatim jezičak Commands pri vrhu dijaloga. Na raspolaganju je bezbroj komandi. Mnoge, na primer File / Save, poznajete od ranije. Neke su prilično opskurne. Da biste videli opis komande, izaberite je (pritisnuvši je jednom) pa pritisnite dugme Description. Komanda se dodaje na paletu tako što se odvuče na postojeću paletu i tamo spusti. Da biste je uklonili sa palete otvorite dijalog Customize pa odgovarajuće dugme povlačenjem vratite na okvir za dijalog.

Liniju menija takode možete prilagoditi tako što ćete najpre izabrati Tools / Customize da prikažete istoimeni okvir za dijalog. Zatim dovlačenjem ili odvlačenjem direktno na liniju menija ili prethodnim otvaranjem menija premestite komandu sa ili na okvir za dijalog. Na ovaj način možete da premestite i čitave menije sa linije menija na drugu komandnu paletu ili da ih jednostavno prevučete na radnu površinu i tako ih sakrijete. Da biste liniju menija ponovo vratili u prethodno stanje izaberite Tools / Customize pa na kartici Toolbars potvrdite opciju Worksheet Menu Bar i pritisnite Reset.

1.6.9.2 Pravljenje nove komandne palete

Da biste napravili novu komandnu paletu pritisnite New u dijalogu Customize/Toolbars . Upisite ime nove palete i pojaviće se prazna komandna paleta kojoj možete da dodajete komande na isti način kako ste to radili kada ste ih dodavali ugrađenoj paleti - jednostavno ih prevlačite sa dijaloga Customize/Toolbars .

Preostala tri dugmeta u okviru za dijalog Customize/Toolbars namenjena su samo namenskim paletama. Svako od tih dugmadi zahteva da prethodno izaberete namensku paletu u listi Toolbars:

Rename: Pritisnite ovo dugme da biste promenili ime izabrane namenske palete.

Delete: Ovim dugmetom brišete izabranu namensku paletu. Ovu akciju moraćete da potvrdite.

Attach: Koristite ovu komandu da priključite namenski izrađenu komandnu paletu odrcdenom radnom listu. (Komandna paleta postaje deo Excelove datoteke). Kada radnu svesku date drugim korisnicima, namenska paleta će se videti kada se radna sveska otvori.

1.6.10 Upotreba matričnih formula

Matrićne formule (engl. array formulas) su posebne formule koje se primenjuju na pravougaone šeme podataka (matrice). Mnogi korisnici Excela ih godinama rado upotrebljavaju za matrične aritmetičke proračune. 

Matrične formule se unose u pravougaone skupove ćelija, čak i kada se skup sastoji od samo jedne ćelije. 

1. Na praznom radnom listu istaknite ćelije B2-.C3.

2. Upišite sledeću forrnulu: =1

3. Završite formulu držeći tastere Ctrl+Shift dok pritiskate Enter.

U četiri ćelije uneta je ista matrična formula. Formula je u liniji za formule uokvirena vitičastim zagradama: (=l). Za ovakvu formulu se kaže da  je uneta  matrično (engl. array-eiitered). Vitičasta zagrada je posledica ovakvog načina unosenja. Da ste sami upisali vitičaste zagrade, uneli biste tekstualnu konstantu, ne matričnu formulu.

Matrične formule nameću nekoliko ograničenja:

• Ne mogu se menjati pojedinačne ćelije obuhvaćene matricnom formulom. Ako izmenite formulu u bilo kojoj ćeliji, tbrmula će se izmeniti i u svim ostalim.

• U skupu ćelija obuhvaćenih matričnom formulom ćelije se ne mogu umetati ni brisati.

• Pri izmeni formule unos morate da završite pomoću Ctrl+Shift+Enter, upravo kao kada se formula prvi put unosi.

• Matrična formula je ograničena na približno 1.600 ćelija.

savet: Ako želite da izaberete ceo skup obuhvaćen formulom, izaberite ćeliju skupa, komandu Edit / Go To, pntisnite Special, izaberite opciju Current Array i pritisnite OK. Prećica na tastaturi je Ctrl+/.

napomena: Pravougaoni skupovi (polja) mogu se izraziti kao konstante. 

1.6.11 Imena

Usvom najjednostavnijem  obliku ime je obeležje ćelije ili skupa ćelija koje je prepoznatljivo i lako za pamcenje. Na primer, ime Prodajal998 lakše se prepoznaje i pamti od ćelijske adrese B4:G18.

Upotreba imena je vrlo važna navika koju mnogi korisnici Excela previđaju. Kada radite sa modelima srednje složenosti, ili čak i sa jednostavnim modelima sa medusobno povezanim radnim sveskama, važno je da naučite osnovne tehnike imenovanja.

U ovom poglavlju naučićete kako se imenuju ćelije, konstante i formule, i kako se ta imena koriste u formulama.

Korisćenje referenci sa rečima običnog jezika, o čemu je bilo reći u četvrtom poglavlju, delom je osujetilo korišcenje ,,pravih" imena - ali samo delom. 

Imena mogu biti od velike koristi jer donose mnoge prednosti - poboljšavaju jasnost, obezbeduju integritet referenci, dopfinose funkcionalnosti i povećavaju produk-tivnost.

1.6.11.1 jasnost i dokumentovanost

Kasnije u ovom poglavlju naučićete o značaju funkcionalnosti koja se postiže korisćenjem imena. Štaviše, dovoljno je što doprinose povećanju jasnosti. Programi za tabelarne proračune poznati su po sindromu ,,špageti koda" a imena su važno sredstvo za njegovo minimiziranje.

 OIakšano je održavanje i razumevanje formula. Formula =Promet-Rashodi ima

mnogo više smisla od =C3-B3, naročito ako je posle šest meseci potrebno preraditi radni list.

• Konvencije o imenovanju sprovedene u celoj organizaciji olakšavaju razumevanje formula različitim korisnicima zajedničke radne sveske.

Imena treba da budu sastavni deo vaše strategije čak i ako razvijate modele srednje složenosti.

1.6.11.2 Bolja povezanost radnih svezaka

U modelu sa jednom radnom sveskom imena doprinose jasnosti ali ako ih ne koristite nije strašno. Kada se vrednost pomeri zato što ste nešto izbrisali ili umetnuli, formule koje se odnose na originalnu ćeliju automatski će se prilagoditi. Modeli sa više radnih svezaka su druga priča: imena su od vitalnog interesa jer se zahvaljujući njima održava integritet referenci. Zamislite sledeći slučaj:

Otvorene su dve radne sveske, DETALJNA i UKUPNA i neka je UKUPNA zavisna radna sveska koja se poziva na ćeliju A3 iz sveske DETALJNA. Ako zatvorite zavisnu radnu svesku UKUPNA pa na početak sveske DETALJNA dodate nov red, vrednost iz celije A3 je sada u ćeliji A4. Kada se ponovo otvori sveska UKUPNA, ona se i dalje poziva na ćeliju A3 umesto na ćeliju A4.

Kada se ćelija premesti, premešta se i njeno ime. Da se sveska UKUPNA pozivala na ćeliju DETAIJNA!A3 po imenu, ne bi bilo zabune izazvane umetanjem novog reda.

1.6.11.3 Poboljšana funkcionalnost

Imena su više od ukrasa! Tehnike imenovanja obuhvaćene ovim poglavljem povećavaju funkcionalnost:

• Imenovane formule čine logiku jasnijom i mogu biti moćan gradivni element u složenim formulama.

• Imena mogu da se upotrebe za obrazovanje skupova koji se dinamički šire i smanjuju.

1.6.11.4 Veća produktivnost

Imena poboljšavaju produktivnost jer se pomoću njih brže kreće kroz radne listove i jednostavnije unose formule:

• Otvaranjem liste iz polja za ime na liniji formule, brzo se prelazi na imenovani skup.

• Imena umanjuju mogućnost greške izazvane pogrešnim upisivanjem. Kada se upiše pogresno ime, pojavljuje se upozorenje.

• Unošenjem imena u formule pojednostavljuje se pisanje formula.

1.6.11.5 Regularna i neregularna imena

Pravila za definisanje imena su:

• Ime može da sadrži samo sledeće znakove: slova od A do Z (dozvoljena su i velika i mala slova), brojeve od 0 do 9, tačku i znak za podvlačenje. Prvi znak mora da bude slovo ili znak za podvlačenje.

• Ime ne sme biti duže od 255 znakova.

• Ime ne sme da bude isto kao referenca ćelije, na primer B3 ili G1998.

Slede primeri regularnih i neregularnih imena:

Regularna imena    
Neregularna imena
Promet.Prošle.Godine 
95.Promet (počinje brojem) 

Zarada_1997 

Bruto Dobit (sadrži razmak)) 

PojedinačnaCena Rad 
A1 (isto kao referenca ćelije

Rad 


R2C2 (isto kao referenca ćelije)

1.6.11.6 Imena i velicina slova

U irnenima se ne pravi razlika izmedu velikih i malih slova. Ako definišete ime PROMET a zatim ime Promet, drugo ime će zameniti prvo. S druge strane, imena zadržavaju veličinu slova (velika ili mala) kojom su napisana. Kada se ime koristi u formuli, automatski će biti upotrebljena ista veličina slova kao i pri njegovom definisanju. Ako je ime definisano kao BrutoDohodak, a u formulu unesete =brutodohodak, formula će se automatski pojaviti u obliku =BrutoDohodak kada se pritisne Enter.

savet: Korisno je da se za imena uvek koristi kombinacija velikih i malih slova. Formule se obićno unose samo malim, ili samo velikim slovima. Pošto se imena uvek pojavljuju u prvobitno definisanom obliku sa kombinacijom malih i velikih slova, odmah ćete uočiti da li je ime pogrešno uneto - neće se pojaviti u kombinaciji velikih i malih slova.

1.6.11.7 Imenovanje ćelija

Postoji više načina da se ćelijama daju iinena: korišćenjem polja za ime, dijaloga Define Name i dijaloga Create Names.

1.6.11.8 Korišćenje polja za ime

Ćeliji se ime najbrže daje pomoću polja za ime koje se nalazi sa leve strane linije za formule.

1. Izaberite jednu ćeliju (ili skup ćelija) kojoj želite da date ime.

2. Izaberite polje za ime (ne dugme sa strelicom):

3. Upišite ime, zatim pritisnite Enter

upozorenje: Polje za ime neće dozvoliti da slučajno pišete preko imena ćelije ako ga izabrana ćelija već ima, ali će dozvoliti da pišete preko innena konstante i formule, bez upozorenja.

1.6.11.9 Korišćenje dijaloga Define Name

Dijalog Define Name služi da dajete imena ćelijama, a kasnije u poglavlju koristiće se i za imenovanje konstanti i formula:

1. Izaberite ćeliju (ili skup ćelija) kojoj želite da date ime.

2. Izaberite komandu Insert / Name / Define, ili pritisnite Ctrl+F3 da prikažete dijalog Define Name 

3. Upišite regularno ime u polje Names in workbook.

4. Polje Refers to prikazuje referencu tekuće selekcije. (Ukoliko hoćete da imenujete neku drugu selekciju možete da upisete novu referencu - polje popunite tako što pokažete i pritisnete selekciju na radnom disku (možete da se poslužite dugmetom za smanjenje dijaloga sasvim desno u polju, ako je potrebno). 

5. Pritisnite OK da završite posao, ili Add da dodate još neko ime ne zatvarajući dijalog Define Name.

savet: Excel će predložiti ime ukoliko aktivna ili susedna ćelija sadrže tekst koji još nije upotre-bljen kao ime.

upozorenje: Dijalog Define Name dozvoljava da se, bez upozorenja, piše preko postojećih imena, iako se ona nalaze u spisku Names in workbook i može da se proveri da li se određeno ime već koristi.

1.6.11.10 Korišćenje dijaloga Create Names

Dijalog Create Names je izvor mnogih zabuna kod većine korisnika zbog nejasne razlike izmedu ovog dijaloga i dijaloga Define Name. Posmatrano sa funkcionalne strane dijalog Define Name omogućava da se definišu neke stvari koje se ne mogu definisati u dijalogu Create Names (o čemu će biti reči kasnije u poglavlju). Medutim, dijalog Create Names ima dve ključne prednosti nad dijalogom Define Name:

• Ako pokušate da pišete preko postojećeg imena, ispisuje se upozorenje.

• Jednom komandom možete da imenujete više ćelija

Dijalog Create Names omogućava da imenujete ćelije na osnovu sadržaja susednih ćelija. Na primer, pretpostavimo da ćelija Al sadrži tekst Istok a ćelija A2 Zapail. Ćelije Bl i B2 mogu se imenovati jednim potezom korišćenjem teksta u ćelijama Al i A2 za imena ćelija Bl i B2. Sledeća vežba ilustruje postupak. Koristeći jednu komandu napravićete tri imena.

1. U prazan radni list unesite sledeće vrednosti:

2. Izaberite ćelije od Al do B3, zatim komandu  lnsert / Name / Createi.potvrdite samo parametar Left Colurnn

3. Pritisnite OK.

Ćelije Bl, B2 i B3 dobiće imena prema tekstu iz ćelija Al do A3. Ćelija Bl dobila je ime Ime l, B2 line2 a B3 Ime3. Ćak i ako izbrišete vrednosti u ćelijama A1:A3, ćelije Bl, B2 i B3 zadržaće svoja imena. Pomoću polja za ime testirajte nova imena - izaberite ime iz liste i imenovana ćelija biće istaknuta.

Ukoliko ime već postoji, pojaviće se sledeće upozorenje:

Pritisnite Yes da zamenite staro ime, No da ostavite staro ili Cancel da otkažete celu operaciju.

1.6.11.11 Imenovanje nesusednih ćelija

Skup ne mora da se sastoji samo od susednih ćelija da bi se vodio pod jednim imenom. Skupu nesusednih ćelija ime se daje pomoću dijaloga Define Name ili polja za ime (dijalog Create Names ne može da se upotrebi). Stvar je prosta: izaberete dva ili više skupova nesusednih ćelija (izaberete jedan a zatim držeći pritisnut taster Ctrl birate preostale), a zatim upotrebite dijalog Define Name ili polje za ime na isti način kao što ste to radili u slučaju imenovanja običnog skupa.

Ako se skup sastoji od mnogo nesusednih delova, upis Refers to može da postane predugačak. Budite pažljivi jer je Refers to ograničen na 255 znakova.

1.6.11.12 Brisanje imena

Ako želite da obrišete imena, bez obzira na tip imena (ćelije, konstante, formule), postupite na sledeći način:

1. Izaberite komandu Insert  / Name / Define da otvorite dijalog Define Name .

2. Izaberite ime koje želite da izbrišete sa liste Names in workbook.

3. Pritisnite Delete.

upozorenje; U svakoj ćeliji koja se poziva na izbrisano ime pojaviće se poruka #NAME? koja upozorava na grešku jer ime na koje se poziva više ne postoji.

1.6.11.13 Pozivanje na imenovane celije u formulama

Imenovana ćelija, ili skup ćelija, jeste ćelija sa apsolutnom adresom. Sledeće formule podrazumevaju da je ćelija $A$1 nazvana Profit i da su ćelije $B$1:$B$3 nazvane Pojedinačni.

=Profit 


izjednačiti sa ćelijom Al

=Profit*2 


pomnožiti Al sa 2

=SUM(Pojedinačni) 
sabrati ćelije B1:B3

=AVERAGE(Pojedinačni) pronaći srednju vrednost ćelija B1:B3

=Profit+SUM(Pojedinačni) dodatiAl zbiru B1:B3

Kao i u slučaju formula sa običnim jezikom, pozivanje ćelija po imenu sasvim je jednostavno. Umesto adrese ćelije, u formuli se koristi ime ćelije.

1.6.11.14 Unošenje imena u formule

Dok unosite ili menjate formulu, imena se mogu unositi iz liste umesto da se upisuju. To je koristan postupak kada ne možete da se setite imena, a ne želite da ga upišete pogrešno, ili ste suviše lenji da ga upisujete. Sledeći primer ilustruje postupak:

1. Nazovit" ćeliju Al BrutoDohodak i unesite 100.
2. Izaberite ćeliju Bl. Počnite formulu upisivanjem znaka jednakosti.

3. Izaberite Insert / Name / Paste, pa iz liste Paste name izaberite ime BrutoDohodak. Ime će biti dodato formuli.

4. Upišite *2 (da pomnožite sa 2), zatim pritisnite Enter. Ćelija Bl biće jednaka 200.

savet: Polje za ime nabraja samo imena pojedinačnih ćelija ili skupova ćelija. Ako hoćete da unesete ime formule ili konstante, upotrebite komandu Insert / Name / Paste.

1.6.12 Imenovanje po završenom poslu

Za trenutnu upotrebu, formule se lakše konstruišu kada se ćelije izaberu mišem a ne pomoću imena. Da bi se ime uopšte koristilo, mora prvo da se definiše. Pogledajte kako se formule prave brzo sa referencama ćelija koje kasnije zamenite imenima:

1. U prazan radni list unesite formulu =A1 u ćelije A2, A3 i A4.

2. Ćeliju Al nazovite Testl.
3. Izaberite komandu Insert / Name / Apply; pojavljuje se dijalog Apply Names .

4. Proverite da li je Testl izabran u listi Apply names. Pritisnite OK.

5. Pogledajte formule u ćelijama A2, A3 i A4 - one se pozivaju na ćeliju Al preko njenog imena.

savet: Kada koristite imena u formuli proverite da li ste izabrali sva potrebna imena u dijalogu Apply Names.

1.6.12.1 Opcija Ignore Relative/Absolute

Opcija Ignore Relative/Absolute nudi dve mogućnosti:
• Ako je potvrđena (postavka koja se podrazumeva), zamenjuje referencu imenom, bez obzira da li je referenca relativna, apsolutna ili mešovita.
• Ako nije potvrđena, zameniće apsolutne reference samo apsolutnim imenima, relativne reference samo relativnim imenima i mešovite reference samo mešovitim imenima.
1.6.12.2 Opcija Use row and column names

Kada se koristi ova opcija, upotrebljavaju se imena preseka (koja su obrađena ranije) ukoliko ne postoji ime ćelije. Na primer, ako se bezimena ćelija nalazi na preseku kolone nazvane Januar i reda nazvanog Dohodak, ovaj parametar omogućava da Excel za nju primeni ime Januar Dohodak..

1.6.12.3 Dodatne opcije

Pritisnite dugme Options da se u dijalogu pojave i opcije  o kojima diskutujemo u narednim odeljcima.

Opcija omit column name if same column 

Ova opcija skiži da se u formulama koje se nalaze u istoj koloni gde i imenovani skup ćelija, izostavi ime skupa u formuli. Evo primera: u radnom listu sa sledeće slike, kolone i redovi su imenovani skupovi ćelija. Dohodak je jednak razlici Prihoda i Rashoda.

savet: Obratite pažnju da se irnena skupova c'elija mogu koristiti u formulama sa običnim jezikom. Kada formirate imenovane skupove koji već imaju naslove kolona, dijalog Create Names prikazaće i predložiti te naslove za imena. Imena moraju biti definisana da bi se pojavila u dijalogu Apply Names.

Pretpostavimo da ste formule dohotka postavili brzo, pokazivanjem i izborom referenci ćelija mišem (npr. formula u C5 je =C3-C4), i želite da zamenite reference ćelija imenima ćelija. Podrazumeva se da je potvrdena opcija Omit column name if same column (izostaviti ime kolone ako je kolona ista). Ako zamenite imena bez promene ove opcije, formula u ćeliji C5 biće =Prihod-Rashod, a ukoliko je promenite formula u ćeliji C5 biće =Fiskalna.97 Prihod-Fiskalna.97 Rashod.

Opcija Omit row name if same row Za ovu opciju važi isto što i za prethodnu, samo što se primenjuje na formule koje se nalaze u istim redovima kao i ćelije na koje se formule odnose.

Opcija Name order Opcija Name order odreduje redosled imena u imenu preseka:red pa kolona ili kolona pa red.

1.6.13 Imenovanje konstanti

Imena koja su do sada upotrebljavana u ovom poglavlju bila su imena ćelija. Možete da imenujete i konstante. Ime se odnosi na vrednost konstante, na primer 25, 10% ili Istok. Najčešći razlog za upotrebu imenovanih konstanti je da se korisnik spreči da im neoprezno promeni vrednosti.

Pretpostavimo na primer da kroz ceo radni list treba da se uracuna provizija od 12%. Znajući da procenat provizije može da se promeni, ne želite da se konstanta 12% pojavljuje u formulama kroz ceo radni list. Ako se 12% čuva u ćeliji, korisnik se prosto poziva da je promeni. Međutim, kada je konstanta imenovana dobijaju se i fleksibilnost imenovane ćelije, i određena bezbednost.

1.6.13.1 Definisanje imenovane konstante

1. Upotrebite komandu Insert > Name > Define koja prikazuje dijalog Det'ine Name.

2. Unesite ime na uobičajen način.                               ""

3. U Refers to upišite vrednost konstante. Konstanta može biti broj, tekst, logička (TRUE/FALSE) ili čak matrica (pravougaoni skup ćelija).

4. Pritisnite OK da dodate ime i zatvorite dijalog ili pritisnite Add da dliNate ime i zadržite dijalog.                                               

savet: Kada definišete imenovanu konstantu, Excel automatski upisuje znak jednakosti u polje Refers to (i znake navoda oko tekstualne konstante). Zapamtite da ne morate da upisujete znak jednakosti ili znakove navoda - dozvolite da Excel to uradi za vas.RESAVANJE PROBLEMA
1.6.13.2 Ispravljanje grešaka #NAME? ^

Greska #NAME? pojavljuje se kada se formula poziva na nepostoječe ime. Ukoliko se to desi, proverite sledeće:

· da li je ime (imena) u formuli ispravno upisano;

· da li je ime (imena) funkcije u formuli ispravno upisano;

· da li se ime nalazi pod znacima navoda.

napomena: Ostatak poglavlja se bavi složenijim tehnikama imenovanja. Možda ćete želeti da se vratite na ovaj deo kada usvojite teme o kojima se govorilo ranije u poglavlju. Biće potrebno da razumete spoljne reference .

1.6.14 Imena koja se odnose na celije iz drugih radnih listova

Imena mogu da se odnose i na ćelije u drugim radnim sveskama. Ova tehnika je veoma važna za razvoj šablona i radnih listova uopšte. Pretpostavimo da su sledeća imena definisana u svesci Bookl:

Ime         

Odnosi se na                   

Komentar 

Promet      

=(XYZ.XLS]Sheetl!Al             

Poziva se na adresu ćelije 

Dohodak_l

 =[ODELl.XLS]Sheetl!Dohodak     
Poziva se na ime ćelije 

UGP.TabeIa 
=SUM([PROMET.XLS]Sheetl!Al:A3) 
Poziva se na skup ćelija

Formule u svesci Bookl sada mogu da sadrže imenaPromet, Dohodak_l i UGP. Tabela kao da se ćelije sa tim imenima zaista nalaze u Bookl, bez obzira što prefiks sa imenom sveske pokazuje da nije tako. Sledeće formule su regularne:

=SUM(Promet) 

=ROWS(Promet) 

=INDEX(Promet)

=Dohodak_l*2
1.6.14.1 Primena imena na spoljne reference

Kad hoćete da dodelite ime koje se odnosi na drugu (spoljnu) radnu svesku (tj. da definišete spoljnu referencu):

1. Izaberite komandu Insert / Name / Detine.

2. Upišite ime.

3. U polje Refers to, upišite =[BOOKl.Xl.S]SheetV.MyCell. (U ovom slučaju,

BOOK1.XLS je ime spoljne radne sveske, aMyCe// je referenca ćelije, ili ime ćelije).

1.6.14.2 Ćuvanje vrednosti iz spoljnih referenci

Uvek kada zadate imena koja se odnose na druge radne listove, vodite računa o parametru Save external link values kojem se pristupa sa Tools / Options i biranjem kartice Calculations. Pretpostavimo da imate radnu svesku (ZAVISNA) sa formulama koje se obraćaju skupovima ćelija u drugoj radnoj svesci (IZVORNA). Kada je ova opcija potvrđena u svesci ZAVISNA, vrednosti odgovarajućih ćelija u svesci IZVORNA biće snimljene u svesku ZAVISNA, mada se to ne vidi. Na ovaj način formule sveske ZAVISNA mogu da rade bez potrebe da se osveže veze. Posmatrajte sledeću situaciju:

Ime UGP.Promet iz sveske Bookl, odnosi se na spoljni skup PROMET98.XLS!Baza koji ima 5000 redova i 20 kolona. Podrazumeva se da je parametar Save external link values komande Tools / Options / Calculation potvrđen. Time se nalaže da se vrednosti iz PROMET98.XLS!Baza snimaju nevidljivo u Bookl. Kada se snimi Bookl, nastala je ogromna radna sveska jer su snimljene i vrednosti koje su sa njom povezane preko spoljnih referenci.

Uklonite oznaku za potvrdu pored ovog parametra ako vrednosti iz spoljne reference ne treba da se sačuvaju zajedno sa radnim listom, što najčešće i jeste slučaj.

1.6.14.3 Imenujte spoljne reference

Već znate kako se imenuje skup ćelija, ali možda ne znate da ime može da se odnosi na skup ćelija u razlicitim radnim sveskama. Imenovane spoljne reference su važni kon-struktori ako ozbiljno radite u Excelu. Radni listovi mogu imati reference na skup iz spoljne radne sveske. Sa njima se teško radi pošto sadrže ime izvorne radne sveske. Ako je izvorna radna sveska zatvorena, cela putanja je deo reference. Imenovanjem spoljašnjeg skupa olaksava se unošenje, menjanje i čitanje formula.

Imenovanje spoljne reference ne razlikuje se mnogo od ,,normalnih" imenovanih skupova. Ime radne sveske se jednostavno unosi u polje za izmene Refer to: iz okvira za dijalog Define Name. To se postiže upisivanjm reference ili izborom spoljne reference iz spoljne radne sveske. Pretpostavimo da želite da stvorite ime u radnoj svesci PRIKAZ.XLS koje se odnosi na skup u radnoj svesci STUDI]A.XLS i da su obe radne sveske otvorene. Aktivirajte PRIKAZ.XLS, zatim izaberite 

Insert / Name / Define. Upišite ime, zatim postavite kursor u polje za izmene Refers to:. 

Upotrebite meni Window da aktivirate svesku STUDI|A.XLS.

Izaberite skup mišem, zatim pritisnite OK. Sada umesto da unesete formulu kao:

-SUM([STUDIJA.SLX!Sheetl] !$A$1:IA$3

unesite:

-SUM(Promet)

1.6.15 Centralizovanje logike korišćenjem imenovanih formula

Sada ste shvatili značaj imenovanja ćelija i konstanti i privikli se da ih i sami imenujete. Ako posmatrate sintaksu imena definisanih pomoću dijaloga Define Name, primetićete da parametar Refers to za sva imena počinje znakom jednakosti. Sva imena u osnovi su imenovane formule različite složenosti. Skoro svaka formula koja može da se unese u ćeliju može se smatrati imenovanoin formiilom.

Jedna od značajnih primena imenovanih formula jeste centralizovanje logike -jedna složeno imenovana formula može prilično da pojednostavi formule koje se nalaze u više ćelija. Posmatrajte sledeći problem:

Za izračunavanje stope povraćaja neke investicije upotrebljena je složena formula.Ista formula se koristi i u stotinak drugih ćelija lista. Sta treba da uradite ako formula mora da se promeni? Možete da upotrebite Find/Replace, ali morate da pazite da ne pišete preko neke druge, slične, formule.

Ovaj problem može da se reši tako što ćete formuli dati ime i zatim je pozivati tim imenom. Pošto je polje Refers to iz dijaloga Define Name pomalo nezgodno za rad, formula se lakše imenuje kada je prvo unesete u ćeliju, a zatim je kopirate u dijalog Define Name. Sledi jednostavan primer.

1. Upišite sledeće konstante u prazan radni list:

2. Unesite formulu =C3*D3 u ćeliju E3.

3. Izaberite formulu (iz linije za fonnule ili u ćeliji), potom izaberite komandu Edit / Copy.

4. Pritisnite Esc (pošto ćeliju F.3 ne rnenjate već samo kopirate njenu formulu).

5. Izaberite komandu Insert / Name /  Define da otvorite dijalog Define Name.

6. Unesite ime Ukupno (ako ga Excel već sam nije uneo).

7. Obrišite sadržaj polja Refers to.

8. Izaberite kornandu Edit / Paste da unesete formulu.

9. Pritisnite OK. 
     Definisana je imenovana formula Ukupno koja još nije upotrebljena:

10. Izaberite ćelije E3:E5.

11. Upišite =Ukupno, zatim pritisnite Ctrl+J da tbrmulu unesete u sve tri ćelije.

Izaberite ćeliju E3, pozovite dijalog Define Name i izaberite ime Ukupno. Ukupno će sc odnositi na =SheetI!C3*Sheetl!D3. Zatvorite dijalog, izaberite F-4 i ponovo pogledajte definiciju Ukupno. Odnosiće se na =Sheetl!C4*Sheetl!D4. Definicija je zavisna od aktivne ćelije jer sadrži relativne reference.

1.6.15.1 Trik sa CellAbove

Pretpostavimo da se u ćelijama A1 :A10 nalaze brojevi i da je formula =SUM(A1 :A10) u ćeliji A11  Potrebno je da dodate neku vrednost koja mora da bude obuhvaćena forrnuiom SUM. Ako red umetnete u sredinu kolone, skup za sabiranje se automatski prosiruje. i'vleduiim, mnogo češće će vam biti potrebno da dodate red na kraj kolone - kada umetnete novi red 11, formula (sada u redu 12) mora da se izmeni tako da i njega obuhvati. jedan naiin da se ovakav problem resi jeste upo-treba relativne reference koja se odnosi na prvu gornju ćeliju. U sledećem primeru, aktivna je ćelija A2:

1. Izaberite Insert  / Name / Define i kao ime ćelije upisite CellAbove.
2. U Refers to, unesite =A1, a zatim pritisnite OK.

3. Sada formulu =CellAbove možete uneti u bilo koju ćeliju iz lista (osim ćelija iz reda jedan) i ona će se odnositi na ćeliju iz jednog reda iznad. Formula će glasiti =SUM(A1 :CellAbove), sto jednostavno rečeno, znači: saberi ćelije od A1 do prve c'eiije iznad formule. Redove možete umetati odmah iznad forrnule SUM. Rela-tivna referenca u imenovanoj formuli čini da se SUM automatski prosiri.

1.6.16 Korišcenje imenovanih formula za obrazovanje dinamickih imenovanih skupova

Dinainički imenovani skupovi ćelija (engl. iiyntimic narned ranges} su skupovi koji se automatski menjaju pod odredenim uslovima, kao kad kolona ima promenljiv broj stavki. Ne postoji formalna konstrukcija dinamicki imenovanog skupa; oni su jedno-stavno irnenovane formule koje se odnose na skup ćelija. Posmatrajte sledeći pioblem:

Skup ćelija se zove Investicje_Detalji. Na imenovani skup Investicije_Detalji odnose se različite formule i dijagrami, u svrhu analize investicija. Potrebno je analizirati još jednu investiciju. Ako se upotrebi klasičan pristup, mogao bi da se formira još jedan skup formula i dijagrama koji bi se odnosio na drugu investiciju. Pošto rnodel zahteva izmene da bi se zadovoljile potrebe analize druge investicije, bilo bi jako poželjno projektovati ga tako da niože da se upotrebi i za eventualnu treću i četvrtu investiciju.

Problem može da se reši pomoću dinamičkog imenovanog skupa - bez izmene složenih formula koje se odnose na Investicije_Detalji. Korisnik sam određuje koja investicija treba da se analizira.

1.6.16.1 Analiza korišćenjem dinamički imenovanog skupa

U sledećoj vežbi koristićete dinamički imenovani skup kao inehanizam za analizu dva različita slučaja:

1. Unesite sledeće u prazan radni list:                              :

2. Nazovite ćelije B2:C6 Investicijal.
3. Nazovite ćelije E2:F6 Investicija2.
4. Nazovite ćeliju D8 Izbor. (Ono što korisnik unese u ovu ćeliju odrediće inves-ticiju koja treba da se analizira.)

5. Izaberite komandu Insert > Name > Define.

6. Unesite kao ime Investicije_Detalji.
7. Unesite sledeću formulu u polje Refers to:

"CHOOSE (Izbor,Investicijal.Investicija2)

8. Pritisnite OK.

Sada testirajte dinamičko ime:

9. Unesite 1 u ćeliju Izbor.
10. Izaberite komandu Edit >- Go To. U polje Reference upišite ime InvesticijeJDetalji i pritisnite OK. Biće izabran skup Investicijal.

11. Unesite 2 u ćeliju Izbor, zatim ponovite korak 10.

Pretpostavimo da će u budućnosti biti dodata treća investicija. Sve što treba da uradite jeste da dodate podatke, nazovete ih InvesticijaS, zatim izmenite definiciju Investicije_Detalji tako da glasi:

"CHOOSE (Izbor, Investicijal, Invesricija2, Investicija3))

napomena: Excel neće prikazati dinamičke imenovane skupove ćelija u dijalogu Go To ili listi polja za ime.

U gornjem primeru formule i dijagrami koji koriste ime Investicije_Detalji kao referencu ćelije su dinamičke i zavise od korisnikovog unosa u ćeliju Izbor. Na primer, ako hoćete zbir brojeva u desnoj koloni skupa Investicije_Detalji upotrebite funkciju OFF-SET  i napišite sledeću formulu:

=SUM(OFFSET(Investicije_Deta1ji ,1,1,4,1))

1.6.16.2 Imenovane matricne konstante

Naprednijim korisnicima matrične konstante (engl. array constants} su veoma korisne, mada su nezgodne za konstruisanje. Slične su pravougaonim skupovima čelija, ali pošto se ne predstavljaju u pravougaonoj tbrmi i ne vide u nireži radnog lista nije lako uočiti ni njih ni njihove redove i kolone. Jedna od primena im je da čuvaju tabele sa podacima koje korisnik radnog lista ne treba da vidi. Kao i kod drugih imenovanih konstanti i matrične konstante se definišu pomoću 

Komande Insert >- Name > Define koja prikazuje dijalog Define Name .

Matrična konstanta sadrži više vrednosti koje su, kao i ćelije, organizovane u redove i kolone. Za razliku od ćelija, redovi i kolone matrične konstante predstavljaju se izrazom koji sadrži konstante poređane u niz i razdvojene separatorima. Redovi i kolone prepoznaju se po tipu upotrebljenih separatora kojih ima dva.

Zarez: označava novu kolonu 

Tačka sa zarezom: označava nov red

U sledećim primerima, unosi ispisani polucrnim slovima označavaju šta treba da se upiše u polje Refers to dijaloga Define Name da bi se formirale sledeće matrične konstante:

=!2;4;6;81 



4 reda, 1 kolona brojeva
=("Istok",12,100; 


2 reda, 3 kolone teksta i brojeva
=("A",TRUE,99.991: Zapad",15,1351
1 red, 3 kolone - tekst, logička i brojna konstanta
Pristupanje podacima iz matrice slično je pristupanju podacima iz ćelije. Funkcija INDEX  služi za pristup pojedinačnom podatku. Funkcija ROWS kao rezultat daje broj redova a funkcija COLUMNS broj kolona matrice.

savet: Projektanti aplikacija često smeštaju informacije u matrice, gradeći matrice uz programsku kontrolu. To im omogućava da se koriste čitavim skupom podataka, bez zamornog definisanja pojedinačnih imena. Pošto su programski definisana imena sakrivena, postiže se još jedan nivo bezbednosti.

1.6.17 Primenjivanje imena na nivou radne sveske ili radnog lista

Imena mogu biti globalna (engl. global) - na nivou radne sveske ili lokalna (engl. local) - na nivou radnog lista. Ovu razliku je važno razumeti da bi se imena koristila efikasno.

1.6.17.1 Globalna imena

Podrazumeva se da su sva imena globalna, tj. odnose se na celu radnu svesku. Kada je ćelija B2, na radnom listu Sheetl, radne sveske Bookl, nazvana Zbir, to znači da:

• Ime Zbir može da se pozove iz bilo kog radnog lista (iste radne sveske), bez potrebe da se navodi prefiks za ime radnog lista - radni list Sheet2 može da sadrži formulu =Zbir.

• Bez obzira koji je list aktivan, ime će se pojaviti u padajućoj listi polja za ime.

• Ako se radni list iz druge radne sveske sa istim globalnim imenom Zbir premesti ili kopiia u radnu svesku Bookl, originalno ime iz radnog lista Sheetl ima pred-nost - ime definisano u upravo prispelom radnom listu postaje lokalno.

1.6.17.2 Lokalna imena

Lokalna imena det'inišu se tako što se ime radnog lista dodaje lokalnom imenu preko dijaloga Define Name (slika 8.1) ili polja za ime. Ako želite da definišete lokalno inie Zbir za radni list Sheetl, uradite sledeće:

1. Aktivirajte Sheetl.

2. Izaberite ćeliju (ćelije) koju želite da imenujete.

3. Unesite ime SheetlIZbir u polje za ime - ime lista je postalo sastavni deo imena ćelije. Kada je definisano lokalno ime ono će se pojaviti u polju za ime bez prefiksa Sheetl! i to samo u polju za ime prvog lista (a neće ga biti u polju za ime drugih listova).

napomena: Polje za ime ne može se koristiti za imenovanje konstanti ili formula, već samo ćelija, skupova ćelija i objekata. Isto tako, u polju za ime pojaviće se samo globalna imena ćelija i skupova ćelija kao i lokalna imena ćelija i skupova ćelija aktivnog radnog lista.

Značenje lokalnog imena Zbir definisanog u radnom listu Sheetl je sledeće:
• Zbir može da se pozove iz bilo kog radnog lista, ali obavezno mora da se navede prefiks imena lista (npr. radni list Sheet2 može da sadrži formulu =Sheetl!Zbir).
• Formula =Zbir uneta u radni list Sheet2 daće grešku #NAME?.

• Ime Zbir može da se definiše u drugim radnim listovima, a SheetliZbir nece biti promenjeno (čak i kada je nova definicija za Zbir globalna).

• Ako se Zbir ponovo definiše u radnom listu Sheetl sa izostavljenim prefiksom imena lista (kao da je globalno), ime će i dalje biti lokalno.

 napomena: U navedenim objašnjenjima globalnih i lokalnih imena koriste se imenovane ćelije  da se ilustruje koncept. Ista pravila važe i kada se radi o imenovanim formulama i imenovanim konstantama.

1.6.17.3 Prečica za definisanje lokalnih imena

Posto okvir za dijalog Create Name nema opciju za formiranje lokalnih imena, nema neposrednog načina da se ona prave bez mukotrpnog procesa definisanja jednog po jednog imena preko okvira za dijalog Define Name.

Pretpostavimo da imate radni list sa podacima za mesec januar i u njemu ste upo-trebili mnogo imena. Sada je februar i trebavam novi radni list u istoj radnoj svesci, ali sa istim imenima kao u listu za januar. (Proces je potrebno ponavljati i za sve naredne mesece.)

Prvo morate napraviti kopiju lista januar u istoj radnoj svesci (držite Ctrl dok povlacite i pustate jezicak kartice januar na novo mesto). Napravićete novi radni list koji sa imenom Januar[2]. Sa dva pritiska na taster misa izaberite oznaku nove kartice, zatim upisite ime Februar u okvir za dijalog Rename Sheet. Novi list Februar sadržaće ista imena kao list januar, ali c'e ona sada biti lokalna za list Februar.

1.6.17.4 Pravila za imenovanje

Kada jednom počnete da koristite imena, koristićete ih sve •više. Složen model može da sadrži stotine imena, tako da spisak imena u dijalogu Define Name može da pos-tane glomazan, Mogu da se dodaju posebni prefiksi i/ili sufiksi kao pomoc pri doku-mentovanju i upravljanju irrienirna. Pravila iinenovanja u sledećim primerima nisu tu da bi se bukvalno primenjivala, već da ponude ideje o tome kako možete da dodete do logičnih pravila koja će vam biti od pomoći.

Pravila zasnovana na tipu imena
Pravila za imenovanje navedena u tabeli zasnovana su na tipu imena koje se stvara.

Prefiks______Značenje___________________________ 

NF 

imenovana formula (engl. named formula') 

AC 
matrična konstanta (engl. array constant) 

ER 

spoljna referenca (engl. external reference) 

DB 
tabela baze podataka (engl. database table)

CR 

izračunat (dinamički) skup (engl. calculated range)

1.6.17.5 Pravila specifična za model

Određen model radnog lista može da ima sopstvena karakteristična pravila, kao u sledećem primeru:

• Ako imate nekoliko skupova na jednom listu, koji se štampaju kao odvojeni izveštaji, upotrebite prefiks Izveštaj; na primer Izveštaj_Zbirni ili Izveštaj_Detaljni.

• Ako radni list sadrži podatke za više tržišta, upotrebite prefiks Tržište; na primer TržišteIstok i Tržište_Zapad.

• Ako radni list koristite za praćenje ulaganja sredstava, upotrebite prefiks kojim identifikujete vrstu ulaganja; na primer, Kredit.BB, Kredit.Oprema, Obveznice.Zajam, Obveznice.TB.

1.6.18 Kako da odjednom pregledate sva imena

Složena radna sveska može da sadrži stotine imena. Dijalog Define Name omogućava da u jednom trenutku pregledate definiciju samo za jedno ime. Komanda Inserta  / Name / Paste otvara sledeći dijalog:

Pritisnite dugme Paste List da unesete sve definicije u aktivan radni list, počev od aktivne ćelije. Uneta su sva globalna imena kao i lokalna imena definisana na aktivnom radnom listu. Lokalna imena definisana u drugim radnim listovima nisu uneta.

upozorenje: Pošto se imena unose počev od aktivne ćelije, morate da pazite da se ne upišu preko podataka iz radnog lista. jedan od načina da se izbegne ova zamka je da se svesci doda nov radni list i u njega unesu imena. Međutim, imajte na umu da će unesena lista sadržati ova globalna imena u radnoj svesci, a lokalna imena samo za aktivni radni list.

U ovom poglavlju videli ste kako imenima možete značajno povećati mogućnosti izvlačenja maksimuma iz Excela. Naučili ste da se imena mogu odnositi na pojedinačne ćelije, skupove ćelija, formule ili konstante. Takode ste otkrili kako se imena mogu iskoristiti u formulama i kako se prave dinamićki imenovani skupovi.

U sledećem poglavlju naučićete neke značajne funkdje radnog lista koje će vam zajedno sa tehnikama imenovanja pomoći da još bolje razumete i ovladate Excelovim potencijalima.

1.7 Znacajne funkcije radnoj lista

Excel ima stotine ugrađenih funkcija i večina korisnika sigurno će naučiti one  koje su potrebne za elementarnu aritmetiku radnog lista, na primer SUM. Ali, kada počnete da gradite složenije modele, tradicionalno štura priroda priručnika za Excelove funkcije pokazuje svoje nedgstatke: ne ističe funkcije koje su značajne za izgradnju ozbiljnog radnog lista i analizu podataka.

Šta čini neku funkciju značajnom? Ćak i najopskurnije funkcije postaju značajne u rnomentu kada su potrebne za rešavanje odredenog problema. Funkcije obuhvaćene ovim poglavljem važni su generićki alati. Primer za to je funkcija OFFSET. Nezamislivo je da se bez nje uradi i najjednostavniji model ili analiza, a malo je korisnika Excela toga svesno.
Ovo poglavlje obuhvata sledeće funkcije za radne listove:

Zbirovi i međuzbirovi 
SUMIF. SUBTOTAL

Pretraživanje i reference 
VLOOKUP, MATCH, 1NDEX, OFFSET. INDIRECT, ROVV,

                                              ROVVS, COLUMN, COLUMNS

Prebrojavanje 

COUNT, COUNTA, COUNTBLANK, COUNTIF

Tekst 


LEN, I.EFT, RIGHT, MID, SEARCH, FIND

Datum i vreme 

TODAY, NOVV, DATE, DAY, HOUR, MINUTE, MONTH

WEEKDAY, YEAR

1.7.1 Izracunavanje zbirova i međuzbirova

Funkcije SUBTOTAE i SUMIF su važne mogućnosti u Excelu i služe za izvršavanje dve značajne i česte vrste obračuna: uslovnih zbirova (engl. conditional totals) i umetnutih  međuzbirova (engl. nested subtotals). Uslovno sabiranje je važno za filtriranje podataka;

1.7.1.1 SUBTOTAL u akciji

Sledeća vežba pokazuje raznovrsne mogućnosti funkcije SUBTOTAL. Naučićete kako korisnik svojirn unosoni može da bira tip izračunavanja.

1. Unesite sledece podatke u prazan radni list:

2. Upišite sledeće formule da izračunate međuzbirove i ukupan zbir:

Celija      Fonnula
E7

=SUBTOTAL(9,E3:E6)

E12

=SUBTOTAL(9,E8:E11)

E13

=SUBTOTAL(9,E3:E12)

Do sada je funkcija SUBTOTAL radila isto što i jednostavnija funkcija SUM. Drugi deo ove vežbe ćini formulu dinamičkom i pokazuje raznovrsne mogucnosti funkcije SUBTOTAL:

1. Nazovite ćeliju F16 ZadajTip.
2. U svakoj od tri formule SUBTOTAL zamenite argument Tip9 referencom ćelije ZadajTip (ne brinite zbog greške #VALUE!, za nju ćemo se pobrinuti u trećem koraku); na primer:

-SUBTOTAL (ZadajTip,E3:E6)
3. Unosiite brojeve od 1 do 11 u ćeliju ZadajTip i posmatrajte kako se SUBTOTAL menja.

Brojevi koje ste uneli odreduju tip izračunavanja koje će obavljati funkcije SUBTOTAL.

savet: Komanda Data / Subtotals može brzo da unese međuzbirove, bez potrebe ručnog unosenja redova a usput će napraviti i mogućnost za okvirno prikazivanje pomoću posebnih kontrolnih elemenata.

